
Incorporate 3D in Your Posters

How to Add 3D Groups to Your Poster Layouts

•  Add visual stimulus to your posters
•  Show the same area from a variety of angles and elevations
•  Familiarize viewer with area’s topography

•  Choose Add/Saved Group from the menu in the Display Manager window.
•  Open the Viewpoint Controls for the 3D group and adjust if necessary.
•  Click and hold the left mouse button to draw a box in the 3D Viewpoint

Selection window around the area you want shown in the layout, then click on
the Apply Changes icon in the same window or Apply button in the 3D
Viewpoint Controls window

•  In layout display mode, you can also add a new 3D group, select the surface
and drape layers, set the Viewpoint Controls, and select the desired area.

DID YOU KNOW . . . you can add a 3D group to any layout?

What Adding 3D to Posters Gives You

Select Yes in the
prompt window
that opens.

Right-click on the 3D group
icon to open the  Viewpoint
Controls.

Sample
Layout

WANT TO KNOW MORE?

3D Perspective Visualization
See the tutorial booklet:

Enlarged area
viewed at shallower
angle.



Geospatial Formulas

How GeoFormulas Work

•  Compute complex display layers on the fly from multiple input objects
•  Define and refine models and equations with immediate visual feedback
•  No need to run separate processes to pre-compute display objects
•  Apply visualization tools to GeoFormula layers that combine multiple raster

and vector input objects

•  Select Add/Layer/GeoFormula/Add GeoFormula Layer from the menu.
•  Select the input objects you want to process in your GeoFormula model.
•  Use the scripting tools to write a GeoFormula that computes display

values from the attributes of your geospatial input objects.
•  Select the Preview panel for a quick look at the display result of your

current model.
•  Save your GeoFormula for later modification, and use it to create perma-

nent output objects.

DID YOU KNOW . . . you can display layers that are dynamically
combined according to complex object models and equations?

What GeoFormulas Give You

A Brovey GeoFormula layer
dynamically sharpens low
resolution imagery (shown in
another layer).

WANT TO KNOW MORE?

Using Geospatial Formulas
See the tutorial booklet:



Symbols from TrueType Fonts

How Symbols from TrueType Fonts Work

•  Predefined symbol shapes that you can use alone or in combination
•  Access to glyphs in any TrueType font in your system
•  Multicolor symbols from glyphs that have multiple shapes
•  Editable shapes that can be easily modified
•  Symbols that are more scaleable than bitmap point symbols

• In the Point Symbol Editor, choose the Open TrueType Symbol option from
the Pattern menu.

• Select a TrueType symbol font (such as the Webdings font in Windows98)
and an appropriate glyph.

• Select colors and turn on fill for the component shapes.  Alter layer order of
shapes as needed to show all interior polygons.

• Use the Paste TrueType Symbol menu option to add additional glyphs (such
as numerals) to build up complex symbols.

DID YOU KNOW . . . you can use glyphs (characters and symbols) in
TrueType fonts for point symbols in vector, shape, or CAD objects?

What Symbols from TrueType Fonts Give You

WANT TO KNOW MORE?

Creating and Using Styles
See the tutorial booklet:



Use Dual Monitors

How Dual Monitors Work

•  Increase display space for increased productivity
•  Keep all the windows you need for your job “on top”
•  Stretch very large view windows across both monitors
•  Multitask: TNT products on one monitor—web, email, or other document

processing on another
•  Place process control windows on one monitor and views on another (use

process IDs to tie together)
•  Compare 3D anaglyph stereo view(s) on one monitor and 2D views on another

• Install one dual-monitor display card or two single-monitor cards.
• Configure your operating system to recognize both monitors: their color

depth, resolution, and relative positions.
• MI/X in X desktop mode on one monitor:

By default, the MI/X window fills your primary display and you can set
which monitor in the MicroImages X Server Preferences window.

• MI/X in X desktop mode on both monitors:
To spread MI/X across both monitors, turn on the Multiple Monitors
checkbox on the Screen tabbed panel of MicroImages X Server Prefer-
ences window.

DID YOU KNOW . . . using two or more monitors lets you get more
work done more quickly?

What Dual Monitors Give You

WANT TO KNOW MORE?

MicroImages’ Web Site
Search the information available on
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3D Views Assist When Editing

How Using 3D Views in the Object Editor Works

•  A 3D view can quickly pinpoint z-value errors.
•  You can quickly verify if the correct element is selected for editing.
•  You can immediately see if your editing is reasonable in 3D.

• Open the 3D vector for editing and add any reference layers desired.
• Choose Open 3D View from the Reference menu in the Spatial Data Editor

window.
• Adjust 3D view position so problem elements are clearly visible.
• Select element(s) in the 2D view and confirm correct selection in 3D.
• Edit the elements in the 2D view and check the results in 3D.

DID YOU KNOW . . . you can open a concurrent 3D view of the object
you are editing in 2D to help you locate and identify elements?

Editing Vector Geodata

WANT TO KNOW MORE?

See the Getting Started Booklet:

What Using 3D Views while Editing Gives You

before
editing after

editing

3D View Aberrant z-
values are
common from
surface edge
effects and are
not readily
apparent with-
out checking
the 3D view.

2D View

enter a
new z-
value
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Advanced Software for Geospatial Analysis

Voice: (402)477-9554
FAX:  (402)477-9559

MicroImages, Inc.

MicroImages, Inc. publishes a complete line of professional software for
advanced geospatial data visualization, analysis, and publishing.  Contact
us or visit our web site for detailed product information.

TNTmips TNTmips is a professional system for fully integrated GIS,
image analysis, CAD, TIN, desktop cartography, and geospatial data-
base management.

TNTedit TNTedit provides interactive tools to create, georeference,
and edit vector, image, CAD, TIN, and relational database project ma-
terials.  TNTedit can access geospatial data in a wide variety of com-
mercial and public formats.

TNTview TNTview has all the same powerful display features for
complex visualization and interpretation of geospatial materials as
TNTmips. TNTview is perfect for those who need flexible access to
the TNT project materials but do not need the technical processing and
preparation features of TNTmips.

TNTatlas TNTatlas lets you publish and distribute your spatial project
materials on the Internet or CD-ROM at low cost. TNTatlas CDs con-
tain multiple versions of the TNTatlas software so that a single CD can
be used on any popular computing platform.

TNTserver TNTserver lets you publish TNTatlases on the Internet or
on your intranet.  Navigate through massive geodata atlases with your
web browser by using the free TNTclient Java applet (or any custom
applet you create) to communicate with TNTserver.

TNTlite TNTlite is a free version of TNTmips, TNTedit, and TNT-
view for students and professionals with small projects. You can down-
load TNTlite for your computer (about 100MB) from MicroImages’
web site, or you can order TNTlite on CD-ROM with the current set of
Getting Started tutorial booklets (shipping and reproduction charges
apply).

email: info@microimages.com
Internet: www.microimages.com

11th Floor – Sharp Tower
206 South 13th Street
Lincoln, Nebraska  68508-2010 USA



GeoLock Multiple Views

WANT TO KNOW MORE?

See the tutorial booklet entitled:

Displaying Geospatial Data

How GeoLocking Works

•  All pan and zoom operations are simultaneously applied to all the
GeoLocked views

•  Simplifies and enhances side-by-side visualization
•  GeoLock by position, or scale, or both
•  Tracking cursor shows mouse position in all views

• Open two View windows with geodata that shares some common extent.
• The GeoLock tool button is automatically turned on in both windows
• Apply several zoom and pan operations and observe the effect.
• In the View window, select GeoLock Settings from the Options menu and

specify settings for GeoLocking by Scale, Position, or both.
• Use dual monitors, multiple View windows, and define different GeoLock

view combinations.
• Turn off Scale GeoLocking in one view and zoom it out as a reference view.

DID YOU KNOW . . . two or more View windows are automatically
GeoLocked when the geodata they display shares any common
geographic area?

What GeoLocking Gives You
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Save/Open Multiple Views

How Multiple Views and Save/Open Work

•  2D and 3D views of the same layers open for use just as saved.
•  Can provide visualization of different areas of a group at different scales.
•  Show/Hide settings for layers in different windows retained when reopened.
•  Contents of all windows retain position, scale, and viewpoint.

• Add any number of layers to the current display window.
• Choose Open 2D View or Open 3D View from the Group menu in the Group

Controls window.
• Adjust position and scale using standard (2D) or Viewpoint Controls (3D).
• Hide layers in individual views if desired.
• Save the group (or layout) and open it again (choose Open Group or Open

Layout from the toolbar) with all layers and views showing as when saved.

DID YOU KNOW . . . that all windows you have open are saved with
the group or layout and will reopen just as when saved?

What Save/Open Multiple Views Gives You

WANT TO KNOW MORE?

See the tutorial booklet entitled:

Displaying Geospatial Data
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View-in-View

How View-in-View Works

•  Expose one or more hidden layers in any show/hide combinations
•  Quick visualization tool for rapid image and feature comparisons
•  Instant flash feature reverses inside/outside images
•  Slide the View-in-View box anywhere in the View to expose hidden layers

immediately

• Add two or more layers that share some common extent such that the top
layers hide those underneath.

• Select the View-In-View tool from the icon buttons in the View window.
• Deselect the View-in-View Hide/Show checkbox for the top layers.
• Draw an elastic View-in-View box in the View window.
• Resize and reposition the View-in-View box.
• Click the right mouse button anywhere on the view to reverse the inside/

outside layers.

DID YOU KNOW . . . that you can see and compare hidden layers
with a resizable View-in-View tool that you can move anywhere in
the View window.

Displaying Geospatial Data

WANT TO KNOW MORE?

See the Getting Started Booklet:

What View-in-View Gives You



Auto Color Map

How Auto Color Map Works

•  Replace aribitrary class colors with colors that help you identify the classes
•  Easily create color palettes based on different RGB combinations of any

number of bands
•  Choice of contrast enhancement methods for each band
•  Available in Spatial Data Display and any other process using a View window

• In the Display Manager window, right-click on the raster object icon and
choose Auto Color Map from the right mouse button menu.

• Select three or more raster objects to use for determining colors.
• Use the Color option buttons to select the band to use for each color compo-

nent (red, green, and blue).
• Red, green, and blue values for each class color are assigned using the

averages of all raster cells in that class.

DID YOU KNOW . . . you can automatically color a class raster to re-
semble any color combination of the available monochrome images?

What Auto Color Map Gives You

“natural” colors

color infraredinitial class colors

TM 7-4-2 colors

WANT TO KNOW MORE?

MicroImages’ Web Site
Search the information available on



Floating 3D Layers

How Floating Layers Work

•  Display of all object types (raster, vector, shape, CAD, TIN, and pinmap)
•  Elevation surface defined by one or more raster objects
•  Separate offset values for each floating layer
•  Interactive controls to adjust viewpoint, distance, and scale
•  A powerful tool for 3D visualization and feature comparison

•  Add one or more raster objects to define the elevation surface.
•  Add any number of objects as drape layers.
•  Open the object’s Layer Controls dialog for each drape layer and enter an

offset value.
•  Use the 3D Viewpoint Controls window to select viewer position, distance,

direction and elevation scale.

DID YOU KNOW . . . 3D views allow you to make a stack of
separate drape layers?

What Floating Layers Give You

Crow Butte natural
color satellite
imagery, false color
5-4-2 bands, and
DLG vectors

If you don’t specify
a surface raster,
floating 3D layers
show in an
exploded perspec-
tive view.

WANT TO KNOW MORE?

3D Perspective Visualization
See the tutorial booklet:



Elements in View Controlled by Scale

How to Set Up Control for Visible Elements By Scale

•  Eliminate clutter when zoomed out
•  Increase detail as you zoom in
•  Decrease drawing time at full view

• Select a vector, CAD, or TIN object for display, set the desired element
selection to By Map Scale (Object Layer Controls), and click [Specify].

• Select or create a scale-selection table, and choose the pertinent attribute.
• Enter the minimum and/or maximum scale at which elements with selected

attributes will be visible (leave blank for elements to show at all scales).
• Close the table and click [OK] in the Object Layer Controls window.

DID YOU KNOW . . . you can control which elements in a layer are
visible as you zoom in and out?

What Controlling Visible Elements by Scale Gives You

full view with all
elements drawn

You can enter the MinScale and MaxScale values
immediately after designating the scale selection
attribute.  You can also enter or change these values
after the object is displayed, but you must turn on the
Show Internal Tables toggle for the table to be shown.

Select the attribute with
values that will determine
the visible map scale for
elements.  In this case, we
are using the Class Codes
Description field to
determine line visibility.

full view with some
elements selected by
map scale

zooming in once adds
water features

zooming in again
adds railroads

zooming in once more
displays city streets

This road type is visible
only when you zoom in
beyond 1:100000.Political boundaries and primary

roads are visible at any map scale.

WANT TO KNOW MORE?

MicroImages’ Web Site
Search the information available on



Layers in View Controlled by Scale

How to Set Up Control for Visible Layers By Scale

•  Replace low resolution imagery with higher resolution as you zoom in
•  Display layers only at map scales that make them readable
•  Change types of layers displayed at different map scales (vector to raster,

for example)

•  Select Set Scale Ranges from the right mouse button menu for group or layout.
•  Enter the minimum scale at which the layer is visible (left column).
•  Enter the maximum scale at which the layer is visible (right column).
•  Leave entries blank for layers you want to show at all times.

DID YOU KNOW . . . you can use map scale to control which layers
are visible as you zoom in and out?

What Controlling Visible Layers By Scale Gives You

This layer is visible at map scales
between 1:50000 and 1:100000.

This layer is visible only when you
zoom in beyond 1:250000.

Counties, NRDs, and Landsat mosaic (left)
are replaced by orthophotos, cities, USGS
quads, and townships (below) as you
zoom in.  You can also enter the visible
scale range for a layer in the object’s Layer
Controls window on the Object panel.

Select Set Scale Ranges from
the group’s or layout’s right
mouse button menu to open
the Scale Ranges window.

WANT TO KNOW MORE?

MicroImages’ Web Site
Search the information available on



Layout Templates

How to Create and Use a Template

•  Quick and automated means for making maps in a series
•  Prompting for groups you want to replace
•  Automatic map grid coordinate adjustment
•  Direct entry of replacement text

• Make a layout as usual.
• Indicate which groups you want to remain unchanged in the template (Group

Settings window), then choose Display/Save As Template.
• Choose Display/Open, or Display/New/From Template, and select the template
• Replace groups and alter text as prompted.
• Replace the legend if necessary.

DID YOU KNOW . . . you can save a layout as a template?

What Layout Templates Give You

Turn on this toggle when you want
the group’s layers to be unchanged

when the template is used.

When the tem-
plate is opened,
you are promp-
ted to enter new
text for text
groups not saved “as is.”

After saving the layout at left as a template, you are prompted to choose the layers
for the image map and enter new heading text when the template is opened.  With the
exception of perhaps having to change the legend, that’s all there is to making each
of the next maps in a series.

WANT TO KNOW MORE?

Making Map Layouts
See the tutorial booklet:



Layer Transparency

•  Works with rasters (monochrome, composite color, and multi-band color)
•  Transparent vector polygon fills, CAD shapes, and TIN triangles
•  See through one or more top layers to lower geodata layers
•  Powerful visualization tool for editing, image and feature comparisons
•  Choose each layer’s transparency value from 0% to 100%

DID YOU KNOW . . . you can set layers to be partially transparent
in views and print layouts?

How Transparency Works
• Add two or more layers that share some common extent such that the top

layers hide those underneath.
• Open the Object Layer Controls dialog for each layer you want transparent.
• For Raster objects, enter a Transparency value in the Options panel.
• For Vector, CAD, and TIN objects, enter a transparency value in the style

controls for polygon, shape, or triangle elements.

What Transparency Gives You

WANT TO KNOW MORE?

See the tutorial booklet:

Displaying Geospatial Data
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• Open the Style Editor, and click on the Insert Symbols icon.
• Select From Style Object from the menu that pops up and click on the ... icon

near the Style Set option menu.
• Select the style object you want to copy from, then select the symbol or

pattern you want in that style object, and click OK.

Copying Symbols

How to Copy between Style Objects

•  Symbol, line pattern, and fill pattern selection for your vector/CAD/TIN from
any style object to which you have access

•  Ability to make master style objects that contain any desired, previously
created symbol or pattern

•  Collections of styles by theme
•  Combination of separate point, line, and polygon style objects into one

DID YOU KNOW . . . you can copy symbols and patterns for points,
lines, and polygon fills between style objects?

What Copying between Style Objects Gives You

The style object for this point vector
lacks a symbol for wells, but you
know you have one with another
vector.

The newly acquired well
symbol can be assigned to draw well points.
Although you can select and assign styles
from a master, main level style object, it is a
better idea to create or copy all desired
symbols and patterns to the style subobject
for each individual vector so it is carried
along when the vector is copied.

symbols to choose
from other style object

copied symbol added
to original style object

symbols in
original style object

WANT TO KNOW MORE?

Creating and Using Styles
See the tutorial booklet entitled:
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Tabular Views in Layouts

How to Set Up Tabular Views for Layouts

•  Alternative legend presentation
•  Increased attribute information along with drawing style for elements
•  Choice of all records or selected records, data and/or statistics

• Set tabular view exactly as you want it saved (show styles, hide fields, etc.).
• Choose Save As from the Table menu, and set Format to CAD Snapshot.
• Set styles for text, lines, and polygons, changing colors and fonts as desired.
• Choose Add CAD Layer for a new group in a layout and enter desired size

directly in the layout panel of the Group Settings window.

DID YOU KNOW . . . you can save a tabular view as a CAD object
and include it in a layout?

What Tabular Views in Layouts Give You

This layout presents the population
for the western USA using two
different themes.  The CAD
representation of the table in the
layout includes the data for both
these themes and more.  The
original tabular view is shown
below.

Here, only the
records attached to
selected elements
were saved as a
CAD snapshot.  Note
also that the polygon
fill colors (table cells)
were changed from
the uniform gray of
the table when the
snapshot was saved.

Wells and Tanks
South Ranch

WANT TO KNOW MORE?

Managing Geoattributes
See the tutorial booklet entitled:



• Add terrain raster as a layer in a display Group or Layout.
• Select Relief Shading from the Right Mouse Button menu for terrain raster
   and set up relief shading.
• Add terrain raster (or copy) as a second layer.
• Select or create color palette for upper layer and set transparency value on
   Raster Layer Controls options panel.
• Increasing both sun elevation angle and Z-scale for the shaded layer creates
   a brighter image with more shading contrast.
• Decreasing transparency value for the color-mapped layer softens colors and
   emphasizes terrain texture.

Color Relief Shading

How Color Relief Shading Works

•  Create enhanced views of terrain rasters
•  Visualize terrain texture along with color-coded elevation information
•  Separate control of shading and color palette settings
•  Freely vary mixture of color and shading

DID YOU KNOW . . . you can create terrain views that combine
shaded relief and colors keyed to elevation ranges?

What Color Relief Shading Gives You

WANT TO KNOW MORE?

MicroImages’ Web Site
Search the information available on



Calculation of fertilizer application
rate for management units using
expected yield and average soil
nitrate and organic matter values.

Computed Attributes

How Computed Attributes Work

•  Create fields that read numeric or text information from other tables
•  Automatic updating when contributing fields are changed
•  Create “virtual tables” made up of selected fields from other related tables
•  Perform simple or complex mathematical calculations
•  Concatenate text strings from several fields into one text entry
•  Freely update numeric and string expressions or make field permanent

•  Add field to the database table using the Table Properties window.
•  Set Field Type to Computed for numerical data or String Expression to read

in text strings.
•  Press the Edit Expression button to open the SML window.
•  Construct desired mathematical or string expression using standard opera-

tor symbols and functions.
•  Use Insert icon to insert references to fields in other tables in the form

Table.Field.

DID YOU KNOW . . . you can do mathematical computations and
combine text in database tables?

What Computed Attributes Give You

Fields read from related tables

WANT TO KNOW MORE?

Managing Relational Databases
See the tutorial booklet entitled:
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Connect Points

How Connect Points Works

•  Create elements quickly by “connecting the dots.”
•  Update geodata with precise GPS input
•  Draw in one object using reference points from another object
•  As you draw, your lines snap to the exact position of the reference points.
•  Choose start and end points, line direction, and which points to include.

• Add your input points as a layer in the Spatial Data Editor, either as a
reference layer or as the active editing layer.

• Select the Connect Points icon from the Vector Tools palette.
• Click the Layer button in the Connect Points window and specify which layer

has the input points.
• Trace with the Connect Points tool.  Each time you click the mouse button,

the editor adds a new segment to your prototype line, snapping its endpoint
to the nearest input point.

• Click the Add button in the Connect Points window to save your trace as a
new line or polygon element.

What the Connect Points Tool Gives You

As you draw with the
Connect Points tool,
your line snaps to
the exact position of
the nearest point
element in the input/
reference layer.

GPS points are used to define an
expanded boundary for a field.
The older reference image
matches the outdated field
boundary.  After the new boundary
is added, the old boundary line is
deleted.

Click the Layer button to choose
which layer has the input points.

DID YOU KNOW . . . that you can trace through points to create a
line or polygon?

WANT TO KNOW MORE?

Editing Vector Geodata
See the tutorial booklet entitled:
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Cut and Paste

How Clipboard Cut and Paste Works

•  Quickly and easily move text between TNT and your Windows applications
•  Paste data directly into TNT database tables
•  Collect metadata from external documents; even from Web pages
•  Copy and paste text between multiple TNT processes
•  Simple right-button pop-up mouse menus for all editable text
•  The X Selection is automatically copied to the Windows clipboard

• From TNT: Click the right mouse button on any editable text to open TNT’s
popup edit menu.

• From Windows: select and copy text to and from the clipboard as always.
• From other X Clients:

DID YOU KNOW . . . that you can cut, copy and paste text through
the Windows Clipboard?

What Cut and Paste Gives You

Click the right mouse button on the MI/X icon in the Windows System Tray to
open the MI/X menu.

Select Copy X Selection to Windows Clipboard to copy selected text from
the X Client to the clipboard.

Select Make Windows Clipboard the Primary Selection and then use the
client’s Paste command to move text from the Clipboard to the X client.

The right mouse
button pops up an
edit menu for
clipboard
operations

The mouse button
editing tools in your
Windows apps
access the clipboard.

Cut, Copy, and Paste

WANT TO KNOW MORE?

MicroImages’ Web Site
Search the information available on
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Mutually Exclusive Groups

WANT TO KNOW MORE?

Designing Electronic Atlases
See the tutorial booklet entitled:

How to Get Mutually Exclusive Groups

•  Defined sets of groups that are mutually exclusive
•  Ability to switch between groups without hiding/unhiding or changing drawing

order

•  Click on the Settings icon for any group you want to add to a mutually
exclusive set.

•  Click on the Special tab and choose the desired mutually exclusive group set
number from the option menu.

•  Repeat for each group you want in a mutually exclusive set.

DID YOU KNOW . . . you can make display of groups within a layout
mutually exclusive?

What Mutually Exclusive Groups Give You

You can create up to 8 mutually
exclusive group sets.  All
groups that belong to the same
group set have mutually exclu-
sive display—you turn one on, it
turns the others off.  In this
example, the 6 base image
raster groups have been made
mutually exclusive.

These groups
belong to mutually
exclusive group
set 1
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Mutually Exclusive Layers

WANT TO KNOW MORE?

Designing Electronic Atlases
See the tutorial booklet entitled:

How to Get Mutually Exclusive Layers

•  Intuitive interface for inexperienced user
•  Ability to switch between layers without hiding/unhiding or changing drawing

order

•  Click on the Settings icon for a group or choose Settings from the Display
menu in the Display Manager window when there is no layout added.

•  Click on the Special tab and toggle on the “Layers are mutually exclusive”
button.

DID YOU KNOW . . . you can make display of layers within a group
mutually exclusive?

What Mutually Exclusive Layers Give You

Before making layers mutually exclusive,
all visibility boxes are checked and all
legend samples are shown (right).

After turning the feature
on, the visibility box is
checked only for the
active layer and only its
legend is shown.

Click on another
layer in the
LegendView and
it is immediately
displayed.



Relief Shading

How Relief Shading Works

•  Create familiar enhanced view of the shape of the surface
•  Enhance drainage patterns, geologic structures, and other features
•  Vary illumination direction to emphasize particular directional structures
•  View at true vertical scale or exaggerate the relief

• Add a surface raster layer to a display Group or Layout.
• Select Relief Shading from the Right Mouse Button menu.
• Use the graphic controls in the Relief Shading Adjustment window to adjust

the illumination direction (azimuth) and sun elevation angle (Elevation).
• Use the slider to adjust Z Scaling; press Apply to apply settings to the view.
• To apply these Relief Shading settings to the raster automatically the next

time it is displayed, open the Raster Layer Controls window and turn on the
Relief Shading toggle button on the Options panel.

DID YOU KNOW . . . you can display any elevation model or other
surface raster in shaded relief with illumination from any direction?

What Relief Shading Gives You

WANT TO KNOW MORE?

MicroImages’ Web Site
Search the information available on
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SML Scripts

How SML Works

•  Build customized processing routines for unique needs
•  Assemble complete specialized products for general applications
•  Bundle scripts together with geodata for special distribution
•  Create interactive tools that run from custom icon buttons and toolbars
•  Use online documentation and help as you build and test prototypes.
•  Apply SML techniques to stand-alone scripts, queries, geoformulas,

cartoscripts, bundled SML applications, and custom push-button tools.

• Use any text editor to create your script (*.sml).
• Include functions for Project File access, display, user input, database

access, and geospatial data analysis.
• Refer to the complete online help for SML functions, syntax, and use.
• Use the Syntax checker and SML Debugger to find and correct problems.
• Run SML scripts in the SML process, or from a custom menu or toolbar.
• Run stand-alone applications bundled with geodata from an icon on your

desktop or custom toolbar.
• Add geodata layers dynamically created by SML to a view.
• Apply custom tools by adding push-button icons to the interface.

DID YOU KNOW . . . that you can write SML scripts to add
customized functions and tools?

What SML Scripts Give You

An SML script can be anything from a single statement
to a long structured program with nested logical
branching constructs and external program calls.
MicroImages provides scores of sample SML scripts to
give you models to work from. You can examine and
adapt scripts ranging from simple processing routines
to complex custom applications that contain hundreds
of lines of code. The real power of SML lies in its rich
function library that lets you create your own custom
tools and specialized geodata analysis routines by
accessing the geospatial objects and subobjects in
your TNT Project Files. MicroImages is constantly
enhancing and expanding the SML functions to give
you more ways to work with your geospatial data.

WANT TO KNOW MORE?

Writing Scripts with SML
See the tutorial booklet entitled:
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Tabular Views in Layouts

How to Set Up Tabular Views for Layouts

•  Alternative legend presentation
•  Increased attribute information along with drawing style for elements
•  Choice of all records or selected records, data and/or statistics

• Set tabular view exactly as you want it saved (show styles, hide fields, etc.).
• Choose Save As from the Table menu, and set Format to CAD Snapshot.
• Set styles for text, lines, and polygons, changing colors and fonts as desired.
• Choose Add CAD Layer for a new group in a layout and enter desired size

directly in the layout panel of the Group Settings window.

DID YOU KNOW . . . you can save a tabular view as a CAD object
and include it in a layout?

What Tabular Views in Layouts Give You

This layout presents the population
for the western USA using two
different themes.  The CAD
representation of the table in the
layout includes the data for both
these themes and more.  The
original tabular view is shown
below.

Here, only the
records attached to
selected elements
were saved as a
CAD snapshot.  Note
also that the polygon
fill colors (table cells)
were changed from
the uniform gray of
the table when the
snapshot was saved.

Wells and Tanks
South Ranch

WANT TO KNOW MORE?

Managing Geoattributes
See the tutorial booklet entitled:
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Virtual Desktop

How to Set Up Your Large Workspace

•  A large workspace for increased productivity
•  Stretch very large View windows across the entire workspace
•  Resize a View window for a full view of its geodata at a chosen map scale
•  A Workspace Overview provides tools for moving all windows around in the

workspace

DID YOU KNOW . . . that using a large X Server workspace lets
you create and use large View windows?

What a Virtual Desktop Gives You

More memory allows
you to have large View
windows in the display
process.

• Select Preferences from the MicroImages X
Server title bar menu.

• Choose a Workspace Size in the MicroImages X
Server Preferences dialog.  (Your changes will
take effect in the next session.)

• Use the Workspace Overview window to move
around in the workspace.

• Resize a View window by selecting Resize To
from its Options menu.  If you have 128 Mb of
RAM, try Double Height and Width.

Move the red view box or
drag the thumbnails in the
Workspace Overview.

WANT TO KNOW MORE?

MicroImages’ Web Site
Search the information available on
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Automatic Projection Reconciliation

How Automatic Projection Reconciliation Works

•  Minimize map distortions to suit your project material’s content
•  Match layers in a variety of projections to a reference map
•  Present all layers in a view in a familiar projection
•  Quickly preview projections for a printed map or atlas

• Add any number of georeferenced layers to a display group.
• Select Group/Projection/Clipping to open the Group Settings dialog.
• Set Auto-Match to None in the Group Settings option button.
• Click the Projection button in the Group Settings dialog.
• Choose System, Projection, and Parameters in the Coordinate System /

Projection Parameters dialog.
• Click the Redraw button in the Group Settings dialog to view the reprojected

results.

DID YOU KNOW . . . the display process automatically warps all
layers in a group to the new map projection you select?

What Automatic Projection Reconciliation Gives You

A 9200 x 8250 AVHRR
raster image of North
America and a vector layer
of U.S. states are viewed in
three map projections.

WANT TO KNOW MORE?

Introduction to Map Projections
See the tutorial booklet:
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Color Scale Range Legends

How Color Scale Range Legends Work

•  Automatically creates color samples and labels
•  Use up to 256 legend entries
•  Quickly reorder and reformat entries in your print layout

• Display the raster in a Group or Layout.
• Select or create a color palette for the raster.
• Choose Color Scale Ranges for Legend Type in Raster Layer Controls window.
• Enter the desired number of legend entries.
• LegendView automatically creates representative color samples and labels.
• In a print layout, use the Add Legend icon button to add a multi-object legend.
• In the Legend Layer Controls window, press the Add from Layer icon button.
• Select the elevation raster layer.
• Reorder and reformat the legend entries to suit your layout.

DID YOU KNOW . . . that you can create data-range legends for
rasters?

Making Map Layouts

WANT TO KNOW MORE?

See the Getting Started Booklet:

What Color Scale Range Legends Give You
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Advanced Software for Geospatial Analysis

Voice: (402)477-9554
FAX:  (402)477-9559

MicroImages, Inc.

MicroImages, Inc. publishes a complete line of professional software for
advanced geospatial data visualization, analysis, and publishing.  Con-
tact us or visit our web site for detailed product information.

TNTmips TNTmips is a professional system for fully integrated GIS,
image analysis, CAD, TIN, desktop cartography, and geospatial data-
base management.

TNTedit TNTedit provides interactive tools to create, georeference,
and edit vector, image, CAD, TIN, and relational database project ma-
terials.  TNTedit can access geospatial data in a wide variety of com-
mercial and public formats.

TNTview TNTview has all the same powerful display features for
complex visualization and interpretation of geospatial materials as
TNTmips. TNTview is perfect for those who need flexible access to
the TNT project materials but do not need the technical processing
and preparation features of TNTmips.

TNTatlas TNTatlas lets you publish and distribute your spatial
project materials on CD-ROM at low cost. TNTatlas CDs contain
multiple versions of the TNTatlas software so that a single CD can be
used on any popular computing platform.

TNTserver TNTserver lets you publish TNTatlases on the Internet or
on your intranet.  Navigate through massive geodata atlases with your
web browser by using the free, open-source TNTclient Java applet (or
any custom applet you create) to communicate with TNTserver.

TNTlite TNTlite is a free version of TNTmips, TNTedit, and
TNTview for students and professionals with small projects. You can
download TNTlite for your computer (about 100MB) from MicroImages’
web site, or you can order TNTlite on CD-ROM with the current set of
Getting Started tutorial booklets (shipping and reproduction charges
apply).

email: info@microimages.com
Internet: www.microimages.com

11th Floor – Sharp Tower
206 South 13th Street
Lincoln, Nebraska  68508-2010 USA
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GeoToolbox

How to Use the GeoToolbox

•  Integrated sketching and measuring with measurements immediately
available for any shape sketched

•  Save any line or polygon in a sketch object
•  Treat GPS input or log files as points, lines, or polygons
•  Use of tools for element selection
•  Region creation and management
•  Update Histogram, Profile, Cross-Section, and Update Contrast tools

•  Click on the GeoToolbox icon in the View window.
•  Choose the graphic tool you want to use and a tabbed panel.
•  Switch between panels to view information and perform operations.
•  Use the right mouse button to choose an action for a shape.

DID YOU KNOW . . . you can select from many tools for sketching,
measuring, and region management?

What the GeoToolbox Gives You

Here you are viewing measurments for a
polygon drawn to be added to a sketch layer.
Alternatively or additionally, you could choose
to create a region from the drawn polygon, use
it to select elements, or record the measure-

ments in a
text file.

Open Profile View
Update Histogram

Generate Cross-Section

Update Contrast

You choose the units of measure for length,
area, angle, position, and elevation.  You have
the option of showing layer specific information
for all layers, the active layer or no layers.  If a
surface layer has been added, you can also
show true surface distance, surface area, and
the area surface range.

WANT TO KNOW MORE?

Sketching and Measuring
See the tutorial booklet entitled:
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Line Style Libraries

How Line Style Libraries Work

•  Display styles let you immediately identify element types
•  Easily create legends for display or printed layouts
•  Use existing styles for professional looking results
•  Modify existing styles to create your own custom style libraries

• Display a vector object that contains line elements with roadway attributes.
• Open the Vector Layer Controls window.
• In the Lines tab, set Style to By Attribute, and click the Specify button.
• In the Assign Styles by Attribute window, click the Styles button for the Style

Object field.
• In the Select Object dialog, navigate to LITEDATA/BEREA/TIGSTYLE.RVC and

select the TIGER style object.
• In the Assign Styles by Attribute window, match the Attribute Values with

the Available Styles.

DID YOU KNOW . . . a selection of line style libraries is included
with the TNT sample data?

What Line Style Libraries Give You

This illustration shows the
line style library for TIGER
data which can be assigned
by line attribute or by query.

The Line Pattern Editor lets
you create new line styles
and modify line styles in
existing libraries.

Creating and Using Styles
See the tutorial booklet:

WANT TO KNOW MORE?
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Writing Scripts with SML
See the tutorial booklet entitled:

WANT TO KNOW MORE?

Macro Scripts

How Macro Scripts Work

•  Execute script from an icon button on any View window
•  Optional drop-down menu for the icon button to choose program options
•  Access any characteristics of View layers: extents, projection, zoom, ...
•  Operate on objects in the View or objects covering the same geographic area
•  Pass selected data to external programs

• Choose Options / Scripts / Macro Scripts from any View window.
• Press the Add icon button and select a script.
• Or to create a new Macro Script press the New icon to open the Query Editor

window.
• Add your own code to define the operation.
• Choose whether to set up a simple icon button or a menu button.
• Enter the list of menu choices if needed.
• The script icon button appears on the toolbar of all your TNT View windows.

DID YOU KNOW . . . that SML Macro Scripts automatically operate
on geodata in a View window?

What Macro Scripts Give You

sample Macro
Script saves a
snapshot of the
view window,
using a file format
selected from a
dropdown menu.

sample Macro
Script zooms the
view window to a
map scale selected
from a dropdown
menu.

SNAPSHOT

ZOOM TO SCALE
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Profile Views

How to Use Profile Views

•  Graph of the cell values for a straight or segmented line
•  Statistics for any point along a single profile
•  Profiles for multiple rasters or TINS
•  Analysis features with single object profile
•  Saved snapshots of profile graphic in raster form

• Click on the GeoToolbox icon in the View window.
• Choose any length or area graphic tool.  • Draw the line or area of interest.
• Click on the Open Profile View icon.
• Open additional rasters or TINs for profiles if desired.

DID YOU KNOW . . . you can view a profile of values in a reference
raster or TIN object?

Sketching and Measuring

WANT TO KNOW MORE?

See the Getting Started Booklet:

What a Profile View Gives You

The profile shown
indicates the changes in
elevation along the road
traced by the ruler tool.
The statistics are for the
value at the position of the
crosshair.  Below (A), the
profile for the same road
is shown together with the
autocorrelation values.
Below (B), the same
profile is shown with the
profiles for two other
rasters (green and blue).

You can only display the statistics graphs,
as in (A), when a single raster is selected
for profiling.

(A)

(B)
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Tool Scripts

How Tool Scripts Works

•  Execute script from an icon button on any View window toolbar
•  Provide standard drawing tools to interact with geodata in the View window
•  Use templates with skeletal function definitions and expand as needed
•  Operate on objects in the View or objects covering the same geographic area
•  Pass selected data to external programs

• Choose Options / Scripts / Tool Scripts from any View window.
• Press the Add icon button and select a script.
• Or to create a new script, press the New icon button to open the Query Editor

window with the Tool Script template.
• Remove the comment characters (#) in the template to activate functions.
• Add your own function code to define the actions for the tool.
• The script icon button appears on the toolbar of all your TNT View windows.

DID YOU KNOW . . . that SML Tool Scripts create graphic tools that
interact with geodata in a View window?

What Tool Scripts Give You

RASTER PROFILE
sample Tool Script:
draw line and get
vertical profile plot of
raster.

AREA STATISTICS
sample Tool Script:
draw polygon and
get raster statistics
for area.

WANT TO KNOW MORE?

Writing Scripts with SML
See the tutorial booklet entitled:



•  Instant access to any TNTmips process
•  Logical grouping of processes for specific tasks
•  Eliminate menu path navigation

You can create any number
of custom toolbars that
launch TNTmips processes
directly with a single click
rather than from the menu.

Custom Toolbars

•  Choose Tools/User Toolbars/Edit from the menubar.
•  Click on New, name your toolbar, and specify style parameters.
•  Add items from the list of available processes.
•  Change the default icon if desired.
•  Turn on the toggle for the toolbar on the User Toolbars menu.

How to Use Custom Toolbars

DID YOU KNOW . . . you can make your own toolbars for instant
access to any process on the menu?

What Custom Toolbars Give You

The information
below the Available
and Selected
Processes lists
applies to the
highlighted item in
the Selected
Processes list.

You can create a
general purpose
toolbar that has
icons for the pro-
cesses you use
most often, or you
can create toolbars
for specific tasks.

Search the information available on

WANT TO KNOW MORE?

MicroImages’ Web Site
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CartoScripts

How CartoScripts Work

•  Full range of drawing functions to create custom map symbols
•  Line navigation functions let you repeat symbols along lines
•  Vary symbol styling and / or orientation based on database attributes
•  Add labels to symbols using text from database
•  Create CartoScript style samples in legends

•  Choose Style: By Script for point or line elements in a vector object.
•  Press Style: Specify to open the Query Editor window.
•  Use the CartoScript functions to define drawing operations and navigate lines.
•  Include references to needed database attributes in the form TABLE.FIELD.
•  The script is evaluated independently for each element.
•  To create legend samples, select a representative vector element, right-click,

and choose Add Active to Legend from the pop-up menu.

DID YOU KNOW . . . you can use CartoScripts to design and draw
custom map symbols for vector points and lines?

Using CartoScripts

WANT TO KNOW MORE?

See the tutorial booklet:

What CartoScripts Give You

CartoScript samples
in LegendView

CartoScript samples
in print layout
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Common File Extensions

RVC Integrated data structure (called a Project File) for large,
user-defined collections of raster, vector, CAD, TIN, and
database objects and associated subobjects, such as
contrast tables, georeference, and display parameters.

ATL File with startup parameters for TNTatlas generated by the
Atlas Wizard or the HyperIndex Linker tool.

SIM File with texture and terrain layers optimized for real-time
display in TNTsim3D that are generated by the Landscape
Builder process.

SML File written using Spatial Manipulation Language (SML) to
manipulate raster, vector, CAD, TIN, and/or database
objects for custom purposes.

GSF Specialized script (GeoFormula) that derives a layer by
altering a geospatial object or combing several objects
during a display action.

QRY Query script used for selection or styling of vector, CAD, or
TIN elements.

RLK RVC "stub" file associated with directly linked files in
external formats that contains link and auxiliary information,
such as georeference information and pyramids.

LOK, KOL Lock files to prevent writing to a Project File when it is in
use by more than one process.

FMT Contains the format for user-defined imports, such as vector
from text and user-defined raster import.

GSC GeoCatalog file used for the selection of objects for display
by their geographic extents.

DID YOU KNOW . . . the small number of file extensions used by all
the TNT products?

Online Reference Manual

WANT TO KNOW MORE?

See the Basic System Operations and Process volumes of the

 File Extension Description

*

*

*

*When you see these icons, the extension has been associated by Windows
to launch the corresponding product.

MicroImages makes every effort in the design of the TNT products to keep file
extensions to a minimum and hidden.  However, some are necessary, and
these are the ones you are most likely to encounter.



Unusual File Extensions

GPS GPS log file for use in the TNT products.

PRM Parameters file for Radar Slant to Ground Conversion.

DST Used in Priroda Lens Correction for specification of photo-
grammetric distortion values (radius/distortion pairs).

ARR Array of values that can be directly entered or generated by
the Principal Components process and provides coefficients
for user-defined raster linear combinations.

RPT Database report file.

TBF Batch file used primarily to set up and run print jobs at a later
time.

USR Custom user information, such as user-defined toolbars and
color maps.

CST Customization settings for TNTatlas/X created from your
customization settings by the TNTatlas Assembly Wizard.

PRF, P1 Pair of files generated by a TNTmips print driver to be copied
directly to a printer port.

OF Outline fonts created for use with TNT products before the
advent of TrueType font support.

TKP Special type of SML script with embedded data used as a
standalone application.

GPT Group saved as text, rather than in RVC Project File Format.

LTT (LYT) Layout saved as text, rather than in RVC Project File Format
(old format).

TPL Template saved as text, rather than in RVC Project File
Format.

SYM Symbol saved as text rather than in RVC Project File Format.

DID YOU KNOW . . . the small number of file extensions used in very
specialized TNT procedures?

Online Reference Manual

WANT TO KNOW MORE?

See the Basic System Operation and Process volumes of the

 File Extension Description

These extensions are for MicroImages’ file types that are seldom used, and
you are unlikely to encounter them.
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GeoCatalogs

How to Use GeoCatalogs

•  Selection of objects by geographic extents
•  Geographic extents defined by currently displayed object(s), selected

region, or center point coordinates
•  Control of the type of TNT objects located

•  Create a GeoCatalog of data you want to access by geographic location
(Support / Geospatial Catalog Manager).

•  Choose Add Layer / Add from GeoCatalog from the View window toolbar.
• Select the appropriate GeoCatalog and define object type, extents, cover-

age, and containment.
•  Choose Add Layer / Add from GeoCatalog, select the objects you want,

and click Apply (GeoCatalog window remains open) or OK (window closes).

DID YOU KNOW . . . you can select data by its geographic location
from your hundreds or thousands of Project Files?

Online Reference Manual

WANT TO KNOW MORE?

See the sections on GeoCatalogs in the:

What GeoCatalogs Give You

The group’s
geographic
extents automati-
cally define the
range, or you can
select a region or
enter a point
location.  After
setting new
parameters, click
on the Results tab
to search again.

The geo-
graphic extents
were defined
by the county
map of
Maryland.
Objects
located were
required to
have at least
90% of their
extents within
this area (containment) but no
minimum coverage was specified.



A
U

TO
M

A
T

IC
 L

A
B

E
L

 L
E

A
D

E
R

 L
IN

E
S

Automatic Label  Leader Lines

How Automatic Leader Lines Work

•  Leader lines inserted when auto-generated label is outside polygon
•  Lines elastically follow labels when repositioned
•  New leader line inserted when label moved from inside to outside polygon

•  Use the Auto Generate Label editing operation to create labels for
selected polygons.

•  Move a label out of a small or crowded polygon and a leader line
automatically appears.

•  Move any label with a leader line to a new position and the line will
follow.

DID YOU KNOW . . . leader lines appear or follow labels when label
position is edited?

Advanced Vector Editing

WANT TO KNOW MORE?

See the tutorial booklet:

What Automatic Label Leader Lines Give You

Leader lines automatically appear when a label  is moved outside its polygon.

Leader lines move with labels when they are repositioned.
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Open Any Object Type

How the Open Icon Works

•  Ability to select any object type to display: raster, vector, CAD, TIN, group,
layout, or template

•  Opens new group for object display if empty group not open already

•  Choose Open / Open and select any displayable TNT object type.
•  Make any other choice on the Open menu and select the TNT

object type specified.

DID YOU KNOW . . . you can open any type of TNT object from the first
icon on the Spatial Data Display toolbar?

Displaying Geospatial Data

WANT TO KNOW MORE?

See the tutorial booklet:

What the Open Icon Gives You

This Group View was opened
when the TIN object was
selected.  In this case, the
last-used display parameters
specify that the TIN object
selected be automatically
converted to and rendered as
contours at two specified
intervals, which were set on
the Contours panel of the TIN
Layer Controls.

Choosing Open / Open
lets you select any
displayable object type,
whether or not you
have a group or layout
open already.
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Recenter and Zoom on Cursor Location

How to Use the Keyboard and Cursor

•  Recenter on cursor location when you press the space bar
•  Zoom in on cursor location when you press the plus key <+>
•  Zoom out on the cursor location when you press the minus key <->

•  Position the cursor over the location you want to be the center of the next
view.

•  Press the space bar, plus, or minus key.
•  This feature is available in TNTmips, TNTedit, TNTview, TNTatlas for X and

TNTatlas for Windows.

DID YOU KNOW . . . you can recenter and zoom in and out on the
cursor location using the space bar, +, and - keys, respectively ?

What the Keyboard and Cursor Give You

To recenter the View over the
building at the bottom of the
current View (left), position the
tip of the arrow over the
building, and press the space
bar.

To zoom up and center on a
location in the image, position
the cursor over it and press the
plus key.

WANT TO KNOW MORE?

Hot Keys
See the Quick Guide:



WANT TO KNOW MORE?

Changing Languages (Localization)
See the tutorial booklet entitled:

TrueType Fonts for Localization

How to Use TrueType Fonts

•  Use with localization package for interface in any language
•  Download fonts from Internet
•  Print at any size without quality degradation from scaling

•  Acquire appropriate Unicode 2-byte fonts from the web or a font vendor and
install.

•  Install and select the desired localization package in TNTmips (Tools /
System / Preferences).

• Select the desired font (Tools / System / Fonts).

DID YOU KNOW . . . you can use TrueType fonts for any supported
language and to create symbols?

What TrueType Fonts Give You

The TrueType fonts you obtain and use
for menu and other interface elements
can also be used in your language for
your map legends, annotations,
automatic feature labels, error mes-
sages, documentation, and help.

DataTips pop in for
the feature nearest
the cursor

Your TrueType fonts are
also used for all field types
in database records,
including string fields, and
for DataTips and ToolTips.

You can also make point symbols from
TrueType fonts (see the Symbols from
TrueType Fonts Quick Guide).



Windows or X Desktop

How Desktop Choices Work

•  Use the Windows desktop to manipulate TNT windows like all other Windows
system and process windows.

•  Use the X desktop to take advantage of the large, virtual workspace in the
single MicroImages X Server window.

DID YOU KNOW . . . you can choose to run the TNT products on
either the Windows desktop or the unique virtual X desktop?

Windows Desktop or the X Desktop

WANT TO KNOW MORE?

What Desktop Choices Give You

Select Windows
Desktop to use the
default Windows
desktop.

Select X Desktop to
use the unique virtual
X desktop.

... with the Windows desktop

... with the X desktop

You can turn this option off
if you routinely run in the
same desktop mode.

• Open the MicroImages X Server Preferences dialog by clicking the MI/X icon in
the Windows System Tray.

• Select the Screen tab in the X Server Preferences dialog.
• Select the Windows Desktop mode or X Desktop mode.
• Open the General System Preferences dialog.
• Turn the “Prompt for desktop type at startup” toggle on.
• Exit all TNT processes and restart.  Your changes will take effect in your next

TNT session where you will be prompted to select interface type with the
default interface selection you made in the MicroImages X Server Preferences
window.

See the Technical Guide entitled:
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Extract and Trim DRGs

How Use Extract and Trim DRGs
•  Choose Process/Raster/Utilities/Extract and Trim DRGs.
•  Click on the Rasters button and select your DRGs.
•  Set the map scale.
•  Click on Run and name the output raster.

DID YOU KNOW . . . you can select a DRG directly in its TIFF format
and automatically extract it to trim off the collar information?

Online Reference Manual

WANT TO KNOW MORE?

See the section entitled Extract and Trim DRGs in the:

What Extract and Trim DRGs Gives You

If you want to display or mosaic adjoining DRGs
(Digital Raster Graphics files), you do not want the
collar information.  Here just one DRG is selected,
but you can select as many as you like.

•  First acquire your Digital Raster Graphics (DRG) files from USGS
•  Removes collar information
•  No need to import—just select the DRG TIFF file directly
•  Select multiple DRGs at the same scale for processing
•  Choose from DRGs at four different map scales
•  DRGs in RVC format ready to mosaic or display with others
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Editor’s Right Mouse Button Menu

How to Set Up and Use the Right Mouse Button Menu

•  Quick application of many editing functions with a single right mouse click
•  Customize to include those functions you use most often
•  Separate settings for vector, CAD, and TIN object editing
•  Use the tab key to step through all elements near your right mouse click

•  Choose Setup/Right Mouse Button in the Spatial Data Editor window.
•  Choose the tab for Vector, CAD, or TIN and turn on/off the desired functions.
•  With Edit Elements window closed, right click near element you want to edit.
•  Use the tab key to step through nearby elements if the one you want is not

initially selected.

DID YOU KNOW . . . you can set up a custom right mouse button
menu for a variety of editing functions?

Online Reference Manual

WANT TO KNOW MORE?

See the section entitled Right Mouse Button Option in the:

What a Custom Right Mouse Button Menu Gives You

RSet the right mouse
button menu options for
vector, CAD, and TIN
objects independently.
Note that available menu
options change as the
element type selected
changes.  The active
element (in magenta) is
above and to the left of
the right mouse button
menu.



•  Right click wherever text cursor has been placed (text block, database field,
DataTip prefix/suffix) and choose Character Map from the menu, or choose
Character Map from an Edit menu.

•  Scroll through the Character Map until you see the desired glyph.
•  Double click on the desired row to insert the glyph at the cursor position.
•  Note input entry code for future insertion of frequently used glyphs.

Use Special Characters

How to Insert Special Characters from the Character Map

•  Insert special characters into text group or database field
•  Scroll through all available glyphs in selected font
•  View/use input entry code
•  Look up glyphs by Unicode value

DID YOU KNOW . . . you can insert special characters from the
Character Map window without typing character codes?

What Inserting Special Characters Gives You

All languages have special characters not directly
represented on the keyboard.  The TNT products
provide two means of inserting such special
characters.  One is by selecting the glyph from the
Character Map window and the other is using <F2>
and the glyph’s corresponding input entry code.
The Character Map window lets you scroll through
all the glyphs in a font ordered by Unicode value.
The Character Map window presents the Unicode
value, glyph in selected font, input entry code, and
the glyph name in a single row.  You can double
click anywhere on this row to insert its glyph.

The right mouse button
menu in the text entry
field is shown at the left.
You can also open the
Character Map from the
Edit menu in the same
window.

Unicode
value

glyph in
selected
font

input
entry code name of

glyph

The eight special characters in the
screen capture above were selected
and inserted from the Character Map
window.

WANT TO KNOW MORE?

Inserting Special Characters
See the Technical Guide entitled:
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Operational Database Constraints

How to Use Functional Database Constraints

•  Selection from a pick list of allowable entries
•  Control the range of acceptable values
•  Autocompletion based on first few characters entered
•  Specification of default value to be shown for each field
•  Opportunity to fill all fields by selection to avoid keyboard use
•  Creation of informative error messages for incorrect entries

•  Create tables with pick list choices.
•  Create tables with autocompletion values.
•  Create table with field constraints and set as desired.
•  Open table in single record view.
•  Add or select elements and choose from option menus or enter data from

the keyboard as appropriate.

DID YOU KNOW . . . you can place constraints on fields to control
how they are filled out?

Managing Relational Databases

WANT TO KNOW MORE?

See the tutorial booklet entitled:

What Functional Database Constraints Give You

Field constraints apply only
to data entry in single
record view.  Constraints
are part of the table
definition.

In this example,
points are added to a
pinmap.



 C
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Cosmetic Database Constraints & Forms

How to Use Cosmetic Database Constraints & Forms

•  More attractive tables
•  Field prefixes longer than allowed for field names
•  Field prefixes can include spaces and symbols not valid for field names
•  Text after (to right of) database field
•  Multiple fields on one line with forms
•  Labels not attached to fields

•  Click on the Database Constraints tab in the Edit Definition window.
•  Select fields in succession modifying Before and After text fields as desired.
•  For forms, click on the Make Table/Form icon and choose New Form, then

consult the Database Forms Quick Guide.
•  With the Edit Form window open when using a fixed width font, simply drag

fields in predefined increments for desired alignment.
•  With the Edit Form window open when using a proportional font, you may

need to hold the shift key while dragging fields for refinement of alignment.

DID YOU KNOW . . . you can change the field prefix to include spaces
and symbols not allowed in field names and add text after a field?

Online Reference Manual

WANT TO KNOW MORE?
See the sections entitled Database Constraints and

Manipulating Database Forms in the Display volume of the:

What Cosmetic Database Constraints & Forms Give You

Field names
would be as
shown in the
column above
left if not altered
by constraints
or with a
database form.

Compare the results that can be
achieved using cosmetic
database constraints (below, left)
and database forms (below,
right).  Database forms provide
headings but do not let the user
change viewing units.



•  Click on the Make Table/Form icon, choose New Form, and enter a name.
•  Choose Table/Edit Form in the newly named form window.
•  Select the table to provide fields for the form.
•  Add fields and labels and drag them to the desired position.
•  Choose Table/Edit Form to make additions or changes to an existing form.

Design Database Forms

How to Make Database Forms

•  Independent labels that can be used as headings or after database fields
•  Field prefixes and labels that include spaces and symbols not valid for field

names, such as * and &
•  Multiple fields on one line
•  Custom alignment of fields

DID YOU KNOW . . . you can create a form from a table for data entry
and viewing that includes the fields and added labels of your choice?

What Database Forms Give You

Each time you
add a field or
label, a new
line is added to
the form.  It is
often best to
wait until all
fields and
labels are
added before
aligning them
so you do not
have to redo
alignment
work.

Initial form shown at left after
fields and labels added.  Rede-
signed form shown below.

WANT TO KNOW MORE?

MicroImages’ Web Site
Search the information available on



Zoom to Full Resolution (1X)

How to Choose the Full Resolution Zoom Raster

•  Control over which raster in a group or layout with multiple layers provides the
resolution for full resolution zoom

•  Full resolution zoom raster need not be the bottom layer

•  Add all desired layers to your display layout.
•  Click on the Raster icon for the layer you want to use for 1X zoom.
•  Click on the Options tab and turn on the Preferred for 1X zoom toggle.
•  Choose View/Zoom 1X, click on the View 1X icon, or press the “1” key

with the cursor over the spatial view.

DID YOU KNOW . . . you can choose any layer in a group or layout to
provide the scale for full resolution (1X) zoom?

What Choosing the Full Resolution Zoom Raster Gives You

Resolution for 1X zoom with 1-
foot airphoto used for 1X zoom

Resolution for 1X zoom with 10-
meter DEM used for 1X zoom

Go from full view of a layout
(left) or any other zoom level to
full resolution of the desig-
nated raster with a single click.

Visualization processes in the
TNT products permit you to
automatically combine
images of mixed resolution.
Thus, not all rasters dis-
played in a group or layout
must be of the same reso-
lution.  You may have an
elevation raster with 10-meter
resolution and an aerial
photograph with 1-foot
resolution as is the case with
the layout illustrated.

WANT TO KNOW MORE?

MicroImages’ Web Site
Search the information available on



Automatic Polygon Labels & Leader Lines

How to Use Automatic Polygon Labels

•  Quick labeling without using the Editor
•  Labels in any process with a View window
•  Optional leader lines with label placement outside polygon
•  Force labels to be inside polygon

•  Select the Polygon tabbed panel of the Vector Layer Controls and set the
Label option button to By Attribute or By Script.

•  Choose the labeling attribute or enter the script.
•  Specify the desired option for label Position.
•  Redraw if necessary.
•  The same label position options are also available when auto-generating

polygon label elements in the Editor.

DID YOU KNOW . . . you can control label position and the use of
leader lines for automatic (on-the-fly) polygon labels?

MicroImages’ Web Site

WANT TO KNOW MORE?

Search the information available on

What Automatic Polygon Labels and Leader Lines Give You



Copy Objects

How to Copy with Project File Maintenance

•  Copy complete Project Files
•  Copy individual objects of any type
•  Copy subobjects of allowed types
•  Back up only selected objects
•  Validate Project File during copy process

•  Choose Tools/Manage Project Files from the menubar.
•  Navigate to the Project File, object, or subobject you want to copy.
•  Click on the Copy icon.
•  Choose the destination Project File (new or existing).

DID YOU KNOW . . . you can copy files and most object types to a
new location using Project File Maintenance?

What Copying with Project File Maintenance Gives You

TNTmips offers extract
processes for raster and
geometric object types that
will copy all or part of the
selected input object(s).
Project File Maintenance
offers a simpler interface
that can be used for any
object type, Project Files as
a whole, and reusable
subobject types.

file level

1st
subobject
level

Style object copied
from subobject level
to main level in new
Project File that will
provide styles for a
number of different
objects or projects.

main level
object

WANT TO KNOW MORE?

MicroImages’ Web Site
Search the information available on
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Database Prompt in Spatial Data Editor

How to Use Database Prompt

•  Automatic prompting for attribute entry as new elements are added
•  Automatic prompting for attribute entry when elements are split or combined

by editing actions
•  New records automatically created
•  Populate database table without opening it

•  Create a new or open an existing vector or CAD object.
•  Choose Setup/Database Prompt in the Spatial Data Editor window.
•  Click on the table for the desired element type.
•  Click on existing table, add a table from another object, or make a new table.
•  Turn on the “Prompt when” toggle for the appropriate element type.
•  Add and edit  elements and enter attribute values when prompted.

DID YOU KNOW . . . you can be automatically prompted to enter
attributes when elements are added while editing?

Online Reference Manual

WANT TO KNOW MORE?

See the Setting Up Prompts for Database Editing section in
the Edit volume of the:

What Database Prompting Gives You

Clicking on any of the [Element]
Table buttons opens the Select Table
For Prompt window for that element
type.  You can select a table for each
element type if desired.

Once database prompting is set
up, you will be prompted to enter
attribute values each time you
add an element.  Splitting
polygons and merging polygons
by adding/removing lines also
generates a database prompt.



Toggle Map Grid Tick Mark Colors
DID YOU KNOW . . . you can toggle between two colors for interior
map grid ticks?

How to Set Up and Toggle Map Grid Tick Mark Colors

•  Greater visibility of map grid ticks over the entire map area
•  Quick change between two colors for any interior map grid tick mark
•  Two color options each for interior border ticks and interior ticks

•  Choose a primary (initially used for all interior grid ticks) and secondary color
on the Graphics panel of the Map Grid Layer Controls.

•  Examine your map for any interior ticks that are difficult to see.
•  Right click near such a map grid tick mark.
•  Choose Toggle Grid Tick Color.

What Toggling Map Grid Tick Mark Colors Gives You

Note the two color tiles in the Interior
Border Ticks and Interior Ticks panels.
The left tile identifies and selects the
primary tick color, which is initially
used for all interior tick marks, and the
right tile defines the secondary color,
which can be assigned to individual
tick marks by toggling grid tick colors.

WANT TO KNOW MORE?

Map Grid Tick Marks
See the Technical Guide entitled: Controlling Color of



Cross Sections with Styles

How to Generate a Cross Section with Styles

•  Immediate visualization of results
•  Styles that match the original vector
•  Easy interpretation with corresponding styles

• Open a new display group or layout, add a surface layer and a polygonal vector
or open a group or layout that has a surface layer and polygonal vector.

• Open the GeoToolbox and use any of the linear or area tools to draw the cross
section X-axis.

• Click on the Generate Cross Section icon in the GeoToolbox.
• Enter a base Z value and turn on the Show results in new window toggle* in the

Cross Section Options window, then click OK.
• Click on the New Object icon, name the cross section, and view the results.

DID YOU KNOW . . . you can generate a cross section with drawing
styles that match the original vector object?

What Cross Sections with Styles Give You

If you do not turn on this toggle, the cross
section will be saved but not immediately
displayed.

You can generate
cross sections when
using the GeoToolbox
in any TNT product.

The Cross Section
feature is active
once a line is drawn.

Cross-
section
path

* If you are generating your cross section in layout mode in TNTmips, TNTedit, or
TNTview, you also have the option to add the cross section as a new group in the
existing layout.  This feature is not available in group mode or with TNTatlas.

WANT TO KNOW MORE?

Sketching and Measuring
See the tutorial booklet:



•  Choose Tools/Manage Project Files from the menubar.
•  Click on the Info icon to open Object Information window.
•  Scroll this window to a subobject highlighted in magenta or red.
•  Use the Project File Maintenance window to navigate to this highlighted name.
•  Click on the Delete icon to remove invalid or conflicting subobject.

Adjust Project File Validation Errors

DID YOU KNOW . . . you can use Project File Maintenance to adjust
validation errors in a project file?

What  Adjusting Project File Validation Errors Gives You

How to Adjust Validation Errors with Project File Maintenance

•  Identify objects that have conflicting or invalid subobjects
•  Navigate to the objects that have validation errors
•  Resolve conflicts and remove invalid subobjects

Info icon opens
the Object
Information
window.

Delete icon is
used to remove
the conflicting
or invalid
subobjects.

WANT TO KNOW MORE?

Maintaining Project Files
See the tutorial booklet entitled: Understanding and

Conflicting subobjects are
highlighted in magenta,
and invalid subobjects are
highlighted in red.



• Create a text file of X,Y,Z values that start in specific columns or are separated
by a specific character (for example, tab or space).

• Choose Process / Import.
• Select “Text” as  your format to import and click on Next.
• Select 3D for the Coordinates menu and set other parameters to fit your text file.
• To create your DEM choose Process / Surface Modeling.
• Select Surface Fitting, Method: Inverse Distance.
• To create your contour lines from your DEMs choose Process / Surface Modeling.
• Select Contouring, Method: Linear, Cubic, or Iterative Thresholding.

Create DEMs from Text Files

How to Create DEMs and Contour Lines from Text Files

• Convert your X,Y,Z text data or database points to 3D vector points
• Convert 3D vector points to DEM surface
• Surfaces from any data
• Create contour lines from the DEM

DID YOU KNOW . . . you can create digital elevation models and
contour lines from text files?

What Creating DEMs from Text Files Gives You

     text file

 X Y  Z

     Digital Elevation Model (DEM)      contour lines

     vector points imported from text file

WANT TO KNOW MORE?

Surface Modeling
See the tutorial booklet entitled:



• Choose Edit / Spatial Data.
• Open a vector object for editing.
• Select the element(s) that you want to cut or copy.
• Select Cut or Copy, and then Paste into an editable vector or CAD layer.
• Choose from six clipping methods for defined areas when Cut or Copy.
• Optionally reposition, rotate, or scale elements before pasting.
• Save your new vector/CAD object.

Copy, Cut, and Paste Geometric Elements

How to Cut, Copy, and Paste Geometric Elements

• Select specific elements within the layer to cut or copy.
• Create new vector/CAD object with elements copied from any geometric layer.
• Paste elements from any geometric object into existing vector/CAD object.

DID YOU KNOW . . . you can copy, cut, and paste geometric ele-
ments of any type within an editable vector or CAD layer?

What Copy, Cut, and Paste Give You

     Select elements (roads in red)

     Paste icon (Ctrl-V)

To create a new vector or
CAD object with your “cop-
ied” elements, click on the
Create New Object icon and
select vector or CAD.

Pasted into the new object

WANT TO KNOW MORE?

Advanced Vector Editing
See the tutorial booklet:

     Create a new object

     Cut icon (Ctrl-X)      Copy icon (Ctrl-C)

Elements can be
rotated.

You can move
elements before
pasting.
Elements can be
rescaled.Copy all or only selected

elements from the entire
object or defined area.



Change DataTip Background Color

How to Change DataTip Background Color

•  Change color whenever desired
•  DataTips with better contrast for individual groups/layouts
•  Same background color for object wherever viewed (until changed)
•  Color can change depending on closest element found

[for fixed color]
•  Choose Tools/System/Preferences/Interface from the menubar.
•  Click on the ToolTip and DataTip Colors button.
•  Choose a background color in the Color Editor (all DataTips).
[for variable color by layer, enter in DataTip prefix field]
•  Open Layer Controls.
•  Enter {~BG misty rose} where misty rose is color name from rgb.txt.
•  Enter {~BG r,g,b} where r,g,b are % red, green, and blue desired.

DID YOU KNOW . . . you can specify the background color of Data-
Tips and change it for each layer?

What Changing DataTip Background Color Gives You

A multiline DataTip specified in a virtual field for a single layer can contain the color specification
for its background, but here (above left and right) it is specified in the prefix field for the DataTip
in the Layer Controls.

The changing DataTip background color in the three illustrations above is controlled by position
and map scale (DataTip viewing option set to Visible Layers).   At Full View (above left) layers
with color-specified DataTips are not drawn so the default background color is used.  When
zoomed in so that layers with background color specified in the DataTip prefix show, the position
of the mouse determines the color (middle and right).

background color
specified as r,g,b%

color name used to
specify background

WANT TO KNOW MORE?

Setting DataTip Background
See the Technical Guide entitled:



Direct Use of ESRI Shapefiles (*.shp)

How to Directly Use ESRI Shapefiles

•  View as layer(s) without importing the file(s)
•  View without altering original file(s)
•  Use same name *.avl for styles if present
•  Use same name *.prj for georeference information if present
•  Assumed as Latitude/Longitude if no *.prj and coordinates within ± 360°
•  Advanced TNT product features maintained in link file (for example, DataTips)
•  Select files for any TNT process, not just viewing, such as Vector Merge

•  Double-click on the file.
•  Use Open With to open in new View in Spatial Data Display.
•  Browse to and select file in any TNT  Select Objects dialog.

DID YOU KNOW . . . you can directly view and use ESRI shapefiles in
the TNT products?

Sharing Geodata with Other Popular Products

WANT TO KNOW MORE?

See the tutorial booklet entitled:

What Directly Using ESRI Shapefiles Gives You

The illustration above shows some of the advanced features you can use when displaying
your linked shapefiles directly in the TNT products without changing the shapefile in any way.
All three shape layers make use of DataTips, which are provided by a selected database
field(s) and defined in the TNT link file (*.rlk).  The selected database fields can be in the
shapefile or the link file.  The countries layer uses the *.avl file to provide polygon fill styles
while the rivers layer uses styles created and assigned by attribute in TNTmips and the cities
layer uses theme mapped styles to reflect population.  These style specifications are maintained
in the TNT *.rlk file and used automatically the next time the shapefile is used in TNTmips.

City: Essen
River: Rhine
Country: Germany



• Double-click on the file.
• Use Open With option and select TNT product.
• Browse to and select file in any TNT Select Objects dialog.

Direct Use of MrSID Files (*.sid)

How to Directly Use MrSID Files

• Automatic display without importing files
• Fast display of large files
• Use as raster object wherever appropriate such as Mosaic (which means, do not

use lossy rasters in TNT automated analysis and sketching processes)
• Raster DataTips are available
• Use in TNTatlas without importing

DID YOU KNOW . . . you can directly display and use MrSID files in
the TNT products? (MrSID is the propietary wavelet based compres-
sion format of LizardTech, Inc).

What Directly Using MrSID Files Gives You

WANT TO KNOW MORE?

Sharing Geodata with Other Popular Products
See the tutorial booklet entitled:

The 6 tiles of compressed MrSID files (between 198 and 228 MB each) shown
were downloaded free from https://zulu.ssc.nasa.gov/mrsid/.  These tiles from
the year 2000 are Landsat-ETM bands 7,4,2 displayed as R,G,B, and sharpened
by the Panchromatic band with a final pixel size of 14.25 meters.  Each tile
encompasses 5 degrees in Latitude and 6 degrees in Longitude. They are
compressed nominally 30 to 1 and would be 40.2 GB when uncompressed.

Mosaic display of 6 tiles of Landsat GeoCover in MrSID files.

Time to display 6 MrSID files totaling 1.3 GB (total 40.2 GB uncompressed).

MrSID files may have
associated georefence that is
used automatically by TNT
products (for example, if
there is a co-named
companion *.sdw file).

DataTip displayed for
image cell in 24-bit color
composite MrSID file.

Selection of MrSID files
in the Mosaic process.



Direct Use of Popular Geodata Formats

How to Directly Use Other Geodata Formats

•  View without importing files
•  View without altering original files
•  Advanced TNT product features maintained in link file (for example, DataTips)
•  Select files for any TNT process, not just viewing
•  Double-click on file to open in new 2D Display group

DID YOU KNOW . . . you can directly view and use geodata in other
raster, shape, and CAD formats?

Sharing Geodata with Other Popular Products

WANT TO KNOW MORE?

See the tutorial booklet entitled:

What Directly Using Other Geodata Formats Gives You

format extension description
Raster
TIFF *.tif Tagged Image File Format, developed by Aldus and

Microsoft, copyright now held by Adobe Systems
*.tfw world file used for georeference if same name

GeoTIFF *.tif an effort by over 160 different remote sensing, GIS,
cartographic, and surveying related companies and
organizations to establish a TIFF-based interchange format
for georeferenced raster imagery

JPEG2000 *.jp2 Part 1 compliant files supported, may contain georeference
as internal metadata, uses wavelet compression developed
by LuraTech and others

*.j2w world file used for georeference if same name
JPEG *.jpg Joint Photographic Experts Group

*.jgw world file used for georeference if same name
PNG *.png Portable Network Graphics

*.pgw world file used for georeference if same name
MrSID *.sid LizardTech proprietary wavelet compression format

*.sdw world file used for georeference if same name
ECW *.ecw Earth Resources Mapping proprietary wavelet compression

format, georeference may be in *.tab file

Shape
shapefile *.shp ESRI format, may have internal georeference

*.avl used for styles if same name
*.prj file used for georeference if same name

Oracle Spatial Oracle Spatial is not a file based format, select by table

CAD
DGN *.dgn Intergraph Microstation format
TAB *.tab MapInfo format, internal georeference
DXF *.dxf AutoCAD Drawing eXchange Format
DWG *.dwg AutoCAD Drawing format

•  Select just like any RVC format object.



• Open the Spatial Data Editor and open your vector object.
• Click on Show Details and turn off element selection for all but labels.
• Click the right mouse button near a label and choose Edit.
• Add the control codes you need in the Text Label Edit Controls window.

Format Label Elements

How to Format Labels

• Add specified text formats to your labels in any language
• Improve appareance of your labels
• Labels using scientific notation

DID YOU KNOW . . . you can edit and change the appearance of your
labels in any language?

What Formatting Labels Gives You

Change text size
and color...

 Edit the label’s style in the Text
Label Edit Controls window.

{~TS18~C100,0,0~I~GLR25}Na{~S-}2{~S0}SO{~S-}4

Add superscript and
subscript characters...

text size in
points

color RGB
values

subscript

  Click the right mouse
button on the label.

Text Formatting Control Codes:
(See the Text Style Formatting Codes Quick Guide for all codes)

WANT TO KNOW MORE?

Advanced Vector Editing
See the tutorial booklet entitled:

{~TS18~C100,0,0} Na{~S-}2{~S0}SO{~S-}4

subscript

turns off
subscript

 Set element selection
to labels only.

{...~I~GLR25}Na...

Add italic and
glyph rotation...

glyph rotation in
25 degrees

italic default shear
of 16 degrees



Geometric Object Types

How to Use Different Geometric Object Types

•  Vectors with polygonal, planar, and network topology for spatial relationships
•  Shape objects to directly use shapefiles, Oracle Spatial layers, and TAB files
•  CAD for sketching and geometric shapes and using DWG, DGN, and DXF files
•  TIN objects to represent 3D surfaces
•  Region objects to define irregular areas for selecting and extracting, and so on

(note: bounding polygon of vector object automatically used as region object)

•  Choose appropriate object type for your data and its initial use.
•  Copy/paste from any geometric object type into vector/CAD object in Editor.
•  Merge any geometric object types into vector or CAD objects.
•  Use conversion processes (Process/Convert/Geometric to CAD, region, or

vector) to convert between different geometric object types.

DID YOU KNOW . . . the TNT products provide integrated support for
five geometric object types (vector, shape, CAD, TIN, and region),
many raster data types, and various RDBMS?

WANT TO KNOW MORE?

What Different Geometric Object Types Give You

Vector Analysis Operations
See the tutorial booklet entitled:

When polygon boundaries must define mutually exclusive ground areas (for example, no
area is part of Texas and Oklahoma), a vector object with polygonal topology is needed.
Some objects that ultimately require polygonal topology may have started as a sketch
layer (CAD).  If these elements should be added to an existing vector object, you can use
the Merge process or copy and paste in the Spatial Data Editor.

vector object

region object

Any vector can be
selected as a
region and all
internal
boundaries are
automatically
dissolved.

CAD object TIN objectshape object



• From the main menu, open the Style Editor (Edit/Styles), and click on the New
icon; or from the Object Layer Controls window, click on the Edit Styles icon in
the Assign Styles by Attribute window.

• Click on Insert Symbols icon and select style object you want to insert from.
• Select the styles you want in that style object using the Select Styles window

that opens, and click OK.

Insert Styles

How to Insert Styles

•  Use previously created style objects for creating new style objects
•  Insert styles from any style object to which you have access
•  Combine separate point, line, and polygon style objects into one

DID YOU KNOW . . . you can insert styles for points, lines and poly-
gons from a previously created style object?

What Inserting Styles Gives You

WANT TO KNOW MORE?

Creating and Using Styles
See the tutorial booklet  entitled:

In this example, some of the polygon styles
from an existing style subobject are inserted.

styles to choose
from other style object

styles are inserted in
the new style object



•  Download free SML from MicroImages website located at
      http://www.microimages.com/sml/raster_labeller.htm or copy it from the
      \Scripts\ScriptLayer folder of the TNT products CD.
•  Open Spatial Data Display.
•  Add the raster objects you want to display.
•  Click on the Add SML Layer icon to open the SML Layer Controls window.
•  Select raster_labeller.sml using the Script tabbed panel.
•  Edit the script to change color, height, and position of the labels.

Label Raster Objects for Display

How to Label Raster Objects

•  Ability to differentiate between rasters when displayed together
•  Add labels to all raster layers in a group
•  Use raster object names as labels in any view

DID YOU KNOW . . . you can label raster objects in a view using an
overlay layer created by a geospatial script (SML)?

What Labeling Raster Objects Gives You

WANT TO KNOW MORE?

Editing Raster GeoData
See the tutorial booklet entitled:

In this example,
4 raster objects
are displayed
with the labels
associated with
the object
names.

The Add SML Layer icon
is used to add the SML
raster_labeller script.
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Pan by Query

How to Pan by Query

•  Ability to examine and/or edit all elements that match the specified query
•  Step from one query selected element to the next
•  Automatically pan the view to each selected element
•  Work at comfortable zoom level without having to zoom in/out repeatedly

•  Zoom in to the level you want to work at.
•  Select elements by query, such as a query to select dangling lines.
•  Perform your editing task if needed, such as snapping lines.
•  Apply the edit to the active element.
•  Click on the Next Selected icon.

DID YOU KNOW . . . you can select elements by query when zoomed
in and move (auto-pan) from one element to the next with a button click?

Advanced Vector Editing

WANT TO KNOW MORE?

See the tutorial booklet entitled:

What Panning by Query Gives You

Even with TNTlite-sized data, as
illustrated here, you cannot make editing
decisions and manipulations at Full
View (above).  If you are zoomed in
when the query is applied, you automati-
cally pan to the first selected (active)
element.

Choose your zoom level using the zoom
tools and hot keys before selecting
elements, then apply the query.  Alterna-
tively, apply the query, then choose Zoom
to Active Element from the Tools menu.

apply query
and zoom in

Evaluate and edit, then click Next Selected.

active
element

selected
elements

active
element

not selected



Page Layout Placement Tool

•  Three viewing modes: standard, wireframe, and filled wireframe (solid)
•  Clicking on any group lets you drag it
•  DataTips identify group by name
•  Groups attached to other groups move as a unit
•  Context sensitive cursors: make active, drag, change attachment, no action

•  Click on the Placement tool.
•  Right click on View to change to wireframe or solid viewing mode.
•  Drag active group to new position.
•  Click on any group in View to make it active.
•  Right click on View to select Redraw from right mouse button menu.
•  Change back to standard mode at any time for WYSIWYG viewing.

DID YOU KNOW . . . the Placement tool provides three layout
viewing modes and interactive features?

WANT TO KNOW MORE?

What the Page Layout Placement Tool Gives You

Making Map Layouts
See the tutorial booklet entitled:

Group (component) extents boxes
and their page attachment arrows
are added to the View when you
select the Placement tool.  It is
easier to see, manipulate, and
precisely position these compo-
nents of your layout if you tempo-
rarily switch to wireframe or solid
viewing modes.  Your layout will
also draw faster in these modes.

How to Use the Page Layout Placement Tool

right mouse
button menu

wireframe
view

solid
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Use Polygon Attributes to Style Lines

How to Directly Use Polygon Attributes to Style Lines

•  Assisted query entry
•  Compare left/right polygon attributes to select/style line
•  Polygon dissolve for selection/styling

•  Open the Vector Layer Controls window
•  Set line selection and/or styling to By Query, and click on Specify.
•  Choose Insert/Field and set the Element option menu to Left Polygon.
•  Select the table and field for the selection/styling of the lines.
•  Click the Insert button.
•  Add your comparison operator or other query components.
•  Choose Insert/Field and set the Element option menu to Right Polygon.
•  Select the table and field for selection/styling of the lines.
•  Click the Insert button, then click OK.
•  Change the style for query selected lines as necessary.

DID YOU KNOW . . . you can use polygon attributes to determine line
drawing styles?

Creating and Using Styles

WANT TO KNOW MORE?

See the tutorial booklet entitled:

What Using Polygon Attributes to Style Lines Gives You

Wider lines for country borders enhance
visualization of maps with state/province
boundaries.  In the illustration above, lines and
polygons are drawn with all selected and an All
Same drawing style.  At the right, only the lines that
have different country names for the polygons on either
side are drawn using a wider drawing style.  The polygon drawing
color now shows because not all lines are selected.

NADESCPolBndA



• Choose Raster/Extract for grayscale objects.
• Select raster(s) and the Raster Extract window opens.
• Use the Output Type menu on the Values panel to select the desired bit-depth.

• Choose Raster/Combine/Convert Color for color objects.
• Set the input type and select raster(s).
• Select the output raster data type from the Output menu.

Convert Raster Data Types

How to Convert Raster Data Types

• Transform bit-depth for grayscale or color composite files
• Work with data at full extent of their bit-depth capacity
• Import files at the correct bit-depth format
• Work with binary, signed and unsigned integer, floating point, and complex rasters

DID YOU KNOW . . . you can work with a wide bit-depth range of
raster objects in TNTmips?

What Converting Raster Data Types Gives You

WANT TO KNOW MORE?

 For grayscale rasters (4- to 128-bits):

 For color rasters (4- to 24-bits):

Complex rasters are
available for output within
the raster data type options.

The Raster Color Conversion process also
allows you to compress the output file(s) to
several formats (i.e., Standard Lossless,
Huffman, and different types of JPEG).

The Raster Extract process allows you to
compress the output raster(s) to several
formats (i.e., Run Length Enconded, Standard
Lossless, Huffman, and different  types of
JPEG and JPEG2000).

The following input raster types can be selected:
Single, RGB Separate, HIS, HBS, and HSV (Munsell).

output type options for
color composite rasters

Technical Characteristics
See the booklet entitled: Introduction to



•  Choose Process / Raster / Extract and select raster.
•  Select Zoom / Orient tabbed panel.
•  Click on the Zoom option button.
•  To decrease cell size, select Zoom, otherwise select Sample.
•  Enter appropriate scale factors in Lines by and Columns by fields.
•  To re-orient the raster object, enter the desired angle in the “Rotate” field.
•  Select Rotate Clockwise or Rotate Anticlockwise icon to rotate raster object.
•  Select Vertical or Horizontal icon to flip raster object.

Scale and Orient Raster Objects

How to Scale and Orient Raster Objects

•  Change spatial resolutions of raster objects.
•  Rotate and flip objects with or without georeference.
•  Match spatial resolution of a reference raster.

DID YOU KNOW . . . you can change the cell size and orientation of
raster objects?

What Scaling and Orienting Raster Objects Gives You

original image
decreasing spatial
resolution 8 times rotating 45 degrees clockwise

flip image
vertically or
horizontally

rotate image
clockwise or
anticlockwise

Zoom: Decreases
cell size by scale

factor

Sample: Increases
cell size by scale

factor

rotate image by
specified angle

WANT TO KNOW MORE?

MicroImages’ Web Site
Search the information available on



Save Scripts with Groups/Layouts

How to Save Scripts with Groups/Layouts

•  Macro, Tool, and Control Scripts available when open Group/Layout
•  Use data-specific custom tools from icon button on toolbar
•  Scripts work with objects in a specific, opened group/layout as designed
•  Scripts and tools can be automatically embedded for use in TNTatlas

•  Choose Use with: This group/layout only for Macro/Tool Script parameters.
•  Choose Group or Layout/Edit Control Script and type in or open custom script.
•  Save group or layout.

DID YOU KNOW . . . you can save custom tools and operations with
groups and layouts?

WANT TO KNOW MORE?

What Saving Scripts with Groups/Layouts Gives You

Writing Scripts with SML
See the tutorial booklet entitled:

When Tool or Macro
Scripts require specific
data, save them with a
group or layout that
contains that data.
Control Scripts are
always saved as part
of a group or layout.

custom tool

This layout uses a
Tool Script to find
properties, which
requires the
Parcels layer, and
a Control Script to
provide enhanced
DataTips using the
floodplain layer.

Sample GraphTips produced by Control Scripts for
different layouts (above).  Scripts can reference specific
data or the bottom/top layer in the group/layout.



Validate Project Files

How to Validate Project File Contents

•  Names of Project Files with conflicting or invalid subobjects are color-coded
•  Red: invalid objects (implied georeference under raster)
•  Dark magenta: conflicting subobjects (multiple

style or affine georeference subobjects)
•  Blue: objects linked to files or objects that cannot

be located (style objects, *.jp2 files)

•  Choose Tools/Manage Project Files and click on the Info button.
•  Locate and select any Project File with a color-coded name.
•  Scroll this Object Information to find the color-coded problems.
•  Delete invalid objects and resolve conflicts with Project File Maintenance.
•  Find missing linked files/objects and relink.

DID YOU KNOW . . . you can use Project File Maintenance to check
your RVC files for validity and conflicts?

What Project File Validation Gives You

Invalid and conflicting objects could be created in earlier
versions of the software that enforced less rigorous Project File
rules.  You may still inadvertently cause missing linked files by
moving, renaming, or deleting the file or object that is linked to.

Subobjects that are invalid or are in
conflict (more than one exists and only
one is allowed) are always color-coded in
the Object Information window whether
the Highlight Project File if validation
errors exist toggle is on or off (Support/
Setup/Preferences/Project File).

Two style subobjects exist under the
line style assignment table, and there
only can be one.  You need to pick the
one you want to keep and use Project
File Maintenance to delete the other.

Info

WANT TO KNOW MORE?

Maintaining Project Files
See the tutorial booklet entitled: Understanding and



•  Increase or decrease the LegendView width by dragging the separator
•  Get double arrow-cursor when it is possible to drag
•  Ability to move the separator in either direction
•  Show as much of the legend as desired

Adjust LegendView Width

How to Adjust LegendView Width

DID YOU KNOW . . . you can adjust LegendView width if LegendView is
shown in the View window?

What Adjusting LegendView Width Gives You

•  Select LegendView/Show/Right or Left from the View menu.
•  Position the cursor above the separator to get the double-headed arrow cursor.
•  Click and hold the left mouse button.
•  Drag the separator in the desired direction.
•  Release the mouse when the separator reaches the desired position.

WANT TO KNOW MORE?

Online Reference Manual

See the section entitled LegendView
in the Display volume of the:

The LegendView/Show options let you
reposition or turn off the LegendView.

The cursor
becomes a
double-headed
arrow when  the
mouse is over
the separator.

You can increase or decrease  the
LegendView width by dragging the
separator to the desired position.

When the separator reaches the
desired position, the Scale readout
is updated for the View pane.



•  Choose Tools/Manage Project Files from the menubar.
•  Click on the Info icon to open Object Information window.
•  Scroll this window to a style object highlighted in blue.
•  Use the Project File Maintenance window to navigate to this blue name.
•  Click on the Edit icon to open the Edit Object Information window.
•  Click on the Change Link button to open the standard Object Select window.
•  Locate and select missing or moved style object to be linked.
•  Click OK in the Edit Object Information window.

Adjusting Links for Styles
DID YOU KNOW . . . you can use Project File Maintenance to adjust the
links for styles? (Links are the connections between the components
needed to fully define each geodata object in a Project File.)

What Adjusting Links Gives You

How to Adjust Links with Project File Maintenance

•  Identify objects with links to style objects that cannot be located
•  Navigate to missing style objects
•  Remake links that are missing or moved
•  Change existing links

Info icon opens the Object
Information window where
objects linked to style objects
that  cannot be located are
highlighted in blue.

Edit icon opens the Edit Object
Information window  where Change
Link button is used to change the link.

WANT TO KNOW MORE?

Maintaining Project Files
See the tutorial booklet entitled: Understanding and



Correct Coordinate Reference Systems

How to Correct Coordinate Reference Systems

•  Change CRS without changing control point coordinates
•  Change incorrect parameters chosen in the Georeference process
•  Correct parameters incorrectly selected in the Import process
•  Change CRS after auto-linking

•  Choose Tools/Change Coordinate Reference System.
•  Select the object(s) for which CRS parameters are incorrect.
•  Choose the correct CRS parameters.

DID YOU KNOW . . . you can correct Coordinate Reference System
(CRS) parameters that were entered incorrectly?

What Correcting the Coordinate Reference System Gives You

When you first display a file
in an external format (for
example DXF or DWG), you
may not know the correct
CRS.  You can choose
Leave as Engineering/Local
so you can display the
geodata, then use the
Change Coordinate
Reference System process
to correct it when known.

After selecting one or more objects
to change to the same CRS, the
Coordinate Reference System
window (right) opens so you
can specify the correct CRS.

WANT TO KNOW MORE?

Coordinate Reference Systems
See the tutorial booklet entitled:



•  Make graphic tool more visible over a variety of backgrounds
•  Ability to adjust graphic tool color from a large variety of color alternatives
•  Ability to specify the line width as desired

Changing Graphic Tool Color and Width

How to Change Graphic Tool Color and Width

DID YOU KNOW . . . you can change graphic tool color and width?

What Changing Graphic Tool Color and Width Gives You

•  Select Tools/System/Preferences from the menubar.
•  Click on the Interface tab in the General System Preferences window.
•  Click on the Graphic Tool Color button to open the Color Editor window.
•  Adjust the color of the Graphic Tool and click OK.
•  To change the graphic Tool Line Width, enter the new width.
•  To change the graphic tool color,
   select Options/Graphic Tools in the GeoToolbox window; or
   select Setup/Preferences/Color in the Spatial Data Editor window.

WANT TO KNOW MORE?

Online Reference Manual

See the section entitled Setting Interface Preferences in the
Support volume of the:

The Graphic Tool
Color button opens
the standard Color
Editor window so
you can choose
other colors.

The numeric field
lets you specify the
graphic tool line
width in pixels.

Different graphic tools are
available in various TNTmips
processes. The illustration
at the right shows one of
the graphic tools in the
Extract process.

Main Menu

GeoToolbox

Spatial Data Editor
When you change the colors in any
of these windows, they are
changed for the graphic tools in all
subsequently opened processes.

The Secondary Color is used for the parts of the
tool that are not part of the graphic element and
only present when using the Ruler, Arc, Arc
Wedge, and Arc Chord tools.

Secondary Color
for Arc Chord



• Choose Tools / System / Preferences to enable TNT Explorer.
• Browse inside a Project File (*.rvc file).
• Double-click on a TNT object that represents a map layout.
• View map layout and associated attributes in a 2D Display window.

Click to View a Map from a TNT Layout

How to Click to View a Map from a TNT Layout

• Auto-open a TNT product to display a map layout
• Automatic display of groups and layers that are contained in a map layout
• Ability to add additional groups or layers to the opened map layout

DID YOU KNOW . . . you can automatically display a map layout by
clicking on a TNT layout object?

What Clicking to View a Map from a TNT Layout Gives You

WANT TO KNOW MORE?

See the tutorial booklet entitled:  Understanding and

Maintaining Project Files

Enable TNT Explorer to
open objects inside a
Project File.

Double-click on
a map layout to
open it in a 2D
View.

If you double-click
on additional map
layouts they will be
displayed in
different Views.



• Install FREE TNTatlas on a Windows platform.
• Double-click on a single TNT object contained in a Project File.
• View the TNT object (single object, group, or layout) and associated attributes.

Click to View an Object in FREE TNTatlas

How to Click to View an Object in FREE TNTatlas

• FREE TNTatlas opens automatically if there is not another TNT product installed
• Open an object of any size with all built-in features in TNTatlas
• Get full TNTatlas geospatial analysis capabilities
• Auto-open a single object, group, or layout in a TNT Project File

DID YOU KNOW . . . you can open TNTatlas by clicking on a TNT
object in a Project File?

What Clicking to View an Object in FREE TNTatlas Gives You

WANT TO KNOW MORE?

See the tutorial booklet entitled:  Understanding and

DRAFT 10 FEBRUARY 2006

There are no size
restrictions for files or
objects in TNTatlas.

All geometric and
raster objects
contained in the
layout are displayed
by double-clicking on
the object.  A group
works in the same
manner.

Auto-open of
TNTatlas is available
for  Windows XP with
Sevice Pack I and
newer OSs.

Maintaining Project Files

Automatic display of a map layout in TNTatlas.

Predefined DataTips
and GraphTips are
available.

Region Analysis, SML and Tool
Scripts, GPS input, Links to a
URL, measuring, and sketching,
are available.
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•  Designate a clipping area using an elastic box
•  Automatically enter region’s extents and CRS to define the clipping area
•  Save clipping area as region for further use

Clipping Groups Using Regions

How to Clip Groups Using Regions

DID YOU KNOW . . . you can clip groups using regions?

What Clipping Groups Using Regions Gives You

•  In any View window, click on the GeoToolbox icon.
•  In the GeoToolbox window, click on the Rectangle tool.
•  Use the mouse to draw a box that will designate the clipping area.
•  Right-click over the View, choose Add as Region, and save the region.
•  Add saved region to the active group.
•  Click on the Group Settings icon and select the Clipping tab.
•  Click on the Match Layer button and toggle on the Clip button.

Group
Settings icon

The Match Layer button allows you  to
enter the extents of the active layer
automatically to define the clipping area.

Group 1 is
clipped
according to
the extents
of the region
saved.

 GeoToolbox icon

Add the region
saved  to
Group 1.

Save icon

Clicking on the object
name makes it the active
layer and the name of the
object becomes bold.

WANT TO KNOW MORE?

Making Map Layouts
See the tutorial booklet entitled:



•  Generate output raster object(s) with smaller storage requirements
•  Use compression methods appropriate for different raster types
•  Determine image quality selecting from lossy or lossless compression methods

Compress Raster Objects

How to Compress Raster Objects

DID YOU KNOW . . . you can reduce the size of the raster objects using
the Compression feature in the Raster Extract process?

What Compressing Raster Objects Gives You

•  Select Raster/Extract from the menubar.
•  Select the raster object(s) you want to compress when prompted.
•  Click on the Special tab in the Raster Extract window.
•  Click the Compression option button to select a compression method.
•  Click on the Run button.

WANT TO KNOW MORE?

Online Reference Manual

See the section entitled Using Special Features  in the
Process volume of the:

Lossless RLE
compression for 1-bit
(binary) rasters

Lossy JPEG compression
for 8-bit and 24-bit RGB/
BGR rasters

Lossless Huffman
compression for
signed, unsigned and
RGB/BGR rasters

Lossless DPCM
compression for
signed, unsigned and
RGB/BGR (preferred
method for signed/
unsigned)

Lossless or lossy
JPEG2000 compression
for unsigned or signed
up to 16 bit and only
RGB/BGR rasters 
(preferred method for
RGB/BGR)

Uncompressed

The 24-bit RGB raster at the
left was compressed using
JPEG2000 lossless
compression. The new
raster object was generated
having the same image
quality but requires only
24% of the storage space.



•  Incorporate database information in layouts
•  Use database tables as legends
•  Choose to save all records or selected records as CAD object
•  Choose to include or exclude hidden fields
•  Maintain the appearance of the database table in CAD object

Convert Database Tables to CAD

How to Convert Database Tables to CAD Objects

DID YOU KNOW . . . you can convert database tables to CAD objects?

What Converting Database Tables to CAD Objects Gives You

WANT TO KNOW MORE?

Managing Geoattributes
See the tutorial booklet entitled:

Hidden fields are included
in the CAD snaphot below.

CAD Snapshot

The Records option
button allows you to
save all records or
selected records.

This toggle button
lets you include
hidden fields in the
CAD snapshot.

CAD Snapshot

Selected
records are
saved as
CAD
snapshot.

The assigned colors and fonts
can be changed using the
settings in the Style Editor
window when saving the CAD
snapshot.

•  Left-click over database table checkbox to open the database table.
•  Select Table/Save As from the menu.
•  Set Format to CAD Snapshot and click OK.
•  Select new CAD object to save database table when prompted.
•  Accept or change default settings in the Style Editor window when prompted.



•  Create a point element from a node
•  Keep the nodes as points even if the associated line elements are deleted
•  Keep the nodes as points when excess nodes are removed

Convert Nodes to Points

How to Convert Nodes to Points

DID YOU KNOW . . . you can create point elements from nodes using
the Convert Node to Point tool? (A node is a vector element that occurs
at the ends of all lines and at all line intersections if the vector object
has polygonal topology.)

What Converting Nodes to Points Gives You

•  Open vector object for editing in the Editor.
•  Select the nodes to be converted to point elements.
•  Click on the Edit Elements icon in the Vector Tools window.
•  Click on the Convert Node to Point icon on the Operation panel.
•  Click on the All button to convert all nodes to point elements;
   or click on the Selected button to convert just selected nodes.

WANT TO KNOW MORE?

Convert Nodes to Point Elements
See the color plate entitled:

The nodes are selected to
apply the Convert Nodes to
Points operation.

Nodes that have been converted to
points survive when adjoining lines
are deleted.

Convert Node to
Point IconThe Edit Elements

icon opens the Edit
Elements window.



• Choose Geometric / Compute / Point Density Raster.
• Click on Input Vector button to select a vector.
• Optionally select Table for the Value and choose a table and field.
• Enter a value for Radius in any distance unit or use the Radius tool to determine it.
• Change cell size if necessary.
• Set appropriate output raster data type.
• Click on Run.

Create Point Density Rasters

How to Create Point Density Rasters

• Create raster objects to show distribution of vector points
• Use attribute information to compute cell values
• Create appropriate output raster data type for your data
• Use all or limit to query-selected points

DID YOU KNOW . . . you can create density raster objects from
vector points?

What Creating Point Density Rasters Gives You

WANT TO KNOW MORE?

Keep the radius
larger than the
cell size.

See the tutorial booklet entitled:

DRAFT 16 DECEMBER 2005

Vector Analysis Operations

Click on Radius tool
icon to draw a circle
with the desired
radius for your vector
point distribution.

Select the
appropriate output
raster data type.

You can use
attribute information
from a table and
field to create a
point density raster.

The output raster
is clipped to the
extents of the
vector points.

Number of
points within
specified
radius.

Input Vector Points

 Point Density Raster



•  Establish specific element-record relationships
•  Identify table behavior when objects are merged, extracted, or manipulated
•  Specify the number of records you can have attached to elements

Database Attachment Types
DID YOU KNOW . . . that you can specify restrictions for attachment of
records to elements using the database attachment types?

What the Database Attachment Types Give You

•  Select attachment type from the option menu when prompted by the database
creation wizard; or

•  Select Properties from the Table menu when viewing a database table.
•  Click on the Table tab in the Table Properties window.
•  Select the appropriate attachment type from the option menu.

WANT TO KNOW MORE?

Managing Geoattributes
See the tutorial booklet:

An element can have no more than one
record attached, but a single record can
be attached to more than one element.

A record can be attached to at most one
element, but individual elements might
have more than one record attached.

Any record can be attached to at most
one element and any element can have
no more than one record attached.

The records are associated with
elements by virtue of key field values
shared with a key in another table.

One Record Per Element

One Element Per Record

One to One Related Only

Implied One-to-One

More than one record can be attached to
an individual element and a single record
may be attached to multiple elements.

No Restriction

Every element has one and only one
record attached. The record number is the
same as the internal element number.

How to Specify Database Attachment Type



Database Table Colors
DID YOU KNOW . . . you can assign colors to tabular database views
for easier interpretation?

•  Ability to change color of the table rows
•  Assign alternating colors to table rows
•  Show statistics and substatistics rows with a different color
•  Interleave two colors for easier record identification

What Database Table Colors Give You

•  Click on database table checkbox to open the database table.
•  Select Table/Colors from the menu; or
   select Table/Preferences and click on the Color button.
•  Open the Color Interleave option menu and select the desired interleave option.
•  Click on color buttons to open the Color Editor and assign the desired colors.
•  Make sure the Transparent toggle is off when colors are assigned.

WANT TO KNOW MORE?

Managing Geoattributes
See the tutorial booklet entitled:

How to Assign Database Table Colors

The default Color option
uses the background
window color for all rows.

The window background color
shows through the selected row
color when the Transparent
button is toggled on.

The Frequency field is active when the
Color option is set to Interleave by row. The
number you enter in this field is the number
of rows that will be drawn in Color 1
before changing to Color 2.

Clicking on any Color
button opens the Color
Editor window, which
lets you change the
selected color.

This toggle button
allows you to show
statistics and
substatistics rows
with different colors.

The Color option lets you
assign different colors to
different rows or groups
of rows.



•  View six types of statistics and/or substatistics in a database table:
   count, sum, mean, standard deviation, minimum, and maximum
•  View statistics calculated for all records
•  View substatistics calculated for records with the same attribute value
•  Choose not to show statistics for particular fields
•  Save only statistics in a new database table

Database Table Statistics
DID YOU KNOW . . . you can view statistics for the records in a
database table when in tabular view?

What Database Table Statistics Give You

How to View Database Table Statistics

WANT TO KNOW MORE?

Managing Relational Databases
See the tutorial booklet entitled:

•  Click on database table checkbox to open the database table.
•  Select Statistics or Substatistics from the Table menu.
•  Toggle on the desired statistic type button to calculate and view.

Toggle on these
buttons to view
corresponding
statistics.

Count

Sum

Mean Six types of statistics are
calculated for all records
in the illustration below.

Minimum

Maximum

Standard  Deviation

Substatistics
are shown
for all
records
with the
same
attribute
value in the
field used
for sorting.

Turning this toggle on
turns off statistics for
the field.

To open the
Field Options
window, right-
click on the
field name and
select Field
Options from
the menu.



• Double-click on the file if TNTmips is assigned as the default application.
• Right-click and use Open With option to select TNT product.
• Browse to and select file in any TNT product Select Objects dialog.

Direct Use of CAD Files (*.dxf, *.dgn, *.dwg, *.tab)

How to Directly Use CAD Files

• Automatic display without importing files
• View without altering original files
• Show DataTips from available attributes
• Select files for any TNT product or process
• Georeference is supported when linking

DID YOU KNOW . . . you can directly view and use CAD files in DXF,
DGN, DWG, and TAB formats in the TNT products?

What Directly Using CAD Files Gives You

WANT TO KNOW MORE?

Sharing Geodata with Other Popular Products
See the tutorial booklet entitled:

DXF
DGN
DWG
TAB

AutoCAD eXchange format
Intergraph MicroStation format, internal georeference
AutoCAD internal format

*.dxf
*.dgn
*.dwg
*.tab

   Format         Extension        Description

Direct display of a DXF file

Text of an
individual layer
is automatically
displayed.

Styles by Attribute or
Script are available.

Show DataTips
according to
Table.Field.

MapInfo internal format



•  Remove lines between adjacent polygons that have shared attributes
•  Identify criterion attribute(s) from a single table or combination of tables
•  Select attributes from a single field or multiple fields
•  Generate a new vector object containing fewer polygons than the input object

Dissolve Polygons

How to Dissolve Polygons

DID YOU KNOW . . . you can use the Dissolve Polygons filter to
reduce the number of polygons in a vector object based on the shared
attributes of the adjacent polygons?

What Dissolving Polygons Gives You

•  Select Geometric/Filter from the menubar.
•  In the Vector Filters window, select the vector object to be filtered.
•  Click on the Add Filter icon and select Dissolve Polygons from the menu.
•  Select the name of the Table listed and then the Field.
•  Click on the Add button to add the Table.Field highlighted to the Attributes list.
•  Click on the Run button to carry out the process and create a new object.

WANT TO KNOW MORE?

Vector Analysis Operations
See the tutorial booklet:

The lines between the county polygons in
the same state are removed to create
larger polygons that represent states in a
new vector object.

The Add Filter icon
opens the Filter
Type menu.

The database table (counties) and
the field (STATE_NAME) are
selected and added to the
Attributes list to combine polygons
with the same state name.

The Test button allows
you to preview the new
polygons to be created.



• Choose Geometric / Filter.
• Click on the Select button and select your vector object(s).
• Click on Add Filter icon and select the Line Simplification filter.
• Click on Show Details icon and choose one of the three filtering methods available.
• Enter Thin Distance value for Douglas-Peucker or Minimum Distance methods.
• Enter Thinness Ratio value for Minimum Ratio method.
• Click on Test button to preview the effect of the filter.
• Click on Run to create output vector object.

Filter Vector to Simplify

How to Filter Vectors to Simplify

• Make vector lines straighter and less complex
• Smaller storage requirements for vector objects
• Vector objects are faster to manipulate in other processes
• Decrease line details for display over imagery of low resolution

DID YOU KNOW . . . you can reduce the number of vertices in
vector lines?

What Filtering Vectors to Simplify Gives You

WANT TO KNOW MORE?
See the section entitled Vector Filters in the Process volume of the

Online Reference Manual

Select one of the three
Line Simplification
methods available.

The Thinness
Ratio is active
for the Minimum
Ratio Thinning
Method.

Click on Add
Filter icon to
select the Line
Simplification
filter.

Increase the Thin
Distance value to
increase the number
of vertices removed.

Click on Test button
to preview results.

Output with Thin Distance of 10 m Output with Thin Distance of 100 m

The Line
Simplification
vector filter
removed 1008 of
1305 vertices
(77.2 %).

The Line
Simplification
vector filter
removed 824 of
1305 vertices
(63.1 %).

Blue line is the original and
the red line is the result after
applying the filter.



•  Clip a group so that only a selected portion of it is shown in the View window
•  Use full extents of the geographically attached group to define the clipping area
•  Quick clipping without needing to define the clipping area manually

Geographically-Attached Group Clipping

How to Clip Geographically Attached Groups

DID YOU KNOW . . . you can clip groups using the extents of another
group when two or more groups are geographically attached?

What Geographically-Attached Group Clipping Gives You

•  Click on the Group Settings icon to open the Group Settings window.
•  Set Horizontal Attachment To one of the groups listed on the Layout panel.
•  Select Geographic from the menu to attach the active group geographically.
•  Turn on the Clip toggle on the Clipping panel.
•  Turn on the Use geographically-attached group clipping toggle.

Group Settings icon

Group 2 and Group 3 are geographically
attached  to Group 1.

Group 1, Group 2, and
Group 3 are displayed
together without clipping.

Group 2  is clipped using the
extents of Group 1, while
Group 3 is not clipped.

Toggling on this button allows
you to use the Group 1’s extents
for clipping Group 2.

Both Group 2 and Group
3 are clipped using the
extents of Group 1.

WANT TO KNOW MORE?

Making Map Layouts
See the tutorial booklet:



• Select View Options from the Options menu in the Display Manager window.
• Select the View tab in the Options window that opens.
• Turn on the “Track mouse cursor between views” toggle button.
• Open two or more View windows with data that shares geographic extents.

Geotrack Cursor in Multiple Views

How to Geotrack Cursor In Multiple Views

• Compare features simultaneously from different views
• Detect a specific location’s land use / cover changes over time
• Identify if raster and/or geometric objects have been correctly georeferenced

DID YOU KNOW . . . you can track the mouse cursor between views
as you move it in TNTmips?

What Geotracking the Cursor in Multiple Views Gives You

Select View
Options to open
the Options
window.

Landsat image year 1990 Landsat image year 2000

Turn toggle
on to get
functionality.

Move mouse
cursor freely
across the
view.

A yellow
crosshair
appears at the
same location as
the mouse
cursor in the
other view.

WANT TO KNOW MORE?

Displaying Geospatial Data
See the tutorial booklet:



•  Choose how your extraction area displays in the View window
•  Differentiate the selected and non-selected areas for extraction
•  Set tint color for selected action area

Highlight Raster Extraction Area

How to Highlight Raster Extraction Area

DID YOU KNOW . . . you can highlight the selected and non-selected
areas for extraction by using different display options?

What Highlighting Raster Extraction Area Gives You

•  Select Raster/Extract from the menubar.
•  Select the raster object you want to extract from when prompted.
•  Click on the Extract tabbed panel in the Raster Extract window.
•  Choose Manual or By Mask from the Select menu.
•  Select Normal or Tint from the Included menu.
•  Select Normal, Tint, or Blank from the Excluded menu.

WANT TO KNOW MORE?

Online Reference Manual

See the section entitled Extraction Area Selection in the
Process volume of the:

The Highlight panel becomes active
when the raster extraction area is to
be defined manually or by mask.

The Color button that opens the
Color Editor window  lets you set
the tint color. The tint color was set
to red, and green in the first and
second illustrations respectively.

Three options are listed to
highlight the areas excluded
from extraction.

Two options are listed to
highlight the areas included in
the extraction area.



•  Use the cell values of an extracted raster to replace those of an existing raster
•  Determine the starting range of cells to be replaced in an existing raster object
•  Choose to replace all cells or only the null cells within the extracted area

Insert Raster Objects

How to Insert Raster Objects

DID YOU KNOW . . . you can insert all or part of the input raster object
into another existing raster object?

What Inserting Raster Objects Gives You

•  Select Raster/Extract from the menubar.
•  Select the raster object you want to extract from when prompted.
•  Click on the Insert tab in the Raster Extract window.
•  Toggle on the Insert into existing raster button.
•  Set the values for Starting Line and Starting Column.
•  Click on the Run button.

WANT TO KNOW MORE?

Online Reference Manual

See the section entitled Inserting into an Existing Raster
Object  in the Process volume of the:

When the extraction area
is defined, the range of
the extraction area is
calculated automatically.

Extracted part of the input
raster at the left was
inserted into an existing
raster at the right.

Toggling on this button allows you to replace
only the null cells in the existing raster with
the cell values of the extracted raster.

Setting Starting Line
and Starting Column
lets you determine the
starting range of the
cells to be replaced.

Toggling on this button
allows you to insert the
extracted raster into an
existing raster.

Note that both raster
objects must have the
same cell size so that
the columns and lines
designated in the Insert
panel can exactly match
the extraction area.



•  Mark elements by any means.
•  Select Compute Region from the Right Mouse Button menu.
•  Select the Region type from the Compute Region menu.
•  Apply the settings and click on OK in the Region Generation window.
•  Draw regions directly using the GeoToolbox and right click in the view window.
•  Use Region panel in the GeoToolbox to add, delete, save, and combine regions.

Interactive Region Analysis
DID YOU KNOW . . . you can create and use regions as an interactive GIS
tool? (A region object is a collection of simple, nonoverlapping polygons)

What Interactive Region Analysis Gives You
•  Ability to generate regions from different object types
•  Define area to be selected
•  Various region analysis methods such as buffer zone, basin, viewshed etc.
•  Advanced methods for region combinations

WANT TO KNOW MORE?

Interactive Region Analysis
See the tutorial booklet entitled:

Click on the Region icon to
activate the Region tabbed panel.

Simple rectangular
region is defined to
select polygons.

Polygons are partially inside
the rectangle are selected and
define region.

The selected polygons are
extracted using the region
generated.

How to Create and Use Regions

The Compute Region choice is
available on the Right Mouse
Button menu when elements are
marked.

The Compute Region menu
options vary with the layer
and element type.



•  Compute new cell values that correspond to various intervals
•  Generate a new raster object composed of interval categories
•  Specify intervals using GeoFormula tool

Interval Categories for Raster Objects

How to Generate Interval Categories?

DID YOU KNOW . . . you can generate interval categories using the
values of a raster object?

What the Interval Categories Give You

WANT TO KNOW MORE?

Using Geospatial Formulas
See the tutorial booklet:

•  Select Script/GeoFormula from the menubar.
•  Use a script to assign raster values to interval categories.
•  Open the new raster object in the Display process.
•  Use Color Palette Editor to assign new colors to the intervals generated.

The Geospatial Formula lets you
assign interval values.

The 16-bit elevation raster is com-
posed of values between 1045 and
1376.

The 8-bit elevation interval raster is
composed of four interval categories.

The Color Palette Editor
lets you assign colors to
each interval category.

The Edit button allows
you  to open the Color
Palette Editor.



WANT TO KNOW MORE?
See the tutorial booklet entitled: Understanding and

Maintaining Project Files

•  Ability to link large number of elements to unique files
•  Automatically enter file paths for each element
•  Ability to launch the external files you link to

Link to External Files Using Attributes

How to Link to External Files Using Attributes

DID YOU KNOW . . . you can link to external files associated with a large
number of elements using element attributes?

What Linking to External Files Using Attributes Gives You

•  Create a computed field to specify the path for external files.
•  Click on the vector element icon in the HyperIndex Linker window.
•  Click on one of the vector elements.
•  Click on the Add button in the HyperIndex Link Selection window.
•  Set the Type to File by Attribute and click on the Object button.
•  Select the database table and computed field in the table list.
•  Click on OK and close the HyperIndex Linker window.

 A string expression field is
created to automatically
generate the file path entries.

A record that identifies the
corresponding photo is
attached to each point.

HyperIndex
Navigator icon

HyperIndex
Linker icon

Setting Type to File by
Attribute for the
selected point element
automatically links all
point elements to the
external files listed in
the selected field.

Clicking on a point element
opens the JPEG file that
shows  the photo  taken at that
point.

The Vector Element
icons (Vector Point,
Line, and Polygon)



See the section entitled Polygon Properties
 in the Process volume of the:

WANT TO KNOW MORE?

Online Reference Manual

•  Calculate selected attribute statistics for vector polygons or points that fall
within the polygons of another vector

•  Generate record with area and percent area for each source polygon that falls
within destination polygon

•  Generate statistics for all source points that fall within destination polygon

Polygon Properties

How to Compute Polygon Properties

DID YOU KNOW . . . you can compute Polygon Properties using a
pair of vector objects?

What Polygon Properties Give You

•  Select Geometric/Attributes/Polygon Properties from the menubar.
•  Choose Polygon or Point Statistics from the Operation menu.
•  Identify Destination Polygons and Source Polygons (or Points).
•  Highlight the names of the table and field you want to use.
•  Double-click the field name to select table and field.
•  Click the Run icon button.
•  View the database tables generated.

You can add tabular
database statistics and
substatistics if multiple
source polygons fall
within a single
destination polygon.

Calculating Point Statistics
requires selection of a
numeric field. Polygon
Statistics expect a string
field but also accept
numeric input.

Note that the Polygon Statistics operation may attach
multiple records to each destination polygon while the
Point Statistics operation generates only one record
per destination polygon.

Run icon

Tables with no restriction
on attachment type do
not appear in the Table
selection list.

The Operation option menu
lets you calculate point or
polygon statistics.

Polygon StatisticsPoint Statistics



Link to ESRI Personal Geodatabase

How to Link to an ESRI Personal Database

• Maintain spatial elements and attributes in their native format
• Link to any or all of the spatial tables in the Geodatabase in one operation
• Get a separate linked shape object for each Personal Geodatabase layer
• Attribute information for each Personal Geodatabase layer automatically

available for viewing and use with DataTips and queries
• Base element styling on linked Personal Geodatabase attributes
• Optional full import to independent TNTmips vector or CAD object

• In the Import process, select the file containing the Personal Geodatabase.
• Choose the GEODATABASE format and press the Next... button.
• Choose Shape from the Object Type menu in the Import Parameters window,

then press the Import... button.
• Select or create a Project File and name a shape object for each Geodatabase

layer you want to link to.

DID YOU KNOW . . . you can link to map data layers in ESRI
Personal Geodatabase files?

Importing Geodata

WANT TO KNOW MORE?

See the tutorial booklet:

What Linking to an ESRI Personal Database Gives You

View with multiple linked ESRI
Geodatabase layers styled
using their native attributes.



Link to Access Database

How to Link to an Access Database

• Maintain spatial attributes in an external Access relational database file
• Link to any or all tables in the Access database
• OLE DB connection maintains all keyfield relationships between Access tables
• Base element styling and DataTips on linked Access attributes
• Access tables can be edited while in use in the TNT products
• Manually refresh TNT table view to see updated attribute values or set for

automatic timed refresh

• Make sure that the root Access table has a primary key field with unique values
corresponding to those in a native TNT table.

• In the Import process, select your Access file and choose the Access format.
• Turn on the Link Only toggle in the Import Parameters window.
• Select the element database in the TNT spatial object to contain the linked

representations of the Access tables.
• After the link is made, use the Database Editor to relate the linked Access root

table to a TNT table that is attached to the spatial elements.

DID YOU KNOW . . . you can link your TNT spatial objects to
attributes in an Access database?

Importing Geodata

WANT TO KNOW MORE?

See the tutorial booklet:

What Linking to an Access Database Gives You

After linking the Access database tables, use the Database Editor to manually
assign a keyfield relationship between the root Access table and a native TNT table.

native
TNT
table

linked
Access
tables

spatial
elements



Link to MySQL Database

How to Link to a MySQL Database

• Maintain spatial attributes in a central, server-based relational database
• Attribute data transparently shared with other users and software
• Linked spatial data fully portable within the server network
• Database log in required only when first establishing the database link
• All keyfield relationships between MySQL tables maintained by the link
• Base element styling and DataTips on linked MySQL attributes
• Updated attribute values automatically available in TNT upon open or refresh

of table view

• Make sure that the root MySQL table has a primary key field with unique values
corresponding to those in a native TNT table.

• Choose the MYSQL format in the Import process.
• Press the Select Data Source... button and log in to the desired database and

schema.
• Turn on the Link Only toggle in the Import Parameters window.
• Select the element database in the TNT spatial object to contain the linked

representations of the MySQL tables.
• After the link is made, use the Database Editor to relate the linked MySQL root

table to a TNT table that is attached to the spatial elements.

DID YOU KNOW . . . you can link your TNT spatial objects to
attributes in a MySQL database?

Importing Geodata

WANT TO KNOW MORE?

See the tutorial booklet:

What Linking to a MySQL Database Gives You

native TNT table

linked MySQL tables

After linking the MySQL database tables,
use the Database Editor to manually
assign a keyfield relationship between the
root MySQL table and a native TNT table.

spatial
elements



Link to MySQL Spatial Tables

How to Link to MySQL Spatial Tables

• Maintain spatial data and attributes in a server-based relational database
• Point, line, and polygon geometries (one type per spatial table)
• Get a separate linked shape object for each spatial table
• Data transparently shared with other users and software
• Linked spatial data fully portable within the server network
• Database log in required only when first establishing the link
• Base element styling and DataTips on attributes in the linked spatial table

• Choose the MySQL-Spatial format in the Import process.
• Press Select Data Source and log in to the desired database and schema.
• Press the Next button.
• Choose the Shape object type in the Import Parameters window.
• Press the Import button.
• Select the Project File and object names for the linked MySQL spatial tables.

DID YOU KNOW . . . you can link to spatial objects in MySQL
spatial tables?

Importing Geodata

WANT TO KNOW MORE?

See the tutorial booklet:

What Linking to MySQL Spatial Tables Gives You



Link to PostGIS Spatial Tables

How to Link to PostGIS Spatial Tables

• Maintain spatial data and attributes in a server-based relational database
• Point, line, and polygon geometries (one type per spatial table)
• Get a separate linked object for each spatial table
• Data transparently shared with other users and software
• Linked spatial data fully portable within the server network
• Database log in required only when first establishing the link
• Base element styling and DataTips on attributes in the linked spatial table

• Choose the POSTGIS format in the Import process.
• Press Select Data Source and log in to the desired database and schema.
• Press the Next button.
• Choose the Shape object type in the Import Parameters window.
• Press the Import button.
• Select the Project File and object names for the linked PostGIS spatial tables.

DID YOU KNOW . . . you can link to spatial objects in PostGIS
(PostgreSQL database) spatial tables?

Importing Geodata

WANT TO KNOW MORE?

See the tutorial booklet:

What Linking to PostGIS Spatial Tables Gives You



Link to PostgreSQL Database

How to Link to a PostgreSQL Database

• Maintain spatial attributes in a central, server-based relational database
• Attribute data transparently shared with other users and software
• Linked spatial data fully portable within the server network
• Database log in required only when first establishing the database link
• All keyfield relationships between PostgreSQL tables maintained by the link
• Base element styling and DataTips on linked PostgreSQL attributes
• Updated attribute values automatically available in TNT upon open or refresh

of table view

• Make sure that the root PostgreSQL table has a primary key field with unique
values corresponding to those in a native TNT table.

• Choose the POSTGRESQL format in the Import process.
• Press the Select Data Source... button and log in to the desired database and

schema.
• Turn on the Link Only toggle in the Import Parameters window.
• Select the element database in the TNT spatial object to contain the linked

representations of the PostgreSQL tables.
• After the link is made, use the Database Editor to relate the linked PostgreSQL

root table to a TNT table that is attached to the spatial elements.

DID YOU KNOW . . . you can link your TNT spatial objects to
attributes in a PostgreSQL database?

Importing Geodata

WANT TO KNOW MORE?

See the tutorial booklet:

What Linking to a PostgreSQL Database Gives You

native TNT table

linked
PostgreSQL
tables

After linking the PostgreSQL database tables,
use the Database Editor to manually assign a
keyfield relationship between the root MySQL
table and a native TNT table.

spatial
elements



Link to SQL Server Database

How to Link to an SQL Server Database

• Maintain spatial attributes in a central, server-based relational database
• Attribute data transparently shared with other users and software
• Linked spatial data fully portable on Windows computers in the server network
• Database log in required only when first establishing the database link
• All keyfield relationships between SQL Server tables maintained by the link
• Base element styling and DataTips on linked SQL Server attributes
• Updated attribute values automatically available in TNT upon open or refresh

of table view

• Make sure that the root SQL Server table has a primary key field with unique
values corresponding to those in a native TNT table.

• Choose the SQL SERVER format in the Import process.
• Press the Select Data Source... button and log in to the desired database.
• Turn on the Link Only toggle in the Import Parameters window.
• Select the element database in the TNT spatial object to contain the linked

representations of the SQL Server tables.
• After the link is made, use the Database Editor to relate the linked SQL Server

root table to a TNT table that is attached to the spatial elements.

DID YOU KNOW . . . you can link your TNT spatial objects to
attributes in an SQL Server database?

Importing Geodata

WANT TO KNOW MORE?

See the tutorial booklet:

What Linking to an SQL Server Database Gives You

native TNT table

linked SQL
Server tables

After linking the SQL Server database tables,
use the Database Editor to manually assign a
keyfield relationship between the root MySQL
table and a native TNT table.

spatial
elements



Link to Excel Spreadsheets

How to Link to an Excel Spreadsheet

• Maintain attributes and build complex formula fields in an Excel spreadsheet
• Get a table representation for each sheet in the Excel file
• Relate Excel data and formula results to elements in your TNT spatial objects
• Show Excel formula results as DataTips
• Use Theme Maps to graphically display the results from Excel formulas
• Update and save Excel formulas while viewing the linked TNT objects

• Make sure the Excel file contains a field with unique values corresponding to
those in a native TNT table in your spatial  object’s database.

• In the Import process, select your Excel file and choose the EXCEL format.
• Turn on the Link Only toggle in the Import Parameters window.
• Select the element database in the TNT spatial object to contain the linked

representation of the Excel file.
• After the link is made, use the Database Editor to relate the linked table to a

TNT table that is attached to the spatial elements.
• To use TNT and Excel concurrently, open the Excel spreadsheet first.

DID YOU KNOW . . . you can link Excel Spreadsheet data and
formulas to your TNT spatial objects?

Importing Geodata

WANT TO KNOW MORE?

See the tutorial booklet:

What Linking to Excel Spreadsheets Gives You
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•  Enter line and column numbers to define an extraction area
•  See the line and column entries as an elastic box in the View window
•  Draw, resize, and move the elastic box to define an extraction area
•  Automatic adjustment of line and column entries based on the elastic box

Raster Extraction By Range
DID YOU KNOW . . . you can select a range of lines and columns to
extract from a raster object?

What Extracting Rasters by Range Gives  You

•  Select Raster/Extract from the menubar.
•  Select the raster object(s) you want to extract from when prompted.
•  Click on the Extract tab in the Raster Extract window.
•  Choose the Range option from the Select menu.
•  Enter Line and Column numbers in the From and To numeric fields.
•  Resize or move the elastic box in the View window if required.
•  Click on the Run button.

WANT TO KNOW MORE?

Online Reference Manual

See the section entitled Extracting by
Range in the Process volume of the:

The Line and
Column totals
automatically
adjust as the
Line and
Column
numbers are
entered in the
From and To
numeric fields.

How to Extract Rasters by Range

The Line and Column
numbers entered in the
From and To numeric fields
are shown as an elastic
box in the Raster Extract
Object View window.

When you draw, resize, or move the
elastic box, the Range numeric fields
automatically adjust.



•  Use variety of elastic tools to define extraction area
•  Add saved region(s) or draw polygon(s) to define extraction area
•  Enter specific values for each vertex, center point, and/or extents of the area
•  Ability to include or exclude from the extraction area
•  Select the inside or outside of the delineated area as the extraction area

Raster Extraction Using Drawn Areas
DID YOU KNOW . . . you can use drawn areas to define an area to
extract from a raster object?

What Raster Extraction Using Drawn Areas Gives You

•  Select Raster/Extract from the menubar.
•  Select the raster object(s) you want to extract from when prompted.
•  Choose the Manual option from the Select menu (Extract tabbed panel).
•  Click on the appropriate Extraction Area Definition tools to draw an elastic

rectangle, circle, ellipse, or polygon or to add a saved region.
•  Click on the Include in Extraction Area button.
•  Click on the Run button in the Raster Extraction window.

WANT TO KNOW MORE?

Online Reference Manual

See the section entitled Extracting A Manually Defined Area
in the Process volume of the:

How to Extract Rasters Using Drawn Areas

Setting Select button to Manual or
clicking on the Define Extraction
Area icon opens the Extraction
Area Definition Tools window.

Define Extraction
Area icon

Region Tool lets you
use a saved region to
define an extraction
area.

Extraction Area
Definition Tools

Include All

Exclude from
Extraction Area

Invert Selection
Exclude All

Include in
Extraction Area

Toggling on the Manual Entry
button allows you to enter
each vertex, center point, and/
or extents of the extraction
area.

The area
defined was
inverted and
then extracted.

In the above illustration, the
extraction area was defined
using the region, rectangle and
circle tools.

The area defined
was extracted.



•  Use masks to define raster extraction area
•  Ability to view the mask applied to the input object
•  Automatic adjustment of the Range entries based on the extents of masked area
•  Ability to extract more than one area at one time

Raster Extraction Using Masks
DID YOU KNOW . . . you can define a raster extraction area by using a
mask? (A mask is a processing barrier or boundary that only allows
selected data values to pass.)

What Extracting Rasters Using Masks Gives You

•  Select Raster/Extract from the menubar.
•  Select the raster object(s) you want to extract from when prompted.
•  Choose the By Mask option from the Select menu (Extract tabbed panel).
•  Select the mask to use for raster extraction when prompted.
•  Click on the Run button.

WANT TO KNOW MORE?

Online Reference Manual

See the section entitled Extracting by
Mask in the Process volume of the:

The Line and Column
entries  on the Range
panel automatically
adjust according to the
extents of the masked
area.

How to Extract Rasters Using Masks

This button allows
you to select a mask
to define a raster
extraction area.

The mask, which is displayed
over the input raster in the
above illustration, is a binary
raster composed of internal
values 1 and 0.

The mask is displayed over
the input raster defining the
extraction areas.

The areas designated by
the mask were extracted
and saved as a new
object.

The Highlight panel
provides options to
display the selected
and non-selected
areas for extraction.



•  Use any saved region to define a raster extraction area
•  Ability to view the region applied to the input object
•  Automatic adjustment of line and column entries based on the region’s extents
•  Automatic creation of null values outside the region if it is not rectangular

Raster Extraction Using Regions
DID YOU KNOW . . . you can define a raster extraction area by using a
previously saved region?

What Extracting Rasters Using Regions Gives You

•  Select Raster/Extract from the menubar.
•  Select the raster object(s) you want to extract from when prompted.
•  Choose the By Region option from the Select menu (Extract tabbed panel).
•  Select region to use for raster extraction when prompted.
•  Click on the Run button.

WANT TO KNOW MORE?

Online Reference Manual

See the section entitled Extracting by
Region in the Process volume of the:

The Line and Column entries
automatically adjust
according to the extents of
the region selected.

How to Extract Rasters Using Regions

The  region, which identifies
the areas of elevation
between 1100 and 1150
meters, is displayed over
the input raster when it is
selected to define the raster
extraction area.

This button allows you to
select a saved region to
define a raster extraction
area.

The null cells are not transparent.

The null cells are transparent.

A new raster
object was created
and null values
were placed
outside the region.



See the section entitled Raster Properties
 in the Process volume of the:

WANT TO KNOW MORE?

Online Reference Manual

•  Calculate statistics for each raster category
•  Compute histogram for each raster category
•  Generate database tables for the statistics and/or histograms computed

Raster Statistics for Category Rasters

How to Compute Raster Statistics for Category Rasters

DID YOU KNOW . . . that you can compute Raster Statistics for
category rasters?

What Raster Statistics for Category Rasters Give You

•  Select Raster/Interpret/Statistics by Category Raster from the menubar.
•  Click on the Rasters button to add one or more raster objects.
•  Click on the Category Raster button to add a raster object.
•  Click on the Run button.
•  Accept or change the default name and description for the raster

database table(s) when prompted.
•  View the raster database tables generated.

This toggle button
determines if a
histogram is
calculated for each
raster category.
Note that this button
is dimmed for raster
objects that are
greater than 8-bit.

The histogram table
provides raster cell
counts for each raster
value that falls within
each raster category.

Descriptive statistics
are generated for each
raster category.

The input  rasters and the
category raster must have the
same cell size to be selected
for this process.

In this illustration, the category
raster consists of six
watershed categories. The
DataTip shows the mean
slope calculated for the first
watershed category.



•  Easy reorganization of fields
•  Move fields in either direction
•  Drag-and-drop reordering of the fields

Rearrange Fields for Tabular Viewing

How to Rearange Fields for Tabular Viewing

DID YOU KNOW . . . you can rearrange fields (table columns) using the
drag-and-drop feature in tabular view?

What Rearranging Fields for Tabular Viewing Gives You

•  Expand database tables for the desired element type.
•  Click on a database table checkbox to open the database table.
•  Click and hold on the column heading.
•  Drag the heading outline to the left or right.
•  Release the mouse when the box is in the desired location.

Click, hold, and drag field name
(column heading) in desired
direction when in tabular view.

WANT TO KNOW MORE?

Managing Geoattributes
See the tutorial booklet entitled:

The column
heading was
dropped at the
right.

Column heading

The heading
outline was
dragged to the
right.

The database table
must be in tabular view
to rearrange table
columns.

Click on the checkbox to
open the database table
viewer.



•  Storage, modification, and transmission of complex layouts
•  Representation of discrete map elements for web-based cartography
•  Text based graphics file format compatible with common Web technologies

Render Complex Layouts to SVG

How to Render Complex Layouts to SVG?

DID YOU KNOW . . . you can render complex layouts to Scalable
Vector Graphics? [SVG is the World Wide Web Consortium (W3C)
language describing 2D graphics.]

What Rendering Complex Layouts to SVG Gives You

WANT TO KNOW MORE?

Render Complex Layouts to SVG
See the Technical Guide entitled:

These panels are active
when corresponding
Scripting choices are
turned on.

Layer Control panel
Adobe menu,
which is
available if
using the
Adobe SVG
Viewer.

Lower values than
the default for
Coordinate
Accuracy provide
more detail than
you are currently
viewing if available.

The Render to SVG Layer
Controls let you include a
Layer Control panel and/or
the Adobe Layer Visibility
menu in an SVG file.

SVG file provides
DataTips when you
pause the mouse
over a vector.

•  Choose Render to/SVG from the Display menu to open the Render to SVG window.
•  Use the Options panel to specify the settings for SVG output.
•  Click on the Render to SVG button.
•  Let your system install the most recent free SVG Viewer from
    http://www.adobe.com/svg/viewer/install/main.html.
•  Use SVG Viewer to open SVG file and right click to view Adobe menu.



When this button is toggled on, the Redraw
after any change icon is pressed for each new
view. It is preferable to toggle this button on to
autodraw when layers are small and fast or
when most layers are already in the view and
layer cache buffers. It is better to toggle it off
to redraw on demand when several large
objects are being added or modified.

•  Easily set preference for how you want the views to refresh
•  Change default redraw behavior for each view
•  Choose manual redraw when large objects are being added or modified

Set Redraw Default to Manual or Auto
DID YOU KNOW . . . you can set the default redraw mode to be auto-
matic after each layer change or only on demand?

What Setting the Redraw Default to Manual or Auto Gives You

•  Select Options/View Options from the Display Manager menu; or
    select Setup/Preferences from the Editor - Layer Manager menu.
•  Click on the View tab in the window that opens.
•  Toggle on the Default to redraw after any change button for auto redraw mode.
•  Unpress Redraw after any change icon in the View window to toggle back to

redraw only on demand when needed.
•  Depress Redraw after any change icon to toggle on auto redraw mode.

How to Set the Redraw Default to Manual or Auto

WANT TO KNOW MORE?

View Toolbar Features
See the color plate entitled :

This icon will toggle your
default refresh selection for
that view to the opposite
choice for as long as that
view is open and used.

This icon updates the view
canvas on demand. It is not
necessary when the Redraw
after any change icon is
toggled on.

Redraw iconRedraw after any change icon

Select View
Options from the
menu to open the
Options window.



How to Set Units for Database Fields
• Show database tables in Display or the Database Editor.
• Right-click on a table name and select Properties; or
• Choose Table / Properties if the table is open.
• Click on the Field tab and select a field for units assignment.
• Select the Unit Type and set the Units in File to match the values in the table.

Set Units for Database Fields

• Establishes units for field when table created
• Establishes units for tables from external sources
• Eliminates ambiguity for data values
• Provides ability to change units when viewing table

DID YOU KNOW . . . you can set the unit type and specific units for
fields in database tables?

What Setting Units for Database Fields Gives You

WANT TO KNOW MORE?
See the tutorial booklet entitled:

Managing Relational Databases

Choose among
65 Unit Types.

Unit Types include:
area, distance, angle,
time, temperature,
volume, mass, and
so on.

Right-click on table
and select Properties
option to open the
Table Properties
window.

You can also click to check this box and open
the table, then choose Table / Properties to
open the Table Properties window.

Select a
field to set
its units.

Click on the units
option button to select
different units and
values will be adjusted
accordingly.

Original table Table after setting units for fields.

Table comes
from a shapefile.

Note:  Unit option
menus appear only in
single record view.



•  Put records in a new order for viewing
•  Sort on more than one field
•  Sort string or numeric fields
•  Sort records in ascending or descending order

Sort Table Fields

How to Sort Table Fields

DID YOU KNOW . . . you can change the order of records by sorting on
one or more fields in a tabular view?

What Sorting Table Fields Gives You

•  Expand database tables for the desired element type.
•  Left-click on database table checkbox to open the database table.
•  Click on the column heading.
•  To sort on more than one field, press and hold the <shift> key and
   click on another heading.
•  Choose Sort from the Field menu.

WANT TO KNOW MORE?

Managing Geoattributes
See the tutorial booklet:

Left clicking on the checkbox opens
the database table.

In order to produce a
meaningful sort that
includes a second
field, the first field
selected must have
multiple records with
the same value.

First field
selected

Second field
selected

If you select the same field and
choose sort again, the records will
sort in inverse order.

Sorting on both fields puts the records in
alphabetical order by city and state.

The order in which fields are selected
affects the sorting results.



See the section entitled Threshold Regions
 in the Display volume of the:

WANT TO KNOW MORE?

Online Reference Manual

•  Set the beginning and ending range of cell values for threshold
•  Determine whether the region is generated inside or outside the threshold
•  Set minimum subregion and island size
•  Preview the temporary region generated

Create Regions by Thresholding

How to Create Regions by Thresholding

DID YOU KNOW . . . you can compute regions using a threshold
range of raster cell values?

What Creating Regions by Thresholding Gives You

•  Add a grayscale raster object and click on the + to show the raster details.
•  Right-click on the raster name or icon.
•  Choose Compute Region/Threshold from the option menu that opens.
•  The Threshold Region Generation window opens.
•  Move the sliders or enter specific values to set the threshold range.
•  Click on Apply to preview the temporary region.
•  Click on OK to generate the region and save it using GeoToolbox.

The threshold region shown above includes
all subregions without size restriction.

GeoToolbox icon

The Apply button
lets you preview
the region to be
generated.

The threshold region shown above does not include
subregions smaller than 3000 square meters.

The Advanced
Options panel
lets you set
minimum
subregion and
island size.



• Display your raster object.
• Choose View Histogram from the raster layer’s right mouse button menu.
• Click on the GeoToolbox icon.
• Choose one of the area drawing tools and draw an area of interest on your raster.
• Click on the Update Histogram icon in the GeoToolbox window.
• Choose View Histogram for other raster layers to open additional histograms.
• Choose File / Raster to select a raster object for histogram viewing.

Update Raster Histograms

How to Update Raster Histograms

• Select specific area of interest to calculate raster histograms
• Update raster histograms for one or more raster objects
• Simultaneously compare raster histograms from different spectral sources

DID YOU KNOW . . . you can automatically update raster histograms
using the GeoToolbox?

What Updating Raster Histograms Gives You

WANT TO KNOW MORE?

Display of raster object

See the tutorial booklet entitled:

Sketching and Measuring

Histogram before update

Histogram after update

Click on Update
Histograms
icon after you
have drawn
your area of
interest.

The File menu
allows you to
select addi-
tional rasters
for histogram
display.

Click on raster layer
with right mouse
button to select the
View Histogram
option.

View Histogram option



• Display layers in 2D or 3D Group windows.
• On the LegendView select and drag one of the layers up or down.

Note: You can also change layer order if you
• Right-click on a layer in the Spatial Data Display window and choose To Top,
Raise, Lower, or To Bottom.

Use LegendView to Change Layer Order

How to Use LegendView to Change Layer Order

• Use mouse to drag layers up or down to change order of your layers
• Interactively drag layers to any position in layer order
• Display geometric objects on top of raster objects for full visibility

DID YOU KNOW . . . you can change the order of layers by dragging
them in LegendView?

What Using LegendView to Change Layer Order Gives You

WANT TO KNOW MORE?

Display of layers hiding vectors and an
elevation raster object (DEM_16bit).

Full visibility of layers when
order has been changed.

Displaying Geospatial Data
See the tutorial booklet entitled:

The elevation raster
(DEM_16-bit) is set to
be 60% transparent so
the bottom raster layer
can also be seen.

LegendView

In the LegendView,
select a layer and drag
it up or down using your
mouse.

Keep geometric objects
on top of raster layers
for visibility.

Raster object was dragged
to the bottom of the layers,
which allows elevation
raster and vector objects
to be seen.



•  Create descriptive statistics for each polygon and line element
•  Generate database tables called POLYSTATS and LINESTATS
•  Use standard statistics values in vector processes

Vector Standard Attributes

How to Compute Vector Standard Attributes

DID YOU KNOW . . . you can automatically generate database tables
with standard descriptive statistics for lines and polygons?

What Vector Standard Attributes Give You

•  Select Geometric/Attributes/Standard from the menubar.
•  Click on the Objects button to select the vector object or objects.
•  Click on the Run button to calculate statistics; or
•  In the Spatial Data Editor, open the vector object for editing.
•  Select Layer/Properties from the Spatial Data Editor menu.
•  Toggle on the Maintain Standard Attributes button and click OK.
•  Right-click on the Vector Layer icon.
•  Select Update Standard Attributes from the right mouse button menu.

WANT TO KNOW MORE?

Online Reference Manual

See the section entitled Standard Attributes  in the Process
volume of the:

The Vector Standard
Attributes process generates
LINESTATS and POLYSTATS
tables for the selected vector
objects.

Vector Layer
icon

Toggling on these buttons
generates additional fields in
the POLYSTATS table but
increases computation time.

Update Standard
Attributes option
generates an
updated standard
statistics table if
you have Maintain
Standard Attributes
button  toggled on
in the Object
Properties window.



• Select Zoom to Location icon in the View window, or
• Click on the View menu in the View window and select Zoom to Location option.
• Enter desired North and East coordinates for the center of your View.
• Select Zoom to scale, height, or width.
• Enter appropriate values for scale, height, or width.
• Click on Apply button, or
• Click on OK button to close the Zoom to Location window and zoom.

Zoom to Location

How to Zoom to Location

• Zoom by scale, width, or height to a specific location
• Enter geographic coordinates manually
• Choose Coordinate Reference System to enter coordinates

DID YOU KNOW . . . you can zoom to a specified location by entering
its geographic coordinates?

What Zooming to Location Gives You

WANT TO KNOW MORE?

Displaying Geospatial Data
See the tutorial booklet entitled:

Zoom to Location option Zoomed in according to coordinates

Specified
coordinates
are positioned
at the center
of the View
window.

Enter coordinates using any of
the Coordinate Reference
Systems supported by TNTmips.

Zoom to
Location

icon

Choose among more
than 50 unit options.

Set scale indirectly
by selecting height
or width options.



•  Open the vector object to edit in the Editor.
•  Right-click on a single label and select Edit from the right mouse button menu.
•  Resize and/or reposition the label text with the mouse or using the Style Editor.
•  Right-click in the View window or click on the Save button in the Text Label Edit

Controls window to open the Text Style Change window.
•  Toggle on the Create new text style button to apply changes to a single label, or

toggle on the Change current text style button to apply the changes to all labels of
the same style.

Apply Label Style Changes
DID YOU KNOW . . . you can interactively edit a single label and apply
changes to only that label or to all labels of the same style?

What Applying Label Style Changes Gives You
•  Change style of one label and apply the changes to the other labels
•  Save style changes as a new style or change the current style
•  Change text size with mouse or with Style Editor

WANT TO KNOW MORE?

 Labels and Leader Lines
See the Technical Guide entitled:  Interactive Editing of

How to Apply Label Style Changes

Toggle on this
button to create
a new text
style, which
applies only to
the selected
label.

Click on the Edit
Style icon to open
the Style Editor to
edit the current
style or create
new styles.

Toggle on this
button if you do not
want to apply the
style changes.

Click on the Style
tab to edit the
current style.

Toggle on this
button to change
current text style,
which applies to all
labels of the same
style.

Click on the Save
button or right-click on
the View window to
open the Text Style
Change window.

Select Edit from the menu to
resize and/or rotate the label u
with mouse or using Text Label
Edit Controls window.

In this example, the current text
style was changed by editing a
single label. The changes were
applied to all labels of this style.



Platform Font Family Font File Name

Sans Helvetica.dfont:1
SansBold Helvetica.dfont;2
Fixed Courier.dfont;1

Mac OS X FixedBold Courier.dfont;2
Serif Times.dfont;1
Serif Bold Times.dfont;2
SerifItalic Times.dfont;3
SerifBoldItalic Times.dfont;4

Sans helr____.ttf
SansBold helb____.ttf
SansItalic heli____.ttf
SansBoldItalic helbi___.ttf
Serif timr____.ttf

Linux SerifBold timb____.ttf
SerifItalic timi____.ttf
SerifBoldItalic timbi___.ttf

outline Sans duck.of
font Fixed raven.of

fallbacks Serif cardinal.of

•  Overcome missing font problems
•  Interface font for TNT products used as for fallback font
•  Manually specified font substitution also available

Automatic Font Substitution

What Automatic Font Substitution Gives You

•  Let TNT products do the font substitution automatically.
•  Specific fonts can be specified for substitution if desired.

How to Use Automatic Font Substitution

WANT TO KNOW MORE?

Font Substitution in the TNT Products
See the Technical Guide entitled:

In automatic font substitution, the font to substitute for a missing font is
automatically chosen from the same font family as listed in the illustrated table.
For example, sans serif fonts are replaced by other sans serif fonts.

Windows

The DataTip is designed in
Arial (arial.ttf).

TNTmips substituted Helvetica
for Arial automatically.

Mac OS X

Platform Font Family Font File Name

Sans arial.ttf
SansBold arialbd.ttf
Fixed cour.ttf

Windows FixedBold courbd.ttf
Serif times.ttf
Serif Bold timesbd.ttf
SerifItalic timesi.ttf
SerifBoldItalic timesbi.ttf

Sans Arial.ttf
SansBold Arial-Bold.ttf
SansItalic Arial-Italic.ttf
SansBoldItalic Arial-BoldItalic.ttf
Fixed CourierNew.ttf

Sun FixedBold CourierBold.ttf
FixedItalic CourierItalic.ttf
FixedBoldItalic CourierBoldItalic.ttf
Serif TimesNewRoman.ttf
Serif Bold TimesNewRoman-Bold.ttf
SerifItalic TimesNewRoman-Italic.ttf
SerifBoldItalic TimesNewRoman-BoldItalic.ttf

DID YOU KNOW . . . the TNT products provide automatic font substi-
tution if the font used for text in layouts is not found on the computer
displaying the layout?



Change Quick Snapshot Properties
DID YOU KNOW . . . you can easily change your initial settings when
using the Quick Snapshot feature?

What Changing Quick Snapshot Properties Gives You

•  Select Options/View Options from the Display Manager menu.
•  Click on the Snapshot tab in the Options window that opens.
•  Change the settings as desired.

How to Change Quick Snapshot Properties

WANT TO KNOW MORE?

Quick Snapshot of View Contents
See the Technical Guide entitled:

•  Select from a variety of external or internal formats
•  Set a prefix to be used as file or folder name
•  Save georeference files (*.kml, *.prj, and world files) with external formats
•  Create a subfolder to save the set of snapshot and georeference files generated
•  Launch Google Earth automatically if a KML file is generated

The Options window opens when
you select Options/View Options
from the Display Manager menu.

Quick Snapshot icon

The first time you click on the Quick Snapshot
icon, you are prompted to select a folder
(existing or new) and format in which to save
the current and subsequent snapshots. These
settings are retained unless you change them in
the View Options window.

If this button is toggled on, a
subfolder is created to contain the set
of snapshot and georeference files
generated by Quick Snapshot.

Toggling on this button
lets you launch Google
Earth automatically if a
KML file is generated.

When this button is
toggled on, rasters saved
to external formats are
georeferenced by the
accompanying, same-
named *.kml, *.prj, and
world files.

The Quick-Save Folder
button lets you set the
folder in which to save
the current and
subsequent snapshots.

The Quick-Save Prefix
button lets you change
the prefix used as file or
folder name, which is
appended by an
increasing number.

The Format menu lets you
choose from internal and
external formats with different
compression methods.



Check Drive Read/Write Performance
DID YOU KNOW . . . you can evaluate the performance of your
system using the Operation Timings process in TNTmips?

What Checking Drive Performance Gives You

•  Select Tools/Miscellaneous/Timings from the menubar.
•  Select the operation type from the Operation menu.
•  Change the settings on the Options panel as desired.
•  Click on the Run button.
•  Select the file to read/write to when prompted.
•  Repeat the test after changing the settings of your computer and compare the

before and after results to evaluate the speed change.

How to Check Drive Performance

WANT TO KNOW MORE?

MicroImages’ Web Site
Search the information available on

•  Analyze six different operations: Read File, Write File, Create File, Read
Raster, Create Raster, and Status Display

•  Examine the relative efficiency of these operations using actual data sets
•  Evaluate the settings of your system for speed based on the test results

The Options panel has
different settings according
to the operation selected.

Toggling this button on
activates a status window
so you can see the test’s
progress and choose to
cancel it before its completion.

Select the operation
type from the menu.

The Timing Report is generated in a separate window
when the selected operation is completed.

The time required to read the
selected object in a project file
is shown in the Timing Report
window above.

The time required to generate a
given number of status update
displays is shown in the Timing
Report window above.



•  Select Enhance Contrast from the right mouse button menu for a raster
layer in the Display Manager.

•  Determine cell value range for raster set using the Raster Histogram choice
on the right mouse button menu.

•  Set the Input Range value to the overall cell value range of the raster set.
•  Select Save/Save As from the File menu.
•  Repeat the above steps for the subsequent raster(s) or copy the saved

contrast table to other raster(s) using Project File Maintenance.

Contrast Enhancement for Raster Sets
DID YOU KNOW . . . you can adjust the contrast enhancement for a set of
adjacent rasters for better visualisation?

What Adjusting Contrast Enhancement for Raster Sets Gives You
•  Match the display colors of a set of adjacent rasters
•  Save adjusted contrast table for each raster

WANT TO KNOW MORE?

See the tutorial booklet entitled:

How to Adjust Contrast Enhancement for Raster Sets

       Getting Good Color

Elevations in raster
EAST range from
1280 to 1707 meters
and in raster WEST
from 1340 to 2741.

When the contrast is adjusted
for both DEMs, the display
colors match along their
common boundary.

Check the histograms
of the rasters to see
the overall range.

Set the Input Range
values of each raster
to the overall range of
the raster set.



•  Choose to Hide/Show layers and groups in hardcopy layout views and prints
•  Choose to Hide/Show layers in display group views when multiple views are open
•  Set different layer or group visibility for hardcopy and its layout view(s)

Control Visibility of Layers and Groups
DID YOU KNOW . . . you can control the visibility of layers and groups
in hardcopy layouts and group display views?

What Controlling Visibility of Layers and Groups Gives You

•  Open a saved layout or create a new one.
•  Right-click on the checkbox for a group or layer.
•  Toggle off the view and/or the hardcopy buttons in the group or layer visibility list

to hide the group or the layer in these views and/or the hardcopy.

How to Control the Visibility of Layers

WANT TO KNOW MORE?

View Toolbar Features
See the Technical Guide entitled:

When the mouse is paused over a
hide/show checkbox of a group or
layer in a hardcopy layout, a ToolTip
is activated as shown above. In
display groups and display layouts,
the ToolTip does not include the
right-click information unless
multiple views are open.

Right-clicking on a hide/
show checkbox opens the
Group Visibility (or the
Layer Visibility) menu that
lets you set the visibility of
the group (or layer) in the
open views and hardcopy.

All groups and the layers are
visible in View 1. Note that
all buttons are toggled on
for all layers and groups.

Group 2 and the Hydrology
layer in Group 1 are hidden
in View 2 (above).

The Roads layer in
Group 1 and the Soils
layer in Group 2  are
hidden in the hardcopy.

In the illustration above, toggling off the
View 2 button hides Group 2 in View 2
(below) and the check is dimmed.



•  Select Tools/File Manager from the menubar.
•  Navigate to the adjusted contrast table under the raster object.
•  Select contrast table and click on the Copy button if only one other raster in set, or

click on the Replicate button for larger sets.
•  Select the raster object(s) to copy the contrast table to when prompted.

Copy Contrast Tables
DID YOU KNOW . . . you can copy a raster’s contrast table to another
raster for better visualisation of a set of adjacent rasters?

What Copying Contrast Tables Gives You
•  Match the display colors of a set of adjacent rasters
•  Use one adjusted contrast table for all other rasters in a set
•  Save time when adjusting the contrast of adjacent rasters

How to Copy Contrast Tables

* Before copying the contrast
table, you need to adjust the
contrast by setting the Input
Range values of the rasters
to the overall range of the
raster set. (In the Display
Manager, select Raster
Histogram from the right
mouse button menu to
determine the overall range.)

In this illustration, the
DEMs do not appear to
match along their
common boundary
since the same gray
shades correspond to
different elevation
ranges in each raster.

In this illustration, the
DEMs match along their
common boundary after
the adjusted* contrast
table of the raster WEST
was copied to the raster
EAST.

contrast table
subobject

Copy
icon

Replicate
icon

WANT TO KNOW MORE?

See the tutorial booklet entitled:

Analyzing Terrain and Surfaces



•  Select Raster/Interpret/Feature Map from the menubar.
•  Click on the desired operation and mode icons in the Region of Interest window.
•  Draw the processing area and click on the Include button. Repeat as necessary.
•  Select File/Region of Interest/Save As to save the binary raster.

Create Binary Masks
DID YOU KNOW . . . you can create binary masks using the Region of
Interest tool in the Feature Mapping process? (A mask is a processing
barrier or boundary that only allows selected data values to pass.)

What Creating Binary Masks Gives You
•  Designate a processing area from a larger scene
•  Block out the parts to be excluded from the current analysis
•  Create rectangular or irregular shapes to designate the mask area

WANT TO KNOW MORE?

Feature Mapping
See the tutorial booklet entitled:

How to Create Binary Masks

Save the region
of interest to use
as a data mask in
other processes.

Clicking on the Include button assigns
the value of 1 to the selected area.

Select an area as shown above using the
desired operation and mode in the Region of
Interest window.

Clicking on the Exclude button assigns the value
of 1 to the area outside the selected area.

Areas to be processed
have a value of 1 in the
mask, while areas to be
excluded from processing
have a value of 0.



How to Create Points for Line Intersections
• Select Geometric/Combine from the menubar.
• Set Operation to Intersect (AND) in the Vector Combinations window.
• in the Source panel, Click on the Select button to select the source vector
  object and set Line to All and Polygons to None.
• In the Operator panel, click on the Vector button to select the operator vector
  object and choose Line from the Select menu.
• Click on the Run button.

Create Points for Line Intersections

• Create a new vector object that keeps the line intersections as point elements
• Choose to join line database tables with same name and/or structure
• Remove unattached and duplicated records when joining database tables

DID YOU KNOW . . . you can create vector points where line ele-
ments of two different vector objects intersect?

What Creating Points for Line Intersections Gives You

WANT TO KNOW MORE?
See the tutorial booklet entitled:

Vector Analysis Operations

In the example above, a new vector object
was created and 76 points were generated
from the intersecting line elements of roads
and hydrology layers. The points were
assigned the attributes of the intersecting lines.

Selected point.

The line database table in
the source vector object.

The line database table in
the operator vector object.

The point database table in
the output vector object.

The attributes
of the selected
point.



The Compute Region choice
is available on the right mouse
button menu when polygons
are marked by any means.

•  Mark elements by any means.
•  Select Compute Region from the polygon element right mouse button menu.
•  Select Marked Polygons from the Compute Region menu.
•  Apply the settings and click on OK in the Region Generation window.
•  Use Region panel in the GeoToolbox to add, delete, save, and combine regions.

Create Regions by Selection
DID YOU KNOW . . . you can create regions from selected polygons?

What Creating Regions by Selection Gives You
•  Define region using polygons selected by any selection method
•  Convert selected polygons directly to region
•  Set minimum subregion and island size

WANT TO KNOW MORE?

Interactive Region Analysis
See the tutorial booklet entitled:

How to Create Regions by Selection

Click on the Region tab
or icon to open the
Region tabbed panel.

Selecting Marked
Polygons from the
Compute Region
menu opens the
Selected Polygon
Region Generation
window.

The region shown above
includes all subregions without
size restriction. The thick outline
indicates the region boundary.

The region on the left
includes all islands but does
not include subregions
smaller than 300 hectares.

GeoToolbox
icon

subregions smaller
than 300 hectares

The region generated by selected
polygons can be saved, deleted,
or combined with other regions
using Region panel features.

The Advanced
Options panel lets
you set  minimum
subregion and
island size for
inclusion.



•  Use raster objects to generate regions
•  Use query to select the raster cell values for region
•  Set minimum subregion and island size
•  Preview the region generated before adding to GeoToolbox

Create Regions Using Raster Expressions

How to Create Regions Using Raster Expressions

DID YOU KNOW . . . you can compute regions using raster cell
values selected by a query?

What Creating Regions Using Raster Expressions Gives You

•  Add a grayscale raster object and click on the + to show the raster details.
•  Right-click on the raster name or icon.
•  Choose Compute Region/Raster Expression from the menu that opens.
•  Click on the Add button to select additional raster objects for query.
•  Click the Raster Expression button to open the SML window.
•  Enter a query to select the desired raster cell values.
•  Click on the Apply button to preview the temporary region.
•  Click on OK to generate the region and save it using GeoToolbox.

The Advanced
Options panel
lets you set
minimum
subregion and
island size.

The Apply
button lets
you preview
the region.

The raster expression region shown
at the right delimits areas where the
slope is less than 10 % and the
elevation is greater than 1150 meters.

GeoToolbox
icon

Click to open
SML window.

Enter a query to find the
cells that satisfy the
selection criteria.

Click to select
additional raster
object(s) to use
in the raster
expression.

Search the information available on

WANT TO KNOW MORE?

MicroImages’ Web Site



Direct Use of JPEG2000 Files (*.jp2)

How to Directly Use JPEG2000 Files

•  Automatic display without importing files
•  Fast display of large files
•  Use as raster object wherever appropriate, such as in Mosaic or Extract

(which means do not use lossy rasters in TNT automated analysis processes)
•  Raster DataTips are available
•  Open in TNTatlas without importing
•  Part 1 compliant files with JPEG2000 compression supported

•  Double-click on the file to open in a new 2D View.
•  Use the Open With right-click option and select a TNT product.
•  Browse to and select file in any TNT Select Objects dialog.

DID YOU KNOW . . . you can directly display and use files with
JPEG2000 compression in the TNT products?

WANT TO KNOW MORE?

What Directly Using JPEG2000 Files Gives You

Sharing Geodata with Other Popular Products
See the booklet entitled:

JPEG2000 file selected
directly in Raster/Extract

JP2 files may contain georeference as internal
metadata or may use a same-named world file (*.j2w)



•  In TNT Explorer or in TNTmips standard file selection dialogs navigate to a direc-
tory where you keep data in RVC format or any format supported for direct use.

Folder and File Icons
DID YOU KNOW . . . TNTmips uses icons that represent Project File
folders and the objects they contain?

What Folder and File icons Give You
•  Distinguish the TNT Project File folders and object types
•  Use same icon for same object/subobject type
•  Identify each icon using DataTips
•  View similar icons on your desktop and in TNT products

WANT TO KNOW MORE?

Maintaining Project Files
See the tutorial booklet: Understanding and

How to Use Folder and File Icons

The icons that represent different object and subobject types

The Project File
icon in TNT
Explorer

The object and
subobject icons in
TNT Explorer

The Project File and
file types supported
for direct use icon
in the TNT products

The object and
subobject icons in
the TNT products



•  Ability to link large number of elements to unique URLs
•  Automatically generate URLs for each element
•  Ability to launch the URLs you link to

Link to URLs Using Attributes

How to Link to URLs Using Attributes

DID YOU KNOW . . . you can link to URLs associated with a large
number of elements using element attributes?

What Linking to URLs Using Attributes Gives You

•  Create a computed field to specify the URLs.
•  Make the layer with this computed field the active layer and click on

the Hyperindex Linker icon in the View window.
•  Click on a vector element icon in the HyperIndex Linker window.
•  Click on one of these vector elements in the View window.
•  Click on the Add button in the HyperIndex Link Selection window.
•  Set the Type to URL by Attribute and click on the Object button.
•  Select the database table and computed field in the table list.
•  Click on OK and close the HyperIndex Linker window.

WANT TO KNOW MORE?

Constructing an Electronic Atlas
See the tutorial booklet entitled:

Script for string expression
field that automatically
generates the URL entries.

A record that provides the correspond-
ing URL is attached to each polygon.

HyperIndex
Linker icon

Setting Type to URL by Attribute for the
selected polygon element automatically
links all polygon elements to the URLs
listed in the selected field.

Clicking on a
polygon opens the
web page that
shows the local
weather of the
selected area.The Vector Element

icons (Vector Point,
Line, and Polygon)



Manually Specified Font Substitution
DID YOU KNOW . . . you can specify fonts for substitution if the font
you use for text in layouts is not found on another computer?

What Manually Specified Font Substitution Gives You

•  Specify the fonts to substitute for the missing font as
{~Ffontname1,fontname2,fontname3} when entering the text.

•  Let TNT products do the font substitution automatically when fonts to
substitute for missing fonts are not specified.

•  If none of fonts specified manually or substituted automatically are found,
font specified for TNT user interface is substituted.

How to Specify Fonts

WANT TO KNOW MORE?

Font Substitution in the TNT Products
See the Technical Guide entitled:

•  Overcome missing font problems
•  Ability to specify the font to substitute for a missing font
•  Automatic font substititution used when no substitution specification is made

The fonts to substitute for
missing fonts in Address and
Owner entries are designer
specified: Times New Roman
bold will be used if found,
Helvetica will be the next choice,
then Courier will be used.

Automatic substitution will
take place for Arial bold. If
not found, Arial bold will be
replaced by Helvetica bold
automatically.

These entries
are designed
in Times New
Roman bold
(timesbd.ttf).

Windows

These entries
are designed
in Arial bold
(arialbd.ttf).

Helvetica
(helvetica.dfont;1)
was substituted
for the absent
Times New Roman
bold (timesbd.ttf)
by design.

Mac OS X

TNTmips substituted
Helvetica bold for
Arial bold
automatically.

In the illustration above, the fonts specified
are shown as part of the string expression in
each record of the corresponding field.



Merge Legend Entries
DID YOU KNOW . . . you can merge the legend entries that use the
same style for different attribute values into a single listing?

What Merging Legend Entries Gives You

•  Click on the vector icon to open Vector Layer Controls window.
•  Click on the Object tab.
•  Toggle on the Merge duplicate styles in legend button.

How to Merge Legend Entries

WANT TO KNOW MORE?

Merging LegendView Entries
See the Technical Guide entitled:

•  Create more compact legends on screen and in map layouts
•  Merge the attributes for each duplicated style sample in LegendView
•  Create Multi-Object Legends that use the same entries as LegendView

Turn off this option if you do not want
LegendView entries merged. This option is
on by default until the setting is changed.

Multi-object legend when Merge duplicate
styles option is off.

The vector object
illustrated uses 16 styles
for the 49 different
polygon attribute values.
The legend labels are
merged next to each
merged style sample
(above) or each can be
listed separately (right).

merging off

merging on

Multi-object legend when Merge duplicate
styles option is on.



•  Select Edit Relations from the right mouse button menu.
•  In the Database Editor window, right-click on the Internal table.
•  Select Copy from the menu that opens.
•  Accept the default name or enter a new one when prompted.
•  Open the new table copied and use standard field creation procedures.
Or,
•  Select New Table from the right mouse button menu.
•  Use table wizard to create a new table.
•  Relate the new table to the internal table through the cell values when prompted.
•  Use standard field creation procedures.
•  Manually enter cell values for the Value (key) field created by the wizard and the

attribute values for other field(s) you created.

•  Create database tables associated with the raster’s cell values
•  Use database field values as DataTips and/or in LegendView
•  Edit database tables just as for any other object type

Raster Attributes
DID YOU KNOW . . . you can create attributes for raster objects?

What Raster Attributes Gives You

Managing Geoattributes
See the tutorial booklet entitled:

Select New Table
to open the
Database Table
Creation Wizard
to create a new
table with the
desired fields
and attachment
type.

For unsigned raster objects up to 16 bit,
you can simply copy the internal table to
have a new database table with the
raster cell values, where you can add
new fields for the desired attributes.

Select Edit
Relations to
open the
Database Editor
window.

In this example, the new field
created in the copied database
table is used for the DataTip
and LegendView.

How to Create Raster Attributes



•  Enter coordinates to define an extraction area
•  See the coordinates entered as an elastic box in the View window
•  Draw, resize, and move the elastic box to define an extraction area
•  Automatic adjustment of coordinates based on the elastic box

Raster Extraction Using Map Extents
DID YOU KNOW . . . you can specify the coordinates of a location to
extract from a raster object?

What Extracting Rasters with Map Extents Gives You

•  Select Raster/Extract from the menubar.
•  Select the raster object(s) you want to extract from when prompted.
•  Choose the Range option from the Select menu on the Extract panel.
•  Click on the Map Extents tab in the Raster Extract window.
•  Enter the coordinates of the area you want to extract.
•  Click on the Run button.

How to Extract Rasters with Map Extents

The coordinates
entered are shown
as an elastic box in
the Raster Extract
Object View window.

When you draw, resize,
or move the elastic box,
the coordinates automati-
cally adjust.

Setting the Select option to Range on
the Extract tabbed panel lets you enter
the coordinates of the raster extraction
area on the Map Extents panel.

The Map Extents panel
shows the coordinate
reference system of the
input raster. The current
CRS can be changed using
the Coordinates button.

Search the information available on

WANT TO KNOW MORE?

MicroImages’ Web Site



Raster Extraction Using Vector Polygons
DID YOU KNOW . . . you can extract new raster objects from your input
object using vector polygons?

What Extracting Rasters Using Vector Polygons Gives You

•  Select Raster/Extract from the menubar.
•  Select the raster object(s) you want to extract from when prompted.
•  Choose the By Polygon option from the Select menu (Extract tabbed panel).
•  Select the vector object for raster extraction when prompted.
•  Select the attribute to supply default names from the database tables listed.
•  Click on the Run button.

The Line and
Column entries
automatically adjust
according to the
extents of the
vector object
selected.

How to Extract Rasters Using Vector Polygons

This button allows
you to select a
vector object to
define the raster
extraction area.

Three raster
objects were
extracted
using the
polygons
selected.

•  Use vector polygons to define raster extraction area(s)
•  Ability to select one or more polygons to define raster extraction area(s)
•  Automatic adjustment of line and column entries based on the vector’s extents
•  Ability to auto-name output rasters with the desired vector attribute

When a vector object is
selected to define the
raster extraction area, the
Select Attributes for Default
Names window opens.

Selecting a table and field allows you to
auto-name your output rasters with the
selected attribute.

Three polygons
were selected to
define the
extraction areas.

If no polygons
are selected, the
Raster Extract
process uses all
polygons in the
vector object to
define the raster
extraction areas.

Search the information available on

WANT TO KNOW MORE?

MicroImages’ Web Site



Raster Geodata Structures
DID YOU KNOW . . . TNT products support a variety of raster
geodata structures?

TNT products automatically handle a wide variety of raster data types from 1 to
128 bits per pixel.  The supported raster geodata structures are as follows:

data type               descriptions                              data depth 

binary  0,1 1-bit 

unsigned integer 0 to 15 4-bit 

unsigned integer 0 to 255 8-bit 

signed integer -128 to 127 8-bit 

composite color 0 to 255, requires color map 8-bit 

unsigned integer 0 to 65,535 16-bit 

signed integer -32,768 to 32,767 16-bit 

composite color RGB or BGR packed 16-bit 

composite color RGB or BGR packed 24-bit 

unsigned integer 0 to 4,294,967,295 32-bit 

signed integer -2,147,483,648 to 2,147,483,647 32-bit 

floating point accuracy of 7 decimal digits 32-bit 

floating point accuracy of 15 decimal digits 64-bit 

complex number  magnitude/phase 64-bit 

complex number  real/imaginary 64-bit 

complex number  magnitude/phase 128-bit 

complex number  real/imaginary 128-bit 

 

Search the information available on

WANT TO KNOW MORE?

MicroImages’ Web Site



•  Ability to warp one or several geometric objects simultaneously
•  Warp geometric objects that do not share the same georeference or extents
•  Use various geometric transformation models for reprojection
•  Create output with implied georeference
   (object coordinates = geographic coordinates)

Reproject Geometric Objects
DID YOU KNOW . . . you can reproject geometric objects to change
their map projections or correct spatial distortions?

What Reprojecting Geometric Objects Gives You

•  Select Geometric/Reproject to open Geometric Warping via Georeference window.
•  Click the Select button to choose the objects to be warped.
•  Select the appropriate geometric transformation model.
•  Set the Output Projection if it is not the same as the input.
•  Click on the Run button.

How to Reproject Geometric Objects

Same as input option
is used when
correcting distortion
in a geometric object
using the map
projection of the input
object.

Output Projection
button lets you change
the Coordinate
Reference System.
This button is dimmed
when Same as input
button is toggled on.

The Line Densification Accuracy value
sets the maximum allowed deviation
between any segment of the reprojected
line and its computed location in the new
projection. Smaller accuracy values
result in more line vertices, producing a
better match to the projected location.

If the input object does not have
the minimum number of control
points required for a geometric
transformation model, that model
is not listed for selection in the
Model menu. When the
georeference subobject does not
contain control points, the default
From Georeference option is the
only method available.

The Select button lets you choose
one or several geometric objects of
any type to be warped simultaneusly.
Geometric object types in TNT
products include vector, CAD, TIN,
region, and shape objects.

Search the information available on

WANT TO KNOW MORE?

MicroImages’ Web Site



The Format menu
lets you choose the
format of the saved
substatistics.

WANT TO KNOW MORE?

Managing Relational Databases
See the tutorial booklet entitled:

•  Save all or any substatistics of the following types:
    count, sum, mean, standard deviation, minimum, and maximum
•  Save substatistics in various formats or in a new database table
•  Choose to save substatistics of all or selected records

Save Database Table Substatistics

How to Save Database Table Substatistics

DID YOU KNOW . . . you can save substatistics shown in tabular view
in a new database table?

What Saving Database Table Substatistics Gives You

•  Click on the database table checkbox to open the database table.
•  Select Table/Save As from the menu to open the Save As window.
•  Select the desired type of the substatistics listed on the Values menu.
•  Change the other settings as desired and click on OK.

The Values menu lets
you choose the type of
substatistics, which only
appear if they are shown
in the tabular view.

The sum of the areas of each
soil type class in the selected
watershed is saved as a new
database table as shown below.

The illustration on the left
shows the watershed
boundaries over soil type
polygons.

The watershed selected has 423
records of soil type classes. The sum
of the areas of each land use class is
shown in the database table below.



1

Saving groups and
layouts as text files
rather than RVC
format layout
objects lets you
change them in a
text editor.
However, you may
corrupt the layout if
you edit the
sections required
by TNTmips for
correct display.

• Save new or existing groups/layouts in ASCII format
• Edit layouts/groups in a text editor
• Directly open or print the contents of the layouts in TNT after editing.

Save Groups and Layouts as Text Files
DID YOU KNOW . . . you can save groups and layouts in a text file
format?

What Saving Groups and Layouts as Text Files Gives You

•  Select Save as Text from the Display Manager’s Display menu.
•  Select an existing file or create a new one in the standard Select File window.
•  Use any text editor to edit the layout/group saved as text file.
•  Open the saved layout in the Display process using Display/Open.

How to Save Groups and Layouts as Text Files

Selecting Save
as Text from the
menu opens the
standard Select
File window.

The extensions for the
new text files are .gpt
and .ltt for groups and
layouts, respectively.

Enter a file name to
save layout/group
as a .ltt/.gpt file.

TNTmips lets you
directly print or open
the layouts/groups from
the edited text files.

Search the information available on

WANT TO KNOW MORE?

MicroImages’ Web Site



•  A style field that shows the styles associated with different attributes
•  Direct access to the style editor for selection and assignment of new styles
•  Position the style field at the top or bottom in single record view

Show Style Samples in a Database Table
DID YOU KNOW . . . you can show samples of the drawing styles
associated with different attributes in a database table?

What Showing Style Samples Gives You

•  Toggle on the Show Style Sample from Field menu in tabular view; or
   select Style Sample from the Table menu in single record view.
•  Position the style field by toggling on the Top or Bottom buttons.
•  Click on a style sample to open the Style Editor window.
•  Toggle on the Hide button in single record view or  toggle off the Show Style Sample

button in tabular view to hide the style field.

WANT TO KNOW MORE?

How to Show Style Samples in a Database Table

Click on the style sample in
single record view or tabular
view to open the Edit Styles
window where you can select
and assign new styles.

The Style Sample menu in
single record view lets you
hide or position the style
sample.

Style sample at the top

Style sample at the bottom

Style sample in tabular view

Search the information available on

MicroImages’ Web Site

Toggling on the Show Style
Sample button on the Field
menu adds a Style field to
the tabular view.

Note that the single record
view and the tabular view
have different preference
settings for showing style
samples.

Switching to Single Record
view lets you select Style
Sample from the Table menu.



New_Style_1

•  Open the vector object to edit in the Editor.
•  Click on the Edit Elements icon in the Vector Tools window.
•  Select multiple labels by any means.
•  Click on the Label Attributes icon in the Edit Elements window.
•  Click on the Edit Style icon to open the Style Editor.
•  Create a new style and close the Style Editor.
•  Select the new style and click on the Marked button.

Styling Multiple Marked Labels
DID YOU KNOW . . . you can style more than one label at a time?

What Styling Multiple Marked Labels Gives You
•  Select the labels to style using various selection methods
•  Create new styles for various sets of labels
•  Choose to apply style changes to all or marked labels

WANT TO KNOW MORE?

Advanced Vector Editing
See the tutorial booklet entitled:

How to Style Multiple Marked Labels

In the illustration above, four labels were marked
and assigned a new style.

Label Attributes
icon

Edit Elements icon

Click on the Marked
button to apply operation
to the marked labels.

Edit Style
icon

The Edit Style icon opens the
Style Editor window where
you can create new styles
and edit the existing ones.



Text Labels for Polygon Legends
DID YOU KNOW . . . you can create text labels in addtion to sample
polygon styles in polygon legends?

What Text Labels for Polygon Legends Give You

•  Click on the vector icon to open the Vector Layer Controls window.
•  Click on the Sample Label button on the Polygon tabbed panel.
•  Select the database field to provide the sample label text.
•  Click on the Legend Label button and repeat step3.

How to Create Text Labels for Polygon Legends

WANT TO KNOW MORE?

Text Labels for Polygon Legends
See the Technical Guide entitled:

•  Enhance information content and appearance of legends
•  Auto-generate corresponding labels for the polygon samples in legends
•  Select any database field to use as text label

Use the Legend Label
button to select the
database field to
provide the legend
entry descriptions.

Use the Sample Label
button to select the
database field to provide
label text in the sample.

The LegendView of the vector object illustrated
contains the descriptions and the symbols of the
soil classes as the legend label and sample label,
respectively.

LegendView entries with polygon
sample and legend labels

Multi-object legend entries with
polygon sample labels

Sample Label:
CLASS.class

Legend Label:
DESCRIPTION.name



Toggle Redraw from Automatic to Manual
DID YOU KNOW . . . when you are working with many large layers in a
view or other situations of slower redraw, you can toggle from automatic
redraw mode to manual redraw on demand?

What Toggling Redraw from Automatic to Manual Gives You

For the current view:
•  Click the Redraw after any change icon off.
For subsequent views:
•  Select Options/View Options from the Display Manager menu; or
    select Setup/Preferences from the Editor-Layer Manager menu.
•  Click on the View tab in the window that opens.
•  Toggle on the Default to redraw after any change button.
•  Click the Redraw after any change icon off in the View window to toggle back

to manual redraw mode when you are preforming slower redraw operations.

How to Toggle Redraw from Automatic to Manual

WANT TO KNOW MORE?

View Toolbar Features
See the Technical Guide entitled:

•  Avoid refreshes that are not needed by manually controlling redrawing
•  Use Redraw icon only when you want the view to refresh
•  Change default redraw behavior to manual instantly if it is set to auto

When this button is
toggled on, the Redraw
after any change icon is
pressed for each new
view and you do not
need to press the
Redraw icon every time
you want to refresh the
view. However, in
situations of slower
redraw, you may want
to change this behavior.

The Redraw after any change
icon toggles your default refresh
selection for that view to the
opposite choice for as long as
that view is open and used.

The Options window
opens when you select
Options/View Options
from the Display
Manager menubar.

Automatic redraw mode

The Redraw icon updates
view canvas on demand. It
is not necessary when the
Redraw after any change
icon is toggled on.

Manual redraw modeUnpress the
Redraw after any
change icon to
switch from Auto
to Manual Redraw
mode.



•  Refresh view automatically after any change
•  No need to press Redraw icon every time you want the view to refresh
•  Change default redraw behavior to automatic instantly if it is set to manual

Toggle Redraw from Manual to Automatic
DID YOU KNOW . . . if you are viewing only a few layers, reordering
layers, and performing similar fast redraw operations, you can toggle
from manual redraw to redraw after any change?

What Toggling Redraw from Manual to Automatic Gives You

For the current view:
•  Click the Redraw after any change icon on.
For subsequent views:
•  Select Options/View Options  from the Display Manager menu; or
    select Setup/Preferences from the Editor-Layer Manager menu.
•  Click on the View tab in the window that opens.
•  Toggle off the Default to redraw after any change button for manual redraw mode.
•  Press the Redraw after any change icon in the View window to toggle back to

automatic redraw mode if you are preforming fast redraw operations.

How to Toggle Redraw from Manual to Automatic

WANT TO KNOW MORE?

View Toolbar Features
See the Technical Guide entitled:

When this button is
toggled off, the
Redraw after any
change icon is not
pressed for each new
view and you need to
click the Redraw icon
when you want to
refresh the view.

The Redraw icon updates
view canvas on demand. It
is not necessary when the
Redraw after any change
icon is toggled on.

The Redraw after any change
icon toggles your default refresh
selection for that view to the
opposite choice for as long as
that view is open and used.

The Options window
opens when you select
Options/View Options
from the Display
Manager menubar.

Manual redraw mode Automatic redraw modeClick on the Redraw
after any change icon to
switch from Manual to
Auto Redraw mode.



•  Automatic recording of all TNT activities in a text file
•  Retain 10 most recent logs regardless of age
•  A timestamp, the process name, and associated text for every log entry
•  Automatically send log files to MicroImages tech support for assistance

Use Session Log Files
DID YOU KNOW . . . you can use session log files to analyze perfor-
mance in TNT products?

What Using Session Log Files Gives You

•  Navigate to the folder where log files are placed:
Windows - My Documents/MicroImages,
Mac - library/logs/MicroImages, and
Unix/Linux - the .MicroImages folder in the user’s home directory.

•  Open the log file using any text editor; or
•  Select Help/Contact Support from the menubar.
•  Click on the Preview icon to preview your current session log file.
•  Keep the Current Session Log button toggled on to send the log files to MicroIm-

ages tech support along with your request for assistance.

How to Use Session Log Files

WANT TO KNOW MORE?

Session Log Files
See the Technical Guide entitled:

The log files are named in the form of YYYYMMDD.log, where YYYY is the
4-digit year, MM is the 2-digit month and DD is the 2-digit day of the month.

The log file contains a timestamp, the
process name and associated text for
every log entry with the following ad-
ditional information:
• Application startup time.
• Executable path and build date/time.
• MISYSTEM, RVCSYS, and GEOM
  libraries build date/time.
• Process termination if exited normally.

Toggling on this button lets
you send the recent log
file to MicroImages tech
support automatically
when requesting
technical assistance.

The Preview icon lets
you preview your
current session log file.



•  Choose Display/Render to KML to open the Render to KML window.
•  Use the Options panel to specify the extents of the KML/KMZ file.
•  Click on the OK button to create a KML/KMZ file with default settings; or
•  Click on the Geometric Controls tab to change the coordinate accuracy value

for the geometric objects.
•  Click on the Raster Controls tab to change the Cell Value and Format Type for

the raster objects.

DID YOU KNOW . . . you can create a KML or KMZ file from the
geospatial layers in your groups or map layouts?

What Creating KML/KMZ Files from Map Layouts Gives You
•  Match the extents of any open 2D or 3D window or match the inclusive

extents of all layers in a view
•  Set the cell size of the raster objects rendered to KML
•  Set the coordinate accuracy of the vertices rendered to KML
•  Control group(s) and the spatial objects in those groups individually in Google

Earth and Google Maps

Create KML/KMZ Files from Map Layouts

WANT TO KNOW MORE?

These panels appear
only when there is a
raster or geometric
object added to the
group/layout.

How to Create KML/KMZ Files from Map Layouts

Select any open view
window or Entire
Display to specify the
extents of the KML file.

See the Technical Guide entitled: Spatial Display:

Render Map Layouts to KML

When a KML/KMZ file is dis-
played in Google Earth,
each group in the layout is
listed in the Places panel as
an expandable folder, which
provides each original TNT
object in that group in a
separate sub-folder. Each
sub-folder lets you turn the
associated object type on
and off independently.

Map layout rendered
to KMZ and displayed
in Google Earth.



•  Generate a new raster object from multiple input objects
•  Compute new cell values using an SML script
•  Set raster type, projection, extents, cell size, and raster size for the output

Creating New Objects Using GeoFormulas

How to Create New Objects Using GeoFormulas

DID YOU KNOW . . . you can create new raster objects using the
GeoFormula process to compute cell values from the attributes of
geospatial input object(s)?

What Creating New Objects Using GeoFormulas Gives You

WANT TO KNOW MORE?

Using Geospatial Formulas
See the tutorial booklet:

•  Select Script/GeoFormula from the menubar.
•  In the GeoFormula window that opens, toggle on Create new formula using

dialog button and click on OK.
•  Select input object(s) to process when prompted.
•  Click on the Script panel and enter an SML script.
•  Click on the Output panel and select data type for the output raster.
•  Click on the Run icon and save output raster.

Select Symbol from the
Insert menu to insert the
names of input objects
into the script using the
Help window.

Run icon

Insert icon

The illustration above shows
the Variables entry expanded
for the list of input objects along
with the other variables. Select
the raster name and click on the
Insert icon to insert the selected
name into the script.

When you toggle on
this button at startup,
you are prompted to
select input objects.

Enter a script to compute cell values of
the output raster using the attributes of
input objects.  In the illustration above,
two input raster objects were used.

The Output tabbed
panel lets you set
parameters for output
raster type, projection,
extents, and cell size
or raster size. Make
sure to select the
appropriate Raster
Type to cover the
whole range of values
generated by the
script.



•  Add a raster object to define the elevation surface.
•  Add any number of vector objects with text labels as drape layers, or
    create dynsmic labels for your vector elements.
•  Select Open 3D View from the Display menu.
•  Click on the Viewpoint Controls icon to set viewer position, distance, direction

and elevation scale.

DID YOU KNOW . . . you can drape vector object labels over a terrain in
your 3D views?

What Draping Labels over Terrain Gives You
•  Render all text labels in 3D perspective view
•  Use permanent or dynamic labels
•  Show leader lines for polygon labels
•  Show labels in text frame shapes

How to Drape Labels over Terrain

Drape Labels over Terrain

See the Technical Guide entitled: 3D Display:

WANT TO KNOW MORE?

Drape Labels over Terrain

3D Perspective View showing labels draped over a terrain

Labels can be draped
with leader lines.

Labels in frames can be
draped over terrain with any
color and transparency level.



•  In the Display Manager window, select Edit Colors from the raster layer’s right
mouse button menu or click on the Edit button in Raster Layer Controls window.

•  In the Color Palette Editor window, click on the desired color to select it.
•  Select an editing tool from the Edit menu or click on an editing icon to adjust the

selected color, or use the sliders to assign a new color.
•  Click on the Redraw icon in the View window to apply the changes in the color

palette. (Note that if the Color Palette Editor  was opened from the Raster Layer
Controls window, you need to close these windows before you can redraw).

• Select Save As from the File menu to create a new color palette.

Editing Standard Color Palettes
DID YOU KNOW . . . you can create a new color palette for your raster
objects by editing a standard color palette?

What Editing Standard Color Palettes Gives You
•  Replace existing color(s) by adjusting or copying the desired color(s)
•  Assign transparency to the selected color(s) or set all colors opaque
•  Reverse the standard color palette
•  Save edited color palette for future use

WANT TO KNOW MORE?

Getting Good Color
See the tutorial booklet entitled:

How to Edit Standard Color Palettes

Copy

Paste
Select
Similar
Colors

Randomize
Set
Selected
Opaque

Set
Selected
Transparent

Selecting the desired editing tool from the
Edit menu (above) or clicking on the
desired editing icon (left) adjusts the
selected color(s).

These editing
tools apply to all
colors regardless
of the selection.

Selected colors are marked with an X.
You can select multiple colors by
using CTRL + Click or SHIFT + Click.

The illustration above shows the
selected colors with full transparency
(Transparency = 100) assigned.

At the right, the
reversed color
palette is shown.
Also a set of similar
colors was selected
and assigned to
white using the RGB
sliders.



•  Choose Display/Render to Raster to open the Render to Raster window.
•  Select the format of the image file to be created from the Format menu.
•  Change the default settings for image size, cell size, and background color,

and select a compression type if desired.
•  Click on the OK button.

DID YOU KNOW . . . you can create an image file in a variety of formats
from the Web Map Service (WMS) layer(s) in your group(s)?

What Rendering a WMS Layer to Raster Gives You
•  A static image file that is not dependent on the availability of the WMS
•  Choose from a variety of image formats
•  Automatically save georeference files (*.kml, *.pgw, and *.prj files)
•  Set the cell size of the raster to be created

Render a WMS Layer to Raster

WANT TO KNOW MORE?

The WMS layer is rendered to an image
file in its full extents regardless of the
zoom level in the View window. The image
file created can be used in different
programs including Google Earth.

How to Render a WMS Layer to Raster

See the Technical Guide entitled: Spatial Display:

Select WMS Layers for Viewing

You can use the KML
file created to
display the image in
Google Earth.

Selecting any format from the
list creates an image file in
the selected format and its
accompanying georeference
files (if applicable).



DID YOU KNOW . . . you can use a standard color palette to automatically
adjust the color of a raster object?

What Standard Color Palettes Give You

Standard Color Palettes

•  In the Display Manager window, select Edit Colors from the raster layer’s right
mouse button menu or click on the Edit button in Raster Layer Controls window.

•  In the Color Palette Editor window, select one of the listed standard palettes or
choose More Palettes from the Palette menu.

•  If More Palettes selected, scroll up/down in the list in the Standard Color Palettes
window, select a standad color palette and click on OK.

•  Click on the Redraw icon in the View window to apply the selected color palette.

•  Easily adjust the color of raster objects
•  Select from a number of standard color palettes
•  Edit any standard color palette to create a new palette

WANT TO KNOW MORE?

Getting Good Color
See the tutorial booklet entitled:

How to Use Standard Color Palettes

Choose to open Standard
Color Palettes window to
select from palettes not
listed on the Palette menu.

The colors of the selected
standard color palette can be
edited using the Color Palette
Editor tools to create a new
palette or assigned directly to
the raster object with no
change.

The last five standard color
palettes used are listed
here for quick selection.

Rainbow 1
standard palette

Coral Reef
standard palette



Vector Geodata Topology Types
DID YOU KNOW . . . the TNT products provide integrated support for
polygonal, planar, and network topology for vector geodata objects?

WANT TO KNOW MORE?

Vector Analysis Operations
See the tutorial booklet entitled:

Polygonal Topology

Project File
Maintenance

Object Information

Planar Topology

Network Topology

•  Highest, or strictest, topology type
•  All lines start and end in nodes
•  No two nodes can have same X and Y coordinates
•  Lines do not intersect other lines or themselves
•  Enclosed areas are defined as polygons
•  A point can be in at most one polygon

•  Topology for 3D objects maintained in the
XY plane

•  Use for objects with enclosed areas that
have attributes

•  All lines start and end in nodes
•  No two nodes can have same X and Y coordinates
•  Lines do not intersect other lines or themselves
•  Topology for 3D objects maintained in the XY plane
•  Use for objects with enclosed areas that do not have

attributes

•  All lines start and end in nodes
•  Two nodes can have same X and Y coordinates
•  Lines can intersect other lines and themselves
•  Constraints imposed by 2D topology on 3D objects

eliminated
•  Use for objects with lines that should cross

without intersection, such as a road network
with overpasses and underpasses



•  Double click on the file if TNTmips is assigned as the default application.
•  Right-click and use Open With option and select TNT product.
•  Browse to and select file in any TNT Select Objects dialog.

DID YOU KNOW . . . you can directly display and use Intergraph
MicroStation DGN files in the TNT products?

What Direct Use of DGN Files Gives You
•  View as layers without importing the files
•  View without altering the original files
•  Show DataTips from available attributes
•  Select files for any TNT product or process
•  Georeference is supported when linking

How to Directly Use DGN Files

Direct Use of DGN Files (*.dgn)

See the Technical Guide entitled: System:

WANT TO KNOW MORE?

Direct Use of CAD Files (DWG, DXF, DGN, TAB)

Show DataTips using
selected Table.Field.

Styles by Attribute or
Script are available.



•  Geotag your digital photos using the Tools/Create Geotagged Image Database
process (make sure that the Embed images in table as BLOBs button is
turned on); or

•  Create a database field with records specifying the path to the photo (make
sure that the Usage is set to Image (file name) in Table Properties window).

•  Display your database pinmap or the vector points with the geotagged image
database or the database with the field that specifies the path to the photo.

•  Select Setup DataTips from the right mouse button menu of the object.
•  Click on the Points/Records tab and choose Select Attribute from the Show

menu, then choose the Image or Thumbnail field from the geotagged image
database, or the field showing the path to the image.

•  Pause the mouse over any vector point symbol or database pin to view the
digital photo thumbnail.

DID YOU KNOW . . . you can view digital photos as DataTips using the
field values automatically created by the geotagging process or creating
the appropriate field specifying the image file?

What Viewing Digital Photos as DataTips Gives You
•  View digital photos in a pop-in DataTip
•  Display digital photos along with the information from other layers in a DataTip

Digital Photos as DataTips

WANT TO KNOW MORE?

How to View Digital Photos as DataTips

See the Technical Guide entitled: Digital Photos:

Pinmap Digital Photos

Select to open
DataTip Settings
window shown
on the right.

Click to select
Table/Field for
the DataTip
information

Any field
specifying the
path of image file
can be selected
to display photos
as DataTip.

Digital photo thumbnail
as DataTip



Node Tables with Computed Fields

How to Create Node Tables with Computed Fields

•  Node element numbers without exposing internal tables
•  Element information for lines attached to nodes
•  Automatic creation of table that includes records for all nodes
•  Add as many fields as desired with computed or direct entry values

•  Right-click on the node element line and choose New Table.
•  Choose User Defined then provide a name and description for the table.
•  Choose One record per element, record number equals element number in

the wizard (which is shown as Implied one-to-one in the table properties)
•  Click on Node table on the Table tabbed panel.
•  Click on the Add Field icon, set as a computed field with width appropriate

for the number of nodes in your vector object, and click Edit Expression.
•  Click on the Insert Field icon in the Query window and accept the defaults

(Current Point, Internal, and ElemNum).
•  Click on Add Field again, this time define the field as desired.

DID YOU KNOW . . . you can create tables for nodes that draw infor-
mation from other tables in the same vector object?

WANT TO KNOW MORE?

What Creating Node Tables with Computed Fields Gives You

Accepting the default values (above)
when inserting a field for a computed
field expression in a node table will
create a table with the same number
of records as nodes in the object.

Building and Using Queries
See the booklet entitled:

Choose to create a new table for
nodes and set its attachment type as
One record per element, record
number equals element number.
When the wizard opens the Table
Properties window, turn on the Node
table toggle (shown below) on the
Table tabbed panel.

The query shown below will get its information for every
node in the vector object from the first line that has that
node as a start node.  This query returns 0 if there is no
upstream line from the node.

Node table
with
computed
fields that
report node
or line
properties.
Records for
selected

nodes are shown.  Polygon properties
can also be reported in such a table.



DID YOU KNOW . . . you can use the Preview tool to resize, reposition
and/or rotate the copied elements when pasting?

What Using Preview in Copy/Paste Gives You
•  A resizable box showing the extents of the copied elements
•  Ability to resize, reposition, and/or rotate the rectangle using the mouse
•  Visualize copied elements with their assigned style

Preview in Copy/Paste

WANT TO KNOW MORE?

How to Use Preview in Copy/Paste

See the tutorial booklet:

Advanced Vector Editing

The selected
elements are
copied to the
clipboard when
you click on
this button.

Copy icon

•  Select Main/Edit from the menubar and open any object.
•  Select the elements to copy and click on the Copy icon in the View toolbar.
•  Click on the Copy button in the Copy to Clipboard window.
•  Create a new object or open an existing object to paste the copied elements.
•  Click on the Paste icon in the View window toolbar.
•  Make sure the Preview button is toggled on in the Paste Placement Tool.
•  Position the cursor over the edges, dotted line, or the box and notice the cursor

styles for resizing, rotating, or repositioning respectively.
•  Click and hold left mouse button when you see the cursor for resize, rotate, or

reposition and drag the edge, dotted line, or the box to the desired position.
•  Release the left mouse button when you are done with resizing, rotating or

repositioning, and click on the Paste button.

Paste icon

Toggle on to
see Preview of
the copied
elements.

The element
selected for copy/
paste

The rectangle
shows the
extents of the
copied elements The rectangle that shows

the extents of the copied
elements is rotated and
reduced.

Toggle on to
copy
selected
elements.



DID YOU KNOW . . . you can open a separate Locator View along with
the one attached to the Legend in the View window?

What Opening a Separate Locator View Gives You
•  A separate reference view with a box showing the extents of the current view
•  Ability to resize and reposition the area viewed with the mouse
•  Use hotkeys to zoom in/out in the Locator View
•  Control layer visibility for the Locator View

Open a Separate Locator View

How to Open a Separate Locator View
•  Display any group or layout in the Display or the Editor process.
•  In the Display Manager, select Open Locator View from the Display menu.

WANT TO KNOW MORE?

See the Technical Guide entitled: Spatial Display:

Locator Reference View
Manages Zoom and Position

The two illustrations of the
Locator views show the
reference area at different
zoom levels. You can use the
hot keys, such as +/-, to zoom
in/out in the Locator View.

Selecting Open Locator View
from the Display menu in the
Display Manager opens a
separate Locator View window
(shown at the right).

Toggling on the Show Locator button on the
Options menu of the View window opens the
Locator at the bottom of the Legend as shown
above.

Refresh
Colors Hide All

Layers Track mouse cursor
between views

The separate
Locator View
window



•  Click on the Zoom Google Earth to Match View icon to automatically launch
Google Earth zoomed up to your current view

•  Change default settings in the Google Earth Synchronization window to set Google
View Scale, draw Group/View Extents in desired colors, and show MI logo.

DID YOU KNOW . . . you can use the Zoom Google Earth to Match View
icon to launch and track your TNT 2D view position in Google Earth?

What Syncing Google Earth with 2D Views Gives You
•  Open Google Earth zoomed up to your current view
•  Google Earth view repositioned and zoomed to match changes in TNT view
•  Draw your group/view extents in Google Earth in desired colors
•  Control Google Earth parameters in TNTmips

Sync Google Earth with 2D Views

WANT TO KNOW MORE?

How to Sync Google Earth with 2D Views

See the Technical Guide entitled: Spatial Display:

Sync Google Earth with 2D and 3D Views

Zoom Google Earth
to Match View icon

Toggle on to draw
MI logo at the
center of the view

When you zoom in/out in
your TNTview, the changes
are automatically tracked in
Google Earth.

Click to open Color
Editor to assign
new colors

Toggle on
to draw
group and/
or view
extents

Use slider to change
Google Earth scale

When the associated buttons
are toggled on, group and
view extents and the MI logo
are displayed in Google Earth
as temporary places.



DID YOU KNOW . . . you can control the visibility of the Locator in the
Legend?

What Turning Locator On/Off in Legend Gives You
•  Choose to show the Locator in the Legend
•  Choose to hide the Locator in the Legend

Turn Locator On/Off in Legend

How to Turn On/Off Locator in Legend
•  Display any group or layout in the Display or the Editor process.
•  Open the Options menu in the View window and make sure the Show Legend

button is toggled on.
•  Toggle on Show Locator button on the Options menu to show the Locator.
•  Toggle off Show Locator button on the Options menu to hide the Locator.

WANT TO KNOW MORE?

See the Technical Guide entitled: Spatial Display:

Locator Reference View
Manages Zoom and Position

The Legend with the
Locator turned on

Keep this button
toggled on to
show the Locator
in the Legend.

The Legend with the
Locator turned off



DID YOU KNOW . . . you can use the Locator to zoom in/out in any View
window and move the area viewed around when zoomed in?

What Zooming With Locator Gives You
•  A reference view in full extents showing the zoom area
•  An elastic box defining the extents of the view(s)
•  Ability to resize, and reposition the elastic box using the mouse
•  Control layer visibility for the reference view

Zoom With Locator

How to Zoom With Locator
•  Display any group or layout and make sure Show Legend and Show Locator

buttons are toggled on in the Options menu of the View window.
•  Right-click on the Show/Hide checkbox for the layer in the Legend or the Display

Manager to change individual layer visibility (all layers are visible by deafult).
•  Position the cursor on any corner of the elastic box to get the double-headed

arrow cursor; click and hold the left mouse button.
•  Drag the corner of the box in the desired direction and release the mouse when

the box reaches the desired size.
•  Position the cursor on the elastic box to get the hand-shaped cursor.
•  Click and hold the left mouse button.
•  Drag the box in the desired direction and release the mouse when the box is in

the desired position.

WANT TO KNOW MORE?

See the Technical Guide entitled: Spatial Display:

Locator Reference View
Manages Zoom and Position

The cursor is a
double-headed
arrow when the
mouse is over the
corner/edge of the
elastic box.

The cursor is
hand-shaped
when the
mouse is over
the elastic box.

The elastic box can be resized and repositioned to
change what is shown in the View window to match
the new extents and position of the box.



•  Geotag your digital photos using Tools/Create Geotagged Image Database.
•  Select Convert/Database to Vector from the menubar to open Database To

Vector Conversion window.
•  Click on the Database button and select a geotagged image database.
•  Select Geotagged Images from the Table menu.
•  Change the default settings if desired and click on the Run button.
•  Create a new vector object when prompted.

DID YOU KNOW . . . you can convert geotagged image database
pinmaps to vector objects with point elements?

What Converting Geotagged Image Locations to Vector Gives You
•  Create point elements in a vector object from a geotagged image database
•  Keep direct attachments between the points and the digital images
•  Generate point database for all pins
•  Generate lines between successive points if desired
•  Style pins by theme, attribute, or image thumbnail once in vector format

Convert Image Locations to Vector

WANT TO KNOW MORE?

How to Convert Geotagged Image Locations to Vector

See the Technical Guide entitled: Digital Photos:

Convert Photo Table to Vector Points

Click to select database

Toggle on to
generate lines
between
successive
vector points.

Click to select table with
geotagged images

Click to change the
coordinate reference
system that is
specified automati-
cally from the
geotagged image
database selected.

Click to select
a database
field for point
order.

Setting is  active
only when
Generate Lines
is toggled on.

Open Database to
Vector Conversion
process

The vector points shown on the left are
converted from a geotagged image
database and styled by image thumbnail.

Toggle on to eliminate
points that lack
coordinates (assigned
to 0,0 if toggle is off)



DID YOU KNOW . . . you can interactively edit a bitmap pattern for use
as a polygon fill pattern or a point symbol?

What Editing Bitmap Patterns Interactively Gives You
•  Create a new bitmap pattern from scratch or modify an existing pattern
•  Use an existing bitmap fill pattern as a template to create new patterns
•  Rotate and/or flip bitmap pattern
•  Tools to fill and replace array of pixels or individual pixels

Edit Bitmap Patterns Interactively

WANT TO KNOW MORE?

How to Edit Bitmap Patterns Interactively

See the tutorial booklet:

Creating and Editing Styles

•  Open Style Editor for points or polygons and toggle on the Bitmap button.
•  Click on the Create or Edit Symbols icon to open the Bitmap Pattern Editor.
•  Select New from the Pattern menu to create a pattern from scratch and enter
    pattern width and height when prompted.
•  Choose Tool/Point to edit pixel by pixel, or Tool/Fill to edit an array of pixels.
•  Click on the desired color on the palette for solid color or on the Variable button to
    be able to assign any color to the symbol when the pattern design is finished.
•  Draw the pattern and select Pattern/Save As to save the new pattern.

Click on this icon to open the
Bitmap Pattern Editor window
for interactive bitmap pattern
design.

Click on this icon to insert
symbol from style object, CAD,
CGM, TrueType, ICO, or PNG.

Click on this icon to delete the
selected bitmap symbol.

The color palettes
set the color for
solid color drawing
and for any
variable color
pattern components.

The array of Ts represents
transparent pixels in the
pattern.

The array of Vs
represents
variable color pixels
in the pattern.

Click to add
transparent
pixels.

Click to add
variable color
pixels.

Click to change
background
color.

Edit pattern to change
pixel position or color.



•  Choose Tools/Create Geotagged Image Database.
•  Click on the Add Images icon and select image files to geotag.
•  Click on the Database Pinmap icon to open the Database Pinmap window.
•  Click on the Input Raster button and select a reference raster.
•  In the Create Geotagged Image Database window, click on a row in the Image List

to select a photo and click on the View Image icon to view it.
•  In the Database Pinmap window, drag the Point tool’s crosshair symbol to the

desired location and right click to accept the position.
•  Repeat the previous two steps for the remaining photos.
•  Click on the Run button in the Create Geotagged Image Database window.

DID YOU KNOW . . . you can add geographic coordinates to digital
photos to show digital photo locations?

What Geotagging Digital Photos Gives You
•  Create a database pinmap of the photo locations
•  View photos in a pop-up viewer window
•  Convert photo locations to vector object
•  Use image thumbnails for styling vector elements or pinmap symbols
•  Create a KML file from the photos to display in Google Earth

Geotag Digital Photos

WANT TO KNOW MORE?

How to Geotag Digital Photos

See the Technical Guide entitled: Digital Photos:

Geotagging Digital Photos

 Point tool
Point tool
crosshair

Click to select
an input raster.

Add Images
icon

View Image
icon

Click to create
database pinmap
of digital photo
locations.

Toggle on this button
to embed images in
the database.

Database
Pinmap icon

Clicking on these buttons
allows you to switch
between the photos.

The viewer opens
when you click on
the View Image icon.



•  Navigate to the TNT Temporary Files folder in your TNT products folder and
delete temporary files you find.

•  Select Tools/System/Preferences from the TNT menubar and click on the
System tabbed panel to specify a new repository for the temporary files.

•  Select the default TNT Temporary Files folder and click on the Remove button
to delete it (you do not need to remove this folder if you specify a path for a
different drive that has more space).

•  Click on the Add button to specify a new location for storing temporary files or
toggle on the Include TEMP and TMP environment settings button toggled on
to store your temporary files in the default folder of MAC (if available).

•  Select Go/Go to Folder from the Finder menu and type the path of the tempo-
rary file folder listed in the Temporary Directory panel or navigate to the tempo-
rary file folder using Finder or other MAC tools.

DID YOU KNOW . . . you have control over the folders that store tempo-
rary files created by TNT processes in MAC OS X?

What Managing Temporary Files Gives You
•  Designate drive and folder to keep TNT temporary files
•  Store temporary files on multiple drives
•  Use automatically created TNT temporary files folder to store temporary files
•  View and delete temporary files in the specified temporary folder

Manage TNT Temporary Files in Mac OS X

Search the information available on

WANT TO KNOW MORE?

MicroImages’ Web Site

Click to remove the
highlighted path.

Click to remove all paths.

Click to specify a new
drive and/or folder to
store temporary files.

The TNT Temporary
Files folder is automati-
cally created in your
TNTmips directory to be
used as the default
primary repository for
the temporary files
created during your use
of various processes.

How to Manage Temporary Files in Mac OS X

This button is active if you have TEMP
and TMP environment variables set for
your computer.  Toggle on this button to
use the default folder set for the TEMP
and TMP environment variables to store
the temporary files when the drive with
TNT Temporary Files folder does not
contain enough free space for the
temporary files.

If the drive with TNT
Temporary Files folder
does not contain
enough free space for
the temporary files, the
second drive with
additional space (if
specified) is used.

If the TEMP and TMP
environment variables folder
specified by Include TEMP
and TMP environment
settings button and the folder
you specified are on the same
drive, the  folder specified is
used as the primary reposi-
tory for the temporary files. If
not, the folder in a drive with
more space is used as
primary repository.



•  Navigate to your TNT temporary files folder and delete temporary files you find.
•  Select Tools/System/Preferences from the TNT menubar and click on the

System tabbed panel to specify a new repository for the temporary files.
•  Click on the Add button to specify new location for storing temporary files.
•  Select the desired path listed in the Temporary Directories pane and click on

the Remove button to delete it.
•  Click on the OK button.

DID YOU KNOW . . . you have control over the folders that store tempo-
rary files created by TNT processes in Windows?

What Managing Temporary Files Gives You
•  Designate drive and folder to keep TNT temporary files
•  Store temporary files on multiple drives
•  View and delete temporary files that remained in the specified temporary folder

Manage TNT Temporary Files in Windows

Search the information available on

WANT TO KNOW MORE?

MicroImages’ Web Site

Click to remove the
highlighted path.

Click to remove all paths.

Click to specify a new
drive and/or folder to
store temporary files.

Keep this button toggled on
to use the default folder set
for the TEMP and TMP
environment variables to
store the temporary files. If
this button is toggled off and
no other folder is specified,
your TNTmips installation
directory is used as the
default primary repository for
the temporary files.

If two folders are defined as the
temporary directory, the last added is
used as the primary repository. If the
two folders specified are on different
drives, the folder on a drive with more
space is used as the primary
repository.

How to Manage Temporary Files in Windows

If the TEMP and TMP environment variables folder
specified by Include TEMP and TMP environment
settings button and the folder you specified are on
the same drive, the  folder specified is used as the
primary repository for the temporary files. If not,
the folder on a drive with more space is used as
the primary repository.



•  Choose Tools/Create Geotagged Image Database to open the Create Geotagged
Image Database window.

•  Click on the Add Images icon and select image files to geotag.
•  Click on the Database Pinmap icon to open the Database Pinmap window.
•  Click on the Input Raster button and select a reference raster.
•  In the Create Geotagged Image Database window, click on a photo in the Image

List to select it.
•  In the Database Pinmap window, drag the Point tool’s crosshair symbol to the

desired location and right click to accept the position.
•  Repeat the last two steps for the remaining photos.
•  Click on Save KML in the Create Geotagged Image Database window.
•  Click on the Yes button when prompted to use image thumbnails for photo icons.

DID YOU KNOW . . . you can add geographic coordinates to digital
photos and create a KML file with digital photo locations?

What Creating KML File from Photo Locations Gives You
•  Generate a KMZ file from database pinmap of the photo locations
•  View photo locations in Google Earth and Google Maps
•  Use image thumbnails for placemark symbols
•  View photos in a pop-up viewer window

Create KML File from Photo Locations

WANT TO KNOW MORE?

The KMZ file generated contains a
placemark for each digital photo
automatically styled  to use the
image thumbnail if specified when
saving the KMZ file in TNTmips.

How to Create KML File from Photo Locations

See the Technical Guide entitled: Digital Photos:

Geotagging Digital Photos

Add Images
icon

Database
Pinmap icon

Click to save digital photo locations
in a KMZ file, which keeps all digital
photos in the compressed form.

In Google Earth, double-clicking
on any image thumbnail opens
the photo in a pop-up viewer.



•  Select Display/New/3D Display in the Display Manager and add layers.
•  Choose Display/Render to KML to open the Render to KML window.
•  Select Match View 2 or any other open 3D view from the Extents menu on the

Options panel to specify the extents of the KML/KMZ file.
•  Click on the OK button to create a KML/KMZ file with default settings; or
•  Click on the Geometric Controls tabbed panel to change the coordinate

accuracy value for the geometric objects.
•  Click on the Raster Controls tab to change the Cell Value and Format Type for

the raster objects.

DID YOU KNOW . . . you can render the layers in a 3D group to a KML
file using the extents of any open 3D view window?

What Rendering 3D View to KML/KMZ Gives You
•  Display the content of 3D view in Google Earth
•  Select any open 3D view window to use its extents for the KML file
•  View the layers from the last used angle and elevation in Google Earth

Render 3D View to KML/KMZ

WANT TO KNOW MORE?

How to Render 3D View to KML/KMZ

See the Technical Guide entitled: Spatial Display:

Render Map Layouts to KML

When you render a Display Group to
a KML/KMZ file using the extents of an
open 3D View, the  KML/KMZ file
generated is displayed in Google
Earth from the same angle and
elevation set in TNTmips. The content
of the group is listed in the Places
panel.

Select any open 3D view
window to specify the
extents of the KML file.



•  In the Display process, open an existing layout or a group containing a WMS/
ArcIMS layer(s) or create a new layout or a group and add a WMS/ArcIMS layer(s).

•  Choose Display/Render to/KML to open the Render to KML window.
•  Toggle on the Create Dynamic Web layer button to create a KML/KMZ file that

contains network links.
•  Click on the OK button to create a KML/KMZ file with default settings.

DID YOU KNOW . . . you can create a KML or a KMZ file from your group
/layout that contains Web Map Service (WMS) or ArcIMS layer(s)?

What Rendering WMS/ArcIMS Layers to KML or KMZ Gives You
•  A KML or KMZ file that stores WMS/ArcIMS layer(s) with the other content of the

group/layout
•  Store WMS/ArcIMS layer(s) in a KML/KMZ file as network links or local images
•  Automatic update of the dynamic WMS/ArcIMS layer when its content changes
•  Adjust automatically calculated cell size, and the format of the local images

Render WMS/ArcIMS Layers to KML or KMZ

WANT TO KNOW MORE?

How to Render WMS/ArcIMS Layer to KML or KMZ

See the Technical Guide entitled: Spatial Display:

Render WMS and ArcIMS Layers to KML

The full extents of the
WMS/ArcIMS layer(s)
is referenced
regardless of the
selection for the
Extents if rendered as
a dynamic web layer.

When a KML/KMZ file is displayed in Google
Earth, each group in the layout is listed in the
Places panel as an expandable folder, which
shows each original TNT object in that group
in a separate sub-folder.  The WMS layer is
also listed as a sub-folder in a group.

Group with WMS and vector
layers rendered to KMZ file and
displayed in Google Earth.

Toggle on this button to render WMS/
ArcIMS layers as dynamic web layers.

This panel gets
activated when
rendering  WMS/
ArcIMS layers as a
local, or static image.



DID YOU KNOW . . . you can use bitmap patterns for point symbols?

What Using Bitmap Patterns for Point Symbols Gives You
•  Create new bitmap patterns or edit the existing ones
•  Use any image in png format for point symbols
•  Select an existing bitmap fill pattern to use as a point symbol
•  Display your point symbols in Google Earth as displayed in TNTmips

Use Bitmap Patterns for Point Symbols

WANT TO KNOW MORE?

How to Use Bitmap Patterns for Point Symbols

See the tutorial booklet:

Creating and Editing Styles

•  Open Style Editor for point symbols and toggle on the Bitmap button.
•  Click on the Create or Edit Symbols icon for interactive bitmap pattern design, or
   click on the Insert Symbol icon.
•  Select From Style Object to insert from the existing symbols.
•  In the Select Patterns window, select any pattern from the default style object or
   click on the Browse icon to select any style object that contains bitmap patterns.
•  Toggle on the associated button in the bitmap symbol list.

The bitmap
patterns in the
style object are
listed here
when the Point
Style Type is
set to Bitmap.

Click on this icon
to create or edit a
bitmap pattern.

Click on this icon to
insert symbol from
style object, CAD,
CGN, TrueType, ICO,
or PNG.

Click on this icon to
delete the selected
bitmap symbol.

When From Style Object
is selected, you can use
any existing bitmap
pattern as a point symbol.
The selected pattern
(above) is added to the
bitmap symbol list (left).

Click on this icon to browse
style objects that contain
bitmap patterns.



DID YOU KNOW . . . you can work with CAD Blocks when creating
CAD geodata?

What Working with CAD Blocks Gives You
•  Block is a “super element” that may include any or all element types
•  Open any CAD object as a block
•  Use CAD objects over and over without recreating elements
•  Ability to reposition, rotate, or scale CAD block before inserting
•  Edit block names and descriptions

Work with CAD Blocks

WANT TO KNOW MORE?

How to Work with CAD Blocks

See the tutorial booklet:

Editing CAD Geodata

•  Select Edit Block Information from the right mouse button menu for the CAD layer
in the Layer Manager window.

•  Click on the Add button and select a CAD object or highlight an existing block in
the list for insertion.

•  Click on the Add Block Insert button on the Add Element panel of CAD Tools.
•  Optionally reposition, rotate, or scale CAD block before inserting.
•  Right-click on the View window, or click on the Element Add button at the bottom
   of the CAD Tools window to insert the selected block.

The  Add Block Insert icon
gets activated when a block
is added in the Block
Selection window.

Click on the  Add Block Insert Button and
then on the  Add button to add the selected
block to the view.

Add

Save

Copy

Delete

Click to
rename
the block.

Select Edit Block Information from
the right mouse button menu to
open the Block Selection window.

Show Block
Information



Use HTML Tags to Specify DataTip Width

How to Specify DataTip Width

•  Specified width formatting for long string fields and memo fields
•  Easily change width of DataTips
•  Eliminate line-by-line formatting

DID YOU KNOW . . . you can include HTML tags to specify the width
in the string expression field for a DataTip?

WANT TO KNOW MORE?

What Specifying DataTip Width Gives You

MicroImages’ Web Site
Search the information available for DataTips on

This string expression for the
DataTip field only specifies new
lines between component fields
of the expression and uses the
carriage returns specified in the
included memo field to determine
the DataTip width.

This string expression includes the html
‘table’ tag with a specified width.  You can
change the width value (in pixels) to
achieve the desired effect.

• Right-click and choose Properties for the table that provides the DataTip.
• Start the string expression for the DataTip field with <table width =”widthpx”>

where widthpx is the minimum pixel width for the DataTip text specified in
pixels followed by px (line break will occur after the word that starts before the
specified pixel width)

• End the string expression with </table>



Filter File Type when Selecting Geodata

How to Restrict File Types

•  Reduce number of files listed for selection when browsing your drives
•  Easy selection of all files of one type in a folder or subfolder
•  Reduce number of files listed after geocatalog searches
•  Switch between different file types to view selectable files
•  Different file types offered for selection depending on current process
•  View all or restricted file types allowed for selection in current process

•  Open Select Objects or Select File window to choose input for any process.
•  Choose file type from toggles provided for most recently selected file types.
•  Choose desired file type from option menu.
•  Restrict object types shown in RVC files by setting Objects of Type option.

DID YOU KNOW . . . you can restrict browsing or use of your
geocatalog(s) to a particular geodata file type?

WANT TO KNOW MORE?

What Restricting File Types Gives You

File Type Selection Options
See the Technical Guide entitled System:

These choices reflect your most recently used file
types if they are suitable for the current process.

All file types supported for
direct use that are suitable
for the current process are
listed on this menu.

This folder contains many files, but only one
shapefile.  Changing visible files to those with a
.shp extension greatly simplifies its selection.

Add All (including
subfolders)



Extract Vector Elements Using Attributes

How to Use Attributes to Extract Vector Elements
•  Choose Geometric/Extract to/Vector.
•  Choose the element type(s) you want to extract, set the selection option to By

Element, and click on Select.
•  Use a database table to select elements and/or use Mark by Query.
•  Once the elements you want to extract are selected, click on Accept and run

the process.

DID YOU KNOW . . . you can use element attributes to select which
elements to extract?

WANT TO KNOW MORE?

What Using Attributes to Extract Gives You

Vector Analysis Operations
See tutorial booklet entitled

Query selects
all Brazilian
polygons to
extract.

•  Choose elements to extract directly from a database table
•  Choose elements to extract using a query
•  Use a combination of any selection methods
•  Remove or keep unattached records



Add WMS and ArcIMS Layers to View

How to Select WMS and ArcIMS Layers for Viewing

•  Choose from  more than 2,000,000 layers available worldwide
•  Reference layers for viewing and editing
•  Search for layers by name or geographic location
•  Display thread separated from local layers so not delayed by slow service
•  Choose layers from  any intranet or Internet site that supports these formats

•  Click on the Add Web Layer icon.
•  Choose Web Map Service (OGC) or ArcIMS.
•  Choose the desired service selected from one of MicroImages’ catalogs,

directly enter the URL for the desired service, or use search capabilities.
•  Choose the desired layers from the list provided by the selected service.

DID YOU KNOW . . . you can select WMS and ArcIMS layers for
viewing alone or in combination with local map and image layers?

WANT TO KNOW MORE?

What Selecting WMS and ArcIMS Layers Gives You

WMS and ArcIMS Layer Selection
See the Technical Guides on



DID YOU KNOW . . . you can automatically create and assign a drawing
style to each attribute value attached to elements in geometric objects?

What Automatic Style Assignment Gives You
•  Predefined symbols for points and solid colors for lines and polygon fills
•  Choose color palette to assign random colors to the attributes
•  Define start and end colors for color spread for each element type
•  Apply size spread to point symbols, line elements, and polygon borders

Automatic Style Assignment

WANT TO KNOW MORE?

How to Assign Styles Automatically

See the Technical Guide entitled Spatial Display:

Automatic Style Assignment Options

•  Select Controls from the object’s right mouse button menu.
•  Click on the tab for the desired element type.
•  Set Style to New - by Attribute.
•  Click on the Attribute button to select a database table and field for styling.
•  Click on the Automatic tab in the Assign Styles by Attribute window.
•  Accept the colors automatically assigned to the attributes, or change the options

to set size, color, transparency, and scale information of styles.

Click on this button
to open the Style
Editor to create
new styles or edit
the existing styles
including the
automatically
generated styles.

The automatic
styles defined at the
right are applied to
polygon attributes
shown below.

Click to apply
random or
progressive color
spread for polygon
borders/fills.

Use this panel to apply
random or progressive
size spread to polygon
borders within a
specified width range.

Enter a percentage
value for
transparency of
polygon fill colors.



DID YOU KNOW . . . you can add one or more sets of raster objects as
a single RGB layer by clicking on the same icon used to quick-add any
type of single-object layer?

What Quick-Adding RGB Raster Sets Gives You
•  Save time by adding RGB raster sets with a single click
•  Add additional  layer types to overlay with the RGB layer
•  Automatic identification of red, green, and blue components using color name
•  Ability to quick-add multiple RGB sets if they have different extents

Quick-Add RGB Raster Sets

WANT TO KNOW MORE?

How to Quick-Add RGB Raster Sets

See the Technical Guide entitled: Spatial Display

Quick-Adding RGB Raster Sets

•  In the Display Manager window, click on the Add Objects icon.
•  Select the raster objects you want to add.
•  Click on the OK button.

Add Objects icon

When rasters are selected in any order,
they are automatically displayed as an
RGB raster set. The names of the rasters
are used to determine the correct
component.

The illustration above shows the three
coextensive, coregistered rasters
displayed as an RGB raster set.



DID YOU KNOW . . . you can create a buffer zone inside or outside the
extraction area defined by polygons or regions when extracting rasters?

What Extracting Raster Areas with Buffer Gives You
•  Use vector polygon(s) or a region to define raster extraction area(s)
•  Add buffer cells around the region or polygon(s) used to extract raster
•  Specify the number of buffer cells to add around the extraction area
•  Choose inside or outside the extraction area to create a buffer zone

Extract Raster Areas with Buffer

WANT TO KNOW MORE?

How to Extract Raster Areas with Buffer

See the Technical Guide entitled: Image Processing

Extracting Raster Areas with Buffer

•  Select Raster/Extract from the menubar.
•  Select the raster object(s) you want to extract from when prompted.
•  Choose the By Polygons or By Region option from the Select menu on the Extract

tabbed panel.
•  Select the vector object or the region for raster extraction when prompted.
•  Select the attribute to supply default names from the database tables listed.
•  Enter the number of buffer cells to add inside or outside the extraction area.
•  Click on the Run button.

Click on this icon to
select By Region or
By Polygons to use
extracting with
buffer feature.

Enter the number of buffer
cells to add inside or
outside the region or
polygon(s) used to define
the extraction area.

Select to create a
buffer inside or outside
the extraction area.



DID YOU KNOW . . . you can use the GeoCatalog Manager to create/
edit geocatalogs with the extents and other information about your
geodata objects and files?

What the Geospatial Catalog Manager Gives You
• Edit or update an existing catalog or create a new one
• Select folder(s) from local or network locations to scan for the geocatalog
• Exclude specific subfolders from the selected geocatalog or all geocatalogs

Geospatial Catalog Manager

WANT TO KNOW MORE?

How to Use the Geospatial Catalog Manager

See the Technical Guide entitled System:

Making GeoCatalogs

•  Choose Tools / Geospatial Catalog Manager from the TNTmips menubar.
•  Click on the Select geospatial catalog button.
•  Select an existing geocatalog to edit or update; or

enter a name in the New File Name field in the Select Geospatial Catalog file
window to create a new geocatalog.

•  Click on the Select button below the Folders to scan list to select folders to scan
for the geocatalog.

•  Click on the Select button below the  Folders to exclude from this catalog/all
catalogs lists to select folders to exclude from the current or all catalogs.

•  Click on the Run button.

Selecting Geospatial Catalog
Manager from the Tools menu
opens the window below.Click to select an existing catalog to

edit or update, or create a new one.

Enter a new file
name to create a
new geospatial
catalog.

The files in the folder(s)
selected here are excluded
from the current catalog.

The files in the folder(s)
listed here are excluded
from all catalogs.

The files in
the folder(s)
listed here
are scanned
for inclusion
in the
catalog.



DID YOU KNOW . . . you can access MicroImages’ documentation files
directly on your computer?

What Accessing Documentation on Local Computer Gives  You
• Use documentation installer to install all latest documentation to your local drive
• Access MicroImages’ documentation with no Internet connection
• Search documentation for the keyword(s) of interest

Access Documentation on Local Computer

WANT TO KNOW MORE?

How to Access Documentation on Local Computer
• Download and run the documentation installer located at MicroImages’ website:
                    http://www.microimages.com/downloads/tntmips.htm.
• Select Help / Search from the TNT menu bar.
• Click on the Search button for the index in Adobe Reader.
• Click on the Load button when prompted to load the Catalog Index.
• Type the keyword(s) of interest and click on the Search button on the same panel.
• Click on any search result to view it in pdf format.

See the Technical Guide entitled System:

Access to TNT Information Resources

Click here after
entering your
search term(s)
to get results as
shown above.

Click on any of
the search
results to view
the document
in pdf format.

Clicking on this button opens the
Acrobat Search panel to search
MicroImages’ documentation
installed on your local computer.



DID YOU KNOW . . . you can use the Mask Editor to edit and save a
null mask or separate mask raster for a target raster object?

What Using the Mask Editor Gives You
• Create mask that excludes designated raster areas from display or processing
• Use variety of drawing tools to mark the areas to be masked
• Set highlight colors and transparency for the included, excluded, and marked areas
• Save the mask as a null mask subobject or as a separate binary raster object
• Directly create/edit masks in the Spatial Display process and other processes that

provide a View of the input raster object

Use the Mask Editor

WANT TO KNOW MORE?

How to Use the Mask Editor

See the Technical Guide entitled Spatial Display:

Create and Edit Masks and Null Masks

•  Select Image/Utilities/Edit Mask from the menubar, or choose Edit Mask from
the right mouse menu of the raster in the Display Manager or LegendView.

•  Click on the Raster button and select a target raster.
•  Click on the desired drawing tool in the Edit Tools panel.
•  Draw the area to mask and right-click to mark the area for action.
•  Click on the Exclude from Raster button to mask the marked area.
•  Repeat the above two steps as necessary.
•  Click on the Null Mask or Binary Raster toggle button to save the current mask as
   a null mask subobject of the target raster or as a separate binary raster object.
•  Click on the Save button.

DRAFT
11-OCT-2010

Click to include/exclude
marked areas from the
mask or invert the
marked areas.

Marked
for action

Excluded

Included

The highlight colors
selected are displayed
with 80% transparency
in the View window.

Click to apply
actions on maskChoose a drawing

tool to mark areas.

Click to select
a target raster.

Choose to save the current mask as a null
mask subobject of the target raster or as a
separate binary raster object.



DID YOU KNOW . . . you can show TNT Process IDs in window titles?

What Showing TNT Process IDs in Window Titles Gives You
•  Find matching TNT process IDs in the Windows task manager as PID
•  Identify a specific TNT process to end
•  Maintain all other processes running when ending the desired
•  Match View windows with associated manager or process window

Show TNT Process IDs in Window Titles

WANT TO KNOW MORE?

How to Show TNT Process ID in Window Titles

See the Technical Guide entitled: Image Processing

Extracting Raster Areas with Buffer

•  Select Tools/System/Preferences from the TNT menu.
•  In the General System Preferences window (the Interface tabbed panel),

toggle on the Show process ID in window titles button.
•  Process ID shows in window titles for processes launched after change.

Toggle on
this button
to show
process IDs
in window
titles.

Each window title shows a unique process ID that
is listed in the  Windows Task Manager when the
option is on and the process is running.

Process ID numbers are
the same for different
windows of the same
process. This feature
allows you to know which
windows go together
when running multiple
instances of a process.

Select to open
General System
Preferences
window.

Process Identifier (PID) column

Note: The process identifier may appear in
different places for different operating
systems and the columns you have
selected for viewing.



DID YOU KNOW . . . you can search the reference materials on
MicroImages’ website using the keyword(s) of interest?

What Searching Website Reference Materials Gives You
• Search entire website for the keyword(s) of interest
• Limit search results to specific categories of information
• Access to documentation indexed by Google

Search Website Reference Materials

WANT TO KNOW MORE?

How to Search Website Reference Materials
• Go to www.microimages.com, and click on one of the Search buttons.
• Type the keyword(s) of interest, click on category button, then on link; or
• Select Help / Search Web from the TNT menu bar.
• Type the keyword(s) of interest and click on the Search button.
• Click on the desired link, or first
• Click on the desired category of information to narrow the results shown.

See the Technical Guide entitled System:

Access to TNT Information Resources

Click on either
of these
buttons to
search
information
resources.

Tech Guides, Quick
Guides, and tutorials
can also be installed
and searched on
your local computer.
See the Quick Guide
entitled Access
Documentation on
Local Computer.

Enter the keyword(s) of
interest and click on the
search category to
search the reference
materials.

Keywords entered here
are transferred to the
next level when you

click Search Site.



DID YOU KNOW . . . you can use the arrow keys on your keyboard as
“hot keys” to scroll the view?

What Using Arrow Keys Gives You
•  Ability to scroll the view using the keyboard
•  Systematically step through the view horizontally or vertically
•  Pan by 90%  increments to the left, right, up, and down

Use Arrow Keys to Pan the View

How to Use Arrow Keys to Pan the View
• With your cursor over the View window canvas, press the right, left, up, or down
  arrow key on the keyboard to step through the display extents.

View 1: initial view View 2: Pan 90% to the right from View 1

WANT TO KNOW MORE?

MicroImages’ Web Site
Search the information available on

View 3: Pan 90% to up from View 2 View 4: Pan 90% to the left from View 3



DID YOU KNOW . . . you can directly add the Microsoft Bing Maps
reference layer to your TNTmips view selecting from aerial, roads, or
combined styles?

What Adding Microsoft’s Bing Maps to View Gives You
•  Provides detailed global image and  / or road reference themes
•  Add to any view using any CRS and any zoom level
•  Use as reference layer in the Editor to create or update elements

Add Bing Maps Image and/or Roads

WANT TO KNOW MORE?

How to Add Microsoft’s Bing Maps to View

Search the information available on

MicroImages’ Website

•  In the Display/Layer Manager click on the Microsoft Bing Maps icon and choose
the theme of your choice to add the Bing Maps global image / road coverage.

•  Zoom to the desired location using Reposition or Zoom tools in the View toolbar.
•  Change the theme and other layer parameters using the Layer Controls.

Choices when you click on
Microsoft Bing Maps icon

When you click on the Microsoft Bing Maps
icon, you choose between Bings’ Aerial (shown
right), Roads, or Aerial with Labels theme
(illustrated below).

The illustration above shows the Microsoft Bing
Maps reference layer (Aerial with Labels style)
displayed with a local vector layer.

The illustration at the right shows an editable
vector layer displayed over Microsoft Bing
Maps as a reference image in the Editor.

new polygon drawing in progress



DID YOU KNOW . . . you can select tileset layers from the Internet for
viewing alone or in combination with local map and image layers?

What Adding Internet Tilesets to View Gives You
•  Add reference layers for georeferencing, tracing features, editing geometric layers
•  Add maps and images from TNT’s list of reference tilesets
•  Use a tileset by pasting in its web URL
•  Use recent list to reselect previously viewed tilesets
•  Add a tileset to your own favorites list

Add Internet Tilesets to View

WANT TO KNOW MORE?

How to Add Internet Tilesets to View

See the Technical Guide entitled Spatial Display:

Adding Tilesets to Your View

• Click on the Add Web Layer icon.
• Choose the desired tileset layer in the Select objects to display window.
• Click on the Add button and then on the OK button; or
• Click on the Enter Path/URL icon in the Select objects to display window.
• Directly enter or paste the URL for a known TSD file into the URL field.
• Press <Enter> on the keyboard, then click on the OK button.

Opens Select
objects to display window
showing default web location.

The illustration above shows selection of
a Google Maps global tileset (shown at
right) from MicroImages’ list of tilesets.

Navigate in these folders
to add the desired
tileset(s) to view.

The illustration above shows a local vector
layer displayed over the Landsat 742 tileset.



DID YOU KNOW . . . you can use the Grow and Mark Features tool to
interactively identify a range of cell values that represents a feature?

What Using the Grow and Mark Features Tool Gives You
• Identify a map feature from a cell range you define
• Use mouse wheel to expand/reduce the determined cell range

Grow and Mark Features Tool

WANT TO KNOW MORE?

How to Use the Grow and Mark Features Tool

See the Technical Guide entitled Feature Mapping:

Region Growing Tool

•  Select Image / Interpret / Feature Map from the menubar.
•  Select the raster object(s) to analyze and the reference object when prompted.
•  Zoom in to the feature you want to identify.
•  Click on the Grow and Mark Features icon.
•  Click in an area that represents a feature.
•  Roll the mouse wheel toward you to expand the range or away to reduce it.
•  Right-click to convert the prototype feature to a marked feature.
•  Select an existing Feature Class or enter a name for a new class when prompted.
•  Select a color for the Feature Class when prompted.

Grow and Mark
Features icon

Region growing by
expanding the range

Marked feature

Prototype feature
Region growing from
initial mouse click

Right-click on the
prototype feature to add a
new class and specify a
marking color.



WANT TO KNOW MORE?

Search the information available on

MicroImages’ Website

DID YOU KNOW . . . you can choose to add reference layer(s) below or
above the editable layer?

What Adding Reference Layer Below Editable Layer Gives You
•  Always have the editable layer displayed over the reference layer(s)
•  No need to change display order when using reference layers during editing
•  Automatically add each new reference layer below the editable layer

Add Reference Layer Below Editable Layer

How to Add Reference Layer Below Editable Layer
•  Select Setup / Preferences from the Editor - Layer Manager menu.
•  Click on the Other tab.
•  Make sure the Add Reference Layer Below Edit Layer button is toggled on.
•  Click on the OK button.
•  In the Editor - Layer Manager window, click on the Open Object for Editing icon.
•  Select an object to edit when prompted.
•  Select a reference layer and note its position in layer order.

Opens the Editor’s
Preferences window.

Toggle on this button to
add reference layer(s)
below the editable layer.

The reference layer is automatically added
below the editable layer when Add Reference
Layer Below Edit Layer button is toggled on.

The reference layer is added above the
editable layer when Add Reference Layer
Below Edit Layer button is toggled off.

Reference Layer

Editable Layer



DID YOU KNOW . . . you can create new geometric or raster objects
from a template saved in TNT’s Editor?

What Creating a New Object from a Template Gives You
• Create a new object from a previously saved template or an existing object
• An object of same data type, georeference, and database structure
• Geometric object with the same style objects and database tables
• Raster object with contrast tables, color maps, and null masks

Create New Object from Template

WANT TO KNOW MORE?

How to Create a New Object from a Template
• In the Editor - Layer Manager, click on Create Object From Template icon, or
   select Create From Template from the Object menu.
• Select the template desired or any object to use as a template for a new object.

See the Technical Guide entitled Spatial Editor:

Creating and Using Geodata Templates

Create Object From
Template icon

Click on this icon or select the
option from the menu to choose
your template object.

When an existing vector object is selected as a
template, a new vector object is created with
the same georeference and database
structure but with no elements (illustration
above). Rasters created from templates have
no initial cell values.

Select a previously created
template or any existing object to
use as a template.

Note lack of
elements.



DID YOU KNOW . . . you can create templates for use in making new
objects from any existing, editable object in TNT’s Editor?

What Creating Geodata Templates Give You
•  Save any object that can be directly opened in the Editor as a template
•  Create a new object of same data type, georeference and database structure
•  Create geometric object templates with style object and other subobjects
•  Create raster object templates with subobjects such as contrast tables,

color maps, etc.

Create Geodata Templates

WANT TO KNOW MORE?

How to Create Geodata Templates
•  In the Editor - Layer Manager, click on the Open Object For Editing icon or
   create a new object.
•  After editing, choose Save as Template from the Object menu.
•  Select output template object when prompted.

See the Technical Guide entitled Spatial Editor:

Creating and Using Geodata Templates

The illustrations show the subobjects of saved
raster (above) and vector templates (below). The
templates shown have no elements (vector) or cell
values (raster) but they have all the subobjects that
the original vector / raster has.

Choose Save as Template
from the Object menu to save
the active layer as a geodata
template for use in creating
similar objects. Note that this
choice is dimmed unless the
layer is an editable layer.



DID YOU KNOW . . . you can erase line and/or polygon parts using the
Delete key?

What Erasing Line/Polygon Parts with the Delete Key Gives You
•  Erase line segments or vertices depending on the location of cursor
•  Use shortcut key <Delete> to erase the part of the element
•  Easily distinguish vertices, nodes and segments to delete

Erase Line/Polygon Parts with Delete Key

WANT TO KNOW MORE?

How to Erase Line/Polygon Parts with the Delete Key
•  In the Editor, select the geometric element to edit.
• Move the cursor over a vertex and press the <Delete> key on the keyboard
   to delete the vertex.
•  Move the cursor to any location over a line segment and press the <Delete>
   key to delete the line segment.
•  Move the cursor away from the line element and press the <Delete> key to
   delete the end vertex.

Move the cursor off
the line and press the
<Delete> key to
delete the end vertex.

end vertex

Move the cursor over
a vertex and press the
<Delete> key to delete
the vertex.

vertex

a location on a
line segment

Move the cursor over
a line segment and
press the <Delete>
key to delete the line
segment.

Search the information available on

MicroImages’ Website



DID YOU KNOW . . . you can get Z values from a surface layer when
adding geometric elements?

What Getting Z Values from Surface Gives You
•  Select a surface layer to provide Z coordinates
•  Automatically display Z values when drawing an element
•  Edit the Z values if necessary

Add 3D Geometric Elements in Editor

WANT TO KNOW MORE?

How to Get Z Values from Surface

See the tutorial booklet entitled:

Editing Vector Geodata

•  In the Editor - Layer Manager window, click on the Add Terrain icon and select a
raster to use as a surface layer.

•  Create a new 3D vector or open an existing 3D vector.
•  In the Vector Tools window, click on the desired Add Line, Add Polygon, or Add

Point tool on the Add Element panel.
•  Click on the Manual Entry icon and then on the Z coordinates from surface layer

icon on the Add Line/Polygon/Point Parameters panel.
•  In the Editor - View window, start drawing with the selected tool and edit the

desired Z value on the Manual Entry panel if necessary.

Click on the Add Terrain
icon to add a surface layer.

Click on the Z coordinates
from surface layer icon to
transfer Z values to
elements added.

Manual Entry icon

Z coordinates from a
surface layer can be
transferred when adding
lines, points, or polygons.

When the Manual Entry icon is pressed, the Manual Entry panel
showing the XYZ values of the element added opens. The
elevation value comes automatically from the surface layer.

When adding elements in the
Editor View window (above), the
XYZ values are automatically
shown in the Manual Entry panel
in the selected Coordinate
Reference System.



DID YOU KNOW . . . you can control the drawing order of hatch
pattern elements?

What Controling Order of Hatch Pattern Elements Gives You
• Design and save different hatch patterns using the same pattern elements
• Select the hatch pattern element to send to back or bring to front
• Move the selected hatch pattern element up or down in the drawing order

Control Order of Hatch Pattern Elements

WANT TO KNOW MORE?

How to Control Order of Hatch Pattern Elements

See the Technical Guide entitled

Hatch Patterns for Polygon Filling

•  In the Style Editor window, toggle on the Hatch button in the Fill Style section.
•  Click on the Create or Edit Pattern icon.
•  In the Hatch Pattern Editor window that opens, select File / Open and then an
   existing hatch pattern from the list to edit or design a new hatch pattern.
•  Click on the hatch pattern element that you want to move in the drawing order.
•  Click on the Raise or Lower icon to move the element up or down.
•  Select File / Save As to save the new drawing order as a new hatch pattern.

Click on the Raise
icon to move the
active hatch pattern
element up.

Click on the hatch
pattern element to
make it active for
moving up/down.

Click on the Lower
icon to move the
active hatch pattern
element down.

the active hatch
pattern element

The active hatch pattern element is moved up. The active hatch pattern element is moved down.



What Interactive Element Editing Gives You
•  Variety of graphic tools for easier and more intuitive editing
•  Automatic highlight of the vertices when moving the mouse over the element
•  Add a new vertex with a mouse click
•  Move an existing vertex by drag and drop

Interactive Element Editing

WANT TO KNOW MORE?

How to Edit Line/Polygon Elements Interactively

See the Technical Guide entitled Spatial Editor:

Graphic Tools Update

•  In the Editor, create a new geometric object or open a geometric object to edit.
•  In the Vector Tools window, click on the Add Line or Add Polygon icon, or

mark any line/polygon element using the desired element selection tool and click
on the Edit Element icon.

•  To add a new vertex, move the mouse over the element, press the left-mouse
button when the cursor is the diamond shape.

•  To move a vertex,  move the mouse over the element until the desired vertex is
marked with a plus sign, press and hold the left mouse button; release the button
at the desired location.

•  To move the start/end vertex, move the mouse over the start/end vertex until the
start/end vertex is marked with a plus sign (+), press and hold the left mouse
button, and release the button at the desired location.

•  To extend the line from the start vertex, move the mouse over the start vertex
until the cursor becomes a diamond shape, press and hold the left mouse button,
and release the button at the desired location.

•  To extend the line from the end vertex, click on the desired location in the View.

Ready to extend
from the start vertex

Ready to move
the start vertex

Ready to move
the end vertex

Ready to extend
from the end vertex

DID YOU KNOW . . . you can edit line / polygon elements interactively?

A vertex on a line/
polygon marked with
a plus sign

A location on a line/
polygon marked with
a diamond

Start Vertex End Vertex



WANT TO KNOW MORE?

Search the information available on

MicroImages’ Website

DID YOU KNOW . . . you can compute points that represent sampling
locations for polygons?

What Computing Sample Position Points Gives You
•  Create centered* or randomly located points in each vector polygon
•  Establish sampling locations for grids generated by the Polygon Grid process
•  Transfer attributes from polygons to points
•  Save created points in a new vector object

Compute Sample Position Points

How to Compute Sample Position Points

•  Select Geometric / Compute / Sample Points from the TNTmips menubar.
•  Click on the Input Object button and select a vector object with polygons.
•  Toggle on the Transfer Attributes from Input button if you want to transfer polygon

attributes to the points generated.
•  Select Center or Random from the Location drop-down menu.
•  Click on the Apply button to preview the computed points.
•  Click on the Save As button to save the points to a vector object.

sample points
centered* in
each polygon

Choose to create centered*
or randomly located points.

Toggle on this button to transfer
polygon attributes to the points
generated.

The point database tables
shown were automatically
transferred from the
polygon database when
sample points were
generated.

sample points
randomly placed
in each polygon

* Centered points are at the polygon centroid if it falls
within the polygon or in the polygon near the centroid.



DID YOU KNOW . . . you can sharpen raster images in the view using
the integrated image filtering in the display process?

What Sharpening Raster Images in Display Gives  You
•  Display sharper images without altering the original raster object(s)
•  Select from a variety of filter types and sizes to apply to each raster layer
•  Create custom filters with desired shape, size, and weighting coefficients
•  Blend the filtered and unfiltered image in the display
•  Set the amount contributed by each image in the blend

Sharpen Images in Display

WANT TO KNOW MORE?

How to Sharpen Raster Images in Display
•  In the Display Manager, select Controls from the object’s right mouse
   button menu and click on the Filter tab.
•  Toggle on the Apply Spatial Filter to Layer button.
•  Set Class to Sharpening and select the desired filter type and size.
•  Move the Amount slider to adjust the blending of filtered and unfiltered images.
•  Click on the OK button.

See the Technical Guide entitled Spatial Display:

Inline Filtering of Images

Toggle on this
button to apply
filter to the raster
image.

Click on this button
to select Sharpening
from the menu. Set amount of the

filtered image to blend
with the input image
(0 = No filtered results
and 100 = Only
filtered image).

RGB display of three
bands of a landsat scene
with no filtering

RGB display of three bands
of a landsat scene  with 3 x 3
High Pass Sharpening Filter

RGB display of three bands
of a landsat scene  with 7 x 7
High Pass Sharpening Filter

Select a
Sharpening
filter type
from this
menu.

Select larger
filter size to
increase the
degree of
sharpening.



DID YOU KNOW . . . you can copy from any editable or reference layer
and paste any part of a raster object into an editable raster layer?

What Copy, Cut, and Paste Raster Pieces Give You
• Select specific area within the raster layer to cut or copy
• Create new raster object with areas copied/cut from any raster layer
• Paste from any raster object into an existing raster object
• Reposition, rotate, or scale areas before pasting

Copy, Cut, and Paste Raster Pieces

WANT TO KNOW MORE?

How to Copy, Cut, and Paste Raster Pieces
• Choose Main / Edit, and open a raster object for editing.
• Click on the Cut or Copy icon in the View window.
• Choose a region type to select the area.
• Define the area that you want to cut or copy.
• Create a new raster object or open an existing one for editing.
• Paste the areas copied/cut into an editable raster layer.
• Optionally reposition, rotate, or scale the areas copied/cut before pasting.
• Save the new/existing raster object.

The Paste icon
gets activated
when areas are
copied/cut from a
raster layer. This
button opens the
Paste Placement
window.

Search the information available on

MicroImages’ Web Site

PasteCopyCut Toggling on the Preview
button lets you reposition,
rotate, or scale the areas
copied/cut before pasting.

Click to copy the
area specified.

The area cut or copied
from a raster can be
rotated before pasting.
.

Click to
paste as
shown
in the
Preview
(left).

Choose
a region
type for
copying.



TNT Hot Keys

keyboard shortcuts

Display View Window
Redraw at Full View 0
Set Zoom to 1x - 4x (raster) 1 - 4
Recenter at Cursor Location <space>
Zoom In +
Zoom Out -
Scroll 90% <arrows>
Redraw \

Display View Tools
Reposition r
Zoom z
Select s
GeoToolbox g
View-in-View i
Layout Placement p
Point Profile (group Displays only) p
Examine Raster x
HyperIndex Navigator n
HyperIndex Linker l

Georeference View Additions
Select Points s
Crosshair c
Tie Point t

Hot Keys are also known as keyboard shortcuts.

Editing Tools
Mark Elements m
Edit Element e
Snap Shift s
Line Simplification Shift k
Element Offset o
Interactive Line-Following Shift m
Spline f
Set Line Labels (vector only) Shift l
Connect Points Shift d
Set Contour Z Values Shift z

Editing Filters
Remove Dangling Lines Ctrl d
Remove Bubbles Ctrl b
Remove Excess Nodes Ctrl e
Remove Sliver Polygons Ctrl t
Dissolve Polygons Ctrl p
Remove Islands Ctrl i
Remove by Script Ctrl q

Editing Elements
Add Point p
Add Line/Edge l
Add Polygon a
Add Node n
Add Label/Text t
Add Rectangle r
Add Regular Polygon j
Add Circle c
Add Arc b
Add Arc Chord d
Add Arc Wedge w
Add Ellipse y
Add Region u
Add Block Insert (CAD only) i

Raster Editing Only
Add Rectangle (filled) Shift r
Add Circle (filled) Shift c
Add Ellipse (filled) Shift y
Add Regular Polygon j
Add Regular Polygon (filled) Shift j

Raster Editing Tools
Paint b
Flood Fill Shift f
Spatial Filter f
Add Grid Shift g
Restore From Source u
Grab Color q

Text Editing
Save Ctrl s
Cut Ctrl x
Copy Ctrl c
Paste Ctrl v
Find Ctrl f
Go To Line Ctrl g



WANT TO KNOW MORE?
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What Adding Multiple Groups to a Layout Gives You
• Quickly add a number of layers for side by side comparison
• Automatically create a new group for each of the spatial data objects selected
• Display any number of spatial data objects in its own separate groups at once

Add Multiple Groups to a Layout

How to Add Multiple Groups to a Layout

A new group is
created for each
of the spatial data
objects selected.

When multiple groups are added to a
display layout, groups are automatically
tiled and have no specific attachments.

DID YOU KNOW . . . you can add multiple groups to a layout at once
for any number of spatial data objects selected?

When multiple groups are added to a page
layout, all groups have an initial group
attachment that centers them on the page.

The Multiple Groups
option is active for
Page/Display layouts.

•  In the Display Manager, click on the New icon and select Display Layout or
Page Layout from the menu.

•  Select Add / Multiple Groups and add all the desired objects to display when
prompted.

See the Tutorial Booklet entitled

Making Map Layouts



WANT TO KNOW MORE?

Search the information available on

MicroImages’ Website

DID YOU KNOW . . . you can add a scalebar to the display view?

What Adding a Scalebar to a View Gives You
•  Provide a graphic scale for the geospatial object(s) displayed
•  Graphic visualization of the scale in English, Metric, or both units
•  Choose the location of the scalebar in the view
•  Control the scalebar length, label font, and colors

Add Scalebar to View

How to Add a Scalebar to a View
•  In the View window, click on Options and toggle on the Show Scalebar button.
•  Hover the cursor over the scalebar to see the DataTip.
•  Right-click on a scalebar to make desired changes to the Scalebar Settings.

Toggle on
this button
to show
scalebar in
the view.

Right-click on the scalebar
to open this window.

Use this panel to
change the color of
the bar, frame, label
text and/or halo.

Click to select a
font for the label
text.

These scalebars show the
distance in meters and
miles for the displayed map.

Select the format
for scalebars.

Click to select
text size for
the label.

Select the
location of the
scalebar(s) in
the view.

Select the unit
type(s)
displayed on the
scalebar.

Hover the cursor over the
scalebar for a datatip
showing the scale.



Create and Maintain List of Favorites

How to Create and Maintain a List of Your Favorites

•  Quick access to your favorite web or local layers geodata
•  Easily add web-based or local geodata files/objects to your Favorites list
•  Easily remove web-based or local geodata files/objects from your Favorites list

DID YOU KNOW . . . you can create and maintain a list of your favorite
web-based or local objects for access within the TNT products?

WANT TO KNOW MORE?

What Creating and Maintaining a List of Favorites Gives You

MicroImages’ Web Site
Search the information available about object selection on

Right-click on an item in this
Browse list to add it to your
Favorites list.

Items added to the Favorites tabbed
panel from the three separate panels
illustrated above.

• Right-click on an entry in the Browse list of the Select objects window or
• Right-click on an entry in the Selected list of the Select objects window or
• Right-click on an entry in the Recent list of the Select objects window and
• Choose Add to Favorites from the right mouse button menu. Or

• Highlight an item on the Browse, Selected, or Recent tabbed panel and click on
the Add to Favorites icon.

An item on the Selected or Recent
panel can always be added to the
Favorites list using the right mouse
button menu, but an item must be
selected on one of the lists for the Add
to Favorites icon to be active.

Add to
Favorites icon



Terrain Layer Value Type and Units

How to Assign a Value Type and Units

•  Set value type and units to correctly reflect raster cell values
•  Set DataTip automatically including suffix (units)
•  Shows units in Z portion of status bar for Height/Elevation/Distance values

DID YOU KNOW . . . you can assign a type (e.g., elevation, magnetic
field strength) and units for a terrain raster ’s cell values?

WANT TO KNOW MORE?

What Assigning a Value Type and Units Gives You

MicroImages’ Web Site
Search the information available about Terrain Layers on

• Choose Tools/File Manager.
• Navigate to and highlight raster object for which to set value type.
• Click on Edit icon.
• Choose Value Type and Units for selected raster object.
• Add object as terrain layer.

The Z portion of the View
window status bar is only
populated when a terrain layer
is present.

Use the Edit icon in the File Manager
to open the window at the left.

Setting the units in the Edit Object
Information window automatically sets the
DataTip units and suffix for a terrain layer.

Note you can set the number of places
shown in the
DataTip and
status bar*.

*useful for floating
point data with
little variation

The Value Type tells what the raster
cell values represent.  The value
type determines the Units choices.



•  Create point elements in a vector object from a database pinmap
•  Generate point database for all selected pins
•  Keep direct attachments between the points and the database records
•  Style pins by attribute or theme once in vector format

Convert Pinmap to Vector Points

How to Convert a Pinmap to Vector Points

DID YOU KNOW . . . you can convert a pinmap to vector points by
pasting the pinmap into a vector object?

What Converting a Pinmap to Vector Points Gives You

•  Select Main/Edit from the menubar.
•  Choose Layer/Database Pinmap from the Reference menu.
•  Select the database table to pinmap.
•  Click on the Copy icon in the Editor View window.
•  Set the Region Type to Entire Object and click on the Copy button.
•  Open a vector layer to edit or create a new vector object.
•  Click on the Paste icon to open the Paste Placement Tool window.
•  Click on the Paste button and save the vector object.

The points converted from pins
can be styled by attribute or by
theme after the pinmap layer is
pasted into a vector object.

WANT TO KNOW MORE?

Pin Mapping
See the tutorial booklet entitled:

Paste icon

The pinmap layer is the active
layer for copying the entire
object or the selected pins.

The vector layer is
the active layer for
pasting the copied
pinmap.

The point
database was
generated
from the
pinmap layer
pasted.

Copy icon



Text Style Formatting Codes
DID YOU KNOW . . . you can format text (including DataTip and
GraphTip text) using style formatting codes?

MicroImages’ Web Site

WANT TO KNOW MORE?

See the documentation on DataTips on

    Code     Description

MicroImages uses a variety of text formatting codes wherever you create text in TNTgis to
specify font, size, tabs, and a number of other text characteristics.  These codes are automatically
inserted when you use style controls in the Text Layer Controls window, but need to be manually
entered in scripts (control or virtual field) or prefix text for DataTips and GraphTips.

DataTips
{~BG} background color for DataTips

Alignment
{~LJ} text flush left
{~RJ} text flush right

{~CJ} center text
{~FJ} justify text (even left and right margins)

Style (bold, italic, etc.) and Position
{~B}, {~/B} bold, not bold
{~BWx} boldness width x (% of text size)
{~I}, {~/I} italic with default shear angle of 16 degrees, not italic
{~IAx} italic with specified shear angle of x degrees
{~U}, {~/U} underline, no underline
{~O}, {~/O} outline, no outline
{~E}, {~/E} enhanced, not enhanced
{~EWx} enhanced with x width (% of text size)
{~SH}, {~/SH} shadow, no shadow
{~N} turns off bold, italic, underline, outline, enhanced, shadow, superscript, and

subscript
{~BX}, {~/BX} boxed, not boxed
{~S+} superscript
{~S-} subscript
{~S0} turns off superscript / subscript while maintaining other set styles
{~AN} establishes text anchor position for subsequent overprint
{~OS} text following this command will overprint preceding text, starting at the last

anchor established by {~AN}

Kerning
{~SM}, {~/SM} smoothing, no smoothing

Orientation
{~GLRx} glyph rotation in degrees
{~IG}, {~/IG} vertical flip of glyph, return to normal text orientation

Size, Color, Font, and Tabs
{~Fname} sets font to “name” font
{~TSx} sets text size to x points
{~C[BG]r,b,g} sets text background color (values from 0 to 100)
{~TABS xjl} sets tabs where x is the character position to put the tab stop, j (optional)

indicates the type of tab justification (L, R, or C; L is the default), and l (optional)
indicates the type of leader line that precedes the tab stop (the default is no
leader line; the options are “.”, “-”, or “_” to indicate the leader line character.  A
single character position sets a fixed interval for multiple tabs; you can indicate
different tab stops by entering multiple positions separated by commas, e.g.
{~TABS 0.5, 1.5, 3R}.

{~K}, {~/K} kerning, no kerning

{~LSx} sets line spacing to x points
{~Cr,g,b} sets color to RGB values (from 0 to 100)



DID YOU KNOW . . . you can select a compass graphic and auto-
matically create a new group for it?

What Adding Compass Graphics Gives You
•  New group for compass graphic created automatically
•  Standard compass graphics provided with TNT products available for selection

Adding Compass Graphics to Layouts

WANT TO KNOW MORE?

•  Open or create a new display or page layout.
•  Choose Add / Compass Graphic from the Display Manager.
•  Resize and reposition the compass graphic in the layout using the Layout

Placement tool or the Group Settings Placement tabbed panel.

See the booklet entitled:

Making Map Layouts

How to Add a Compass Graphic and New Group in One Step

ArrowHead Bluestar ClassicNorth NorFleur NorsTrek

NorthCompass NorthGolf NorthHat

NorthRedPoint RubyStarYinsunNorthPyramid

NorthSimple

NorthSpear

Compass Graphics Installed with the TNT Products

North4pointsNorth

NorthTeepee
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